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Intended Use: 

NovaPACS is intended for the viewing, archiving, analysis, annotation, registration, distribution, editing, fusion, and 

processing of digital medical images and data acquired from diagnostic imaging devices and all DICOM devices, 

including mammography. 

NovaPACS is intended for use by trained healthcare professionals, including radiologists, physicians, technologists, 

clinicians, and nurses. NovaPACS allows the end user to display, manipulate, archive, and evaluate images.  

Mobile devices are not intended to replace a full workstation and should be used only when there is no access to a 

workstation. They are not to be used for mammography or fMRI. Mobile devices are used for diagnosis of medical 

images from different modalities including CT, MR, US, CR/DX, NM, PT, and XA. For a list of compatible mobile 

platforms, see NovaPACS Diagnostic Viewer User Manual.  

While NovaPACS’s full workstation provides tools to assist the healthcare professional determine diagnostic viability, 

it is the user’s responsibility to ensure quality, display contrast, ambient light conditions, and to confirm image 

compression ratios are consistent with the generally accepted standards of the clinical application. 

NovaPACS is intended for providing analysis and visualization of functional MRI data of the human brain, 

presenting derived properties and parameters in a clinically useful context. 

 

Warning: 

Digital mammography images must be acquired from an FDA-cleared or approved Full Field Digital 

Mammography (FFDM) modality for primary interpretation and diagnosis.  

 

Serious Incidents: 

Any serious incident that has occurred in relation to NovaPACS medical device should be reported to Novarad and 

the competent authority of the Member State in which the user and/or patient is established.  

 

Safety Assurance:  

Nova RIS is safe for our consumers and the environment. Nova RIS complies with the General Product Safety 

Directive (2001/95/EC). This holds Novarad responsible to provide our consumers with quality products that are 

safe for use. 

 

Installation Instructions: 

Installation is the responsibility of Novarad Technical Services. The user is directed by Novarad Technical Services if 

their assistance is required. 

 

NovaPACS is only intended for use with hardware that meets or exceeds minimum performance requirements, 

satisfies current safety regulations, and is CE marked as required by national or regional regulations. 

 

 

 

 

Hardware Specifications for NovaPACS 

Below are the minimum server and workstation requirements for using the NovaPACS Diagnostic Viewer. To use the 

NovaPACS Diagnostic Viewer systems at their highest performance, it is best to meet or exceed these 

recommendations. These system recommendations are subject to change.  
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a) Minimum Server Specifications: 

REQUIRED PERFORMANCE BENCHMARKS (The following minimum benchmarks must be reached using the 

PassMark Performance Test tool. A free version can be downloaded from 

http://www.passmark.com/products/pt.htm )  

CPU Mark: 11,000 

Memory Mark: 2,100 

Disk Mark: 28,000 

Passmark Rating: 2,500 

The hardware used to meet the above benchmarks is based on the following Specifications:  

Processor: Intel Xeon Silver 4110 2.1G, 8C/16T, 9.6GT/s , 11M Cache, Turbo, HT (85W) DDR4- 2400, 

Bus Speed 8.00 GT/s DM13, TDP 80W  

Operating System: Windows Server 2022 

Memory: 32 GB DDR4 DR x4 ECC x2 2666MT (In pairs for Dual Channel configuration) 

Drive Controller: 2GB NV Cache 

Hard Drives: 1TB M.2 SSDs in Dell Boss Card RAID-1; partitioned for OS (C:), Processing drive (D:) 3x4TB 

7200 RPM SATA (RAID-5) for Archive* 

CD/DVD: None  

Network Card: 1 GB Ethernet NICs 

Power Supply: Dual, Hot-plug, and Redundant Power Supply (1+1), 750W 

Storage: 200Mbps sustained read/write throughput to the disk systems, at minimum  

*Drive size used in production may vary based on archive  

 

b) Minimum Workstation Specifications 

Standard (Tech, Clinical, Web Viewer, Telerad, Gateway) Workstation—  

Operating System: Windows 11 (latest version)*  

Processor: Intel® Core™ i3-12300 

Hard Drive: 1 TB M.2 SSD 

Ethernet: 1 Gigabit 

Graphics Card: on-board video, DP 

Memory: 16 GB RAM 

Screen Resolution: 1600x1200 pixels or higher 

Optical Drive: 8x DVD+/-RW Optical Disk Drive 

Enterprise Workstation (no Tomo/Mammo)—  

Operating System: Windows 11 (latest version) 
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Processor: Intel® Xeon W-2223 

Hard Drive: 1 TB M.2 SSD 

Ethernet: 1 Gigabit  

Graphics Card: NVIDIA RTX-A4000, 16 GB, 4 DP  

Memory: 32 GB RAM  

Screen Resolution: 3 megapixels or higher  

Optical Drive: 8x DVD+/-RW Optical Disk Drive  

Tomo/Mammo / 3D Workstation / High-End Tech Review Workstation—  

Operating System: Windows 11 (latest version)  

Processor: Intel® Xeon W-2223  

Hard Drive: 1 TB M.2 SSD  

Ethernet: 1 Gigabit  

Graphics Card: NVIDIA RTX-A4000, 16 GB, 4 DP  

Memory: 32 GB RAM  

Screen Resolution: 5 megapixels or higher  

Optical Drive: 8x DVD+/-RW Optical Disk Drive 

c) Accessory Requirements for Use 

• A modern supported Microsoft Operating System  

• A modern supported internet browser  

• Server hardware that meets minimum specifications  

• Workstation hardware that meets minimum specifications  

• Current Virus Protection  

• A tablet with a modern supported version of iOS Operating System for the iOS Tablet Viewer  

• At least a five-button mouse  

• A supported dictation microphone  

• A modern USB keyboard  

• At least a 3MP Monitor for Radiology and a 5MP monitor for Mammography 

 

 

 

Maintenance/Upgrade Procedures: 

Maintenance, upgrades, and warranty replacements are the responsibility of Novarad Technical Services and the 

Original Equipment Manufacturer (OEM). Novarad Technical Services will assist the user if needed. 
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Hardware Disposal: 

Contact Technical Support regarding any hardware warranty replacement or disposal issues before taking action. 

Disposal of hardware should be authorized by technical support and done in accordance with the procedures 

specified in the original equipment manufacturer’s manual. 

 

All patient data is the responsibility of the acquiring site. When the NovaPACS system is decommissioned, the 

control, management, and exporting of all imaging data is 100% the responsibility of the customer. Novarad 

provides access to the NovaPACS software until the migration of data out of NovaPACS and into the new PACS 

system is complete; a table showing all the Study UIDs can also be provided as a reference, if desired. No other 

Novarad assistance or involvement occurs. When the migration is complete, any hardware owned by Novarad is 

required to be wiped by the customer or Novarad Support and returned to Novarad headquarters. In the case 

where NovaPACS was installed and images are stored on customer owned VMs, the Novarad software is simply 

decommissioned by Novarad Support after the images are migrated by the customer, with no other Novarad 

involvement. 

 

Degree of Accuracy for measuring functions: 

Measurements done on DICOM images that include pixel-scaling data are precise within two-pixel lengths. 

NovaPACS does not return a measurement with more precision than is appropriate for the DICOM data and 

resolution of the images. 

Due to the imprecise nature of a computer monitor, a mouse, and a person’s hand, calibrating measurements by 

hand can result in inaccurate measurements. Measurements taken after calibration should be treated as rough 

estimates. Calibration is only valid for the current image unless the Apply to Series option is selected during 

calibration. 

 

Environment: 

NovaPACS’s intended operational environment is located in radiology departments in hospitals and clinics as well as 

imaging centers. Mobile NovaPACS may be used in any environment where mobile devices may be taken. 

 

LIST OF SYMBOLS 

The following symbols appear in this manual: 

 

Symbol Meaning 
 

Indicates important cautionary information such as warnings and 

precautions that cannot, for a variety of reasons, be presented on the 

medical device itself. 

 

Denotes the manufacturer. 

 

Denotes the manufacturer’s European Community representative. 
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Medical Device 

 Denotes the Importer. 

 Denotes the Distributor. 
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CHAPTER 1—GETTING STARTED  

NovaPACS Diagnostic Viewer is a world-class product and is one of the original Picture Archiving and 

Communication Systems (PACS). The NovaPACS Diagnostic Viewer includes many innovations created by Novarad. 

NovaPACS is known in the industry as a product that leads to radiology efficiency through a mouse-driven viewer, 

customizable interface, and easy access to advanced features. NovaPACS Diagnostic Viewer also includes web-

based functionality, dual monitors, viewers, technology tools, an administrative console, and on-site seven-year 

archives.  

Novarad understands that workflow and efficiency are highly valued, and all products are built around these 

concepts. NovaPACS provides radiology departments with the following:  

• The best web-based technology utilizes high-level streaming, imaging, algorithms, and proprietary methods 

for distributing large data sets quickly.  

• Images and reports that are available anytime, anywhere, all accessible via the latest web browser version.  

• A full Diagnostic Viewer that is accessible from any Microsoft Windows computer and location, and is 

feature-rich, including advanced hanging protocols, MIP/MPR, and voice annotation.  

• A user-friendly, easy-to-learn Diagnostic Viewer that has customizable buttons, toolbars, menus, hotkeys, 

and mouse settings. These settings are saved as a user-specific profile that provides continuity when 

changing workstations.  

• An Image Viewer that is mouse-driven and allows the radiologist to focus on the images on the screen 

rather than on keys or buttons.  

• A Study Browser that displays the entire patient’s image history, the number of series for a study, and the 

number of images in a series, along with many other features.  

1-1—INTRODUCING THE STUDY BROWSER AND IMAGE VIEWER 

The Study Browser is essentially the control 

panel for the Diagnostic Viewer. The Study 

Browser displays information in branches or 

lists and shows details such as the entire 

patient’s image history, the number of series for 

a study, and the number of images in a series. 

In addition to these details, the viewable 

columns can be set to show studies with 

existing reports and the name of the reviewing 

radiologist.  

The Image Viewer displays the selected images from the Study Browser. Radiologists can design their workspace 

with the Image Viewer’s flexible display options, allowing them to move efficiently through their caseload.  
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1-2—NOVAPACS DIAGNOSTIC VIEWER SYSTEM  

    Note: NovaPACS is not intended for use on smartphones. Any unsupported mobile platforms display a persistent 

on-screen message of “Not intended for diagnostic use.” 

The following light level conditions are supported for diagnostic reading:  

• A typical radiology reading room (7.3 lux) 

• An office (250 lux) 

• A bright room (850 lux) 

    Note: Lighting environments outside the range of 7.3 to 850 lux are not recommended for diagnostic reading. 

    Note: The brightness setting on the mobile device should always be at 100% for maximum detail. Adjustment 

outside of the maximum brightness is not recommended. 

1-3—ACCESSING THE DIAGNOSTIC VIEWER  

The Diagnostic Viewer functions essentially the same, no matter how it is accessed. There are two ways users can 

access the Diagnostic Viewer: 

1. From a computer or workstation—referred to as accessing the Managed Viewer.  

2. From a web browser—referred to as accessing the Novaweb Launch page. This page is where users can launch 

all Novarad products, including NovaPACS.  

Note: Users are unable to route studies to a machine using the Web Viewer and studies are only cached temporarily 

if studies are sent to the machine. When using the Web Viewer from the Novaweb page, users must write access to 

the machine in order to retrieve images, share patient studies, and to save user preferences locally. All other 

functionality is identical to using a Managed Viewer. 
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THE MANAGED VIEWER 

The Managed Viewer is often faster and allows users to route images directly to the workstation for faster opening 

and display. The Managed Viewer gives users full access to all product functions. Many facilities have a combination 

of both Managed Viewers and Web Viewers. Novarad suggests radiologists and cardiologists use a Managed Viewer 

for best performance.  

LAUNCHING THE MANAGED VIEWER 

Novarad’s Image Viewer icon shows on the computer’s desktop after the Managed Viewer has 

been installed. Double-click the icon to launch the Diagnostic Viewer.  

The login dialog box appears. 

Note: Administrators can configure the 

Diagnostic Viewer to use a Windows login 

as the login for the Viewer. If using this 

configuration, users will not see a login 

prompt. Also, if configured, users can 

select the Remember Me checkbox to be 

automatically logged in for each 

subsequent visit. It is recommended that 

only those with a dedicated machine use 

this option.  

 

THE WEB VIEWER 

The Web Viewer is Novarad’s thin-client version that downloads Image Viewer files temporarily and is accessed 

through a secure server using the Internet. Users must download and use Microsoft’s .NET Framework 4 Client 

Profile to use the Web Viewer from the Novaweb page. This Viewer gives users full access to all product functions 

and can be accessed anytime from any computer through a website and a secure server.  

 

1. Diagnostic Viewer—Novarad’s Diagnostic Viewer accessed 

via the web provides access to DICOM PACS with full 

product functionality. Radiologists and Radiology 

departments can use this version to work from an office, 

clinic, and/or hospital.  

2. HTML5 Viewer—The HTML5 Viewer is a web-based 

viewer.  

3. Single Study Access—Users can assign a single-study 

password in the NovaPACS Diagnostic Viewer. 
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LAUNCHING THE WEB VIEWER FROM THE NOVAWEB PAGE 

To launch the Web Viewer from the Novaweb page, open the web browser and enter the site’s PACS server address 

in the address bar. Press Enter.  

Click the Diagnostic Viewer link and enter the credentials on the login page to access the Diagnostic Viewer.  

• MPR/3D Plug-in—System administrators can download this one-time plug-in when using the Web Viewer. 

• Cardio Reporting Plug-in—Users should download and run this one-time plug-in before using the Web Viewer 

with EncaptureMD.  

Important: The Novarad Web Viewers now require multi-factor authentication. When users log in, they 

will be prompted to register for multi-factor authentication. Users will be sent a one-time passcode and 

instructions on how to use the MobileRad App to complete multi-factor authentication.  

Warning: Novarad’s Web Viewers are not intended for diagnostic purposes. 

1-4—LOGGING INTO THE DIAGNOSTIC VIEWER 

Click the Diagnostic Viewer option. Enter the username and password and click Login.  

LOGGING IN AUTOMATICALLY 

Users can select the Remember Me checkbox in the login dialog box. This saves the username and password for 

future logins and the Diagnostic Viewer launches automatically.  

Note: Administrators can enable/disable the ability to automatically log in on the Machines tab of the NovaPACS 

Admin Console. If the option to automatically login is enabled, the Remember Me checkbox is available on the login 

dialog box. If disabled, no Remember Me checkbox displays. Use the Remember Me checkbox with caution, as any 

user accessing the NovaPACS Diagnostic Viewer is automatically logged in as this user until deselected on the Data 

Sources page. It is recommended that only those with a dedicated machine use this option. 

Note: Administrators should contact Novarad Support to have their users’ passwords auto expire after a set number 

of days.  

LOGGING INTO A DATA SOURCE 

If the site uses other servers to access images, users receive a prompt to log into the other data sources when the 

Diagnostic Viewer tries to connect to it. Some sites need to log in multiple times—which logs them into their multiple 

data sources.  

Note: If users click Cancel for any data source login prompt, they can access and log into that data source at any 

time from within the Diagnostic Viewer. Clicking Cancel returns users to the Novaweb page.  

This prompt also appears when selecting an available data source within the Diagnostic Viewer that has not been 

authenticated. 
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Note: Contact a system administrator to log in across all data sources using the same username and password for 

each additional server.  

Users can also log into data sources from inside the 

NovaPACS Diagnostic Viewer. If the user has not logged into 

an available data source at the time of login, they can click 

the name of the data source listed at the bottom of the 

Study Browser window to access the login dialog box for 

that data source. This enables users to quickly log into data 

sources at any time from the NovaPACS Diagnostic Viewer.  

MULTI-FACTOR AUTHENTICATION 

NovaPACS includes multi-factor authentication to help safeguard patient 

information. NovaPACS multi-factor authentication is integrated with 

MobileRad. Upon client authentication, users will see a dialog informing 

them that they must enroll in multi-factor authentication. The dialog 

provides instructions and a QR code that will link to the MobileRad app. 

The QR code contains the server name and username which can be used 

to log in to MobileRad. The server name is displayed above the Continue 

and Skip for Now buttons. Clicking Continue will initiate two-factor 

authentication with MobileRad.  

After a successful client authentication, users will see the “A multi-factor 

authentication approval request has been sent” message. If users did not 

receive a request, click the Didn’t receive a request? link to obtain a one-

time passcode. The one-time passcode prompt will provide instructions 

and a QR code that will link to MobileRad.  

NovaPACS multi-factor authentication is also integrated with Duo 

Security. When users login, if they are enrolled for multi-factor 

authentication, they will be sent an approval request to their registered 

device. Once the request has been approved, users will then have to scan 

a QR code to receive a one-time passcode to enter.   

If users are having trouble with the multi-factor authentication, there is a 

Still need help? link located under the passcode field. This link will walk users through how to find their one-time 

passcode. Once users have correctly entered their one-time passcode, they will be logged in.  
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If users select the Remember Me button on the login screen, the system will remember the device so users will not 

have to enter two-factor authentication every time they log in. 

Users can see who has been exempted from MFA through the Admin Console’s Users Tab. Users will see an MFA 

exempt column. If a user has an ‘X’ by their name, they are exempt. 

DISABLED DUPLICATE DATA SOURCES 

Users can be prevented from logging into duplicate data sources simultaneously—which could lead to studies 

inadvertently being displayed multiple times. Instead, if the user clicks on a disabled duplicate data source, they 

receive a prompt asking to switch their current data source to the disabled duplicate; hence, they only use one 

instance of that data source at any given time. 

How to find and use duplicate data sources: 

Locate the Duplicates list (if available) in the bottom right-hand corner 

of the Study Browser window.  

Click to see all disabled duplicate data sources. 

Select the desired data source that is currently disabled.  

Click Yes to assign the 

duplicate as the preferred 

data source or click No to 

cancel the preference change. 

Users may be prompted to log 

in, depending on the 

configured login options.  

The new data source is displayed along the bottom of the 

Study Browser, and the previous data source is now listed in 

the Duplicates list in the bottom right-hand corner of the 

Study Browser.  

Note: The site may not have any disabled duplicate data sources if there are no remote connections set up for 

NovaPACS. Users should always save (export) a copy of user preferences before switching data sources to a disabled 

duplicate as a failsafe. The NovaPACS Diagnostic Viewer automatically determines if a data source is a duplicate of 

another and needs to be disabled.  
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CHAPTER 2—USING THE STUDY BROWSER 

The Study Browser functions as the control panel for the Diagnostic Viewer. The Study Browser displays information 

including study information, patient information, patient history, the number of series in a study, the number of 

images in a series, and applicable reports for studies. In addition to these details, the viewable columns can be set 

to show information such as studies with existing reports and the name of the reviewing radiologist. 

  The Study Browser is where users can search for and open their studies into the Image Viewer. Users can customize 

search filter options on the various worklist tabs in the Study Browser to quickly locate their studies.  

 

 

 

 

Users also have access to multiple worklist tabs including the Search 

Tab, the Assigned Worklist tab, Advanced Worklist tabs, the 

Teaching Files tab, and the Preliminary Impressions tab. These 

worklist tabs offer users additional ways to search for studies and 

save frequently used search criteria. Users can streamline their 

workflow and reduce the time spent searching for studies using the 

various worklist tabs in the Study Browser.  

 

 

 

2-1—FILTERED STUDIES LIST 

The Filtered Studies list is the top list in the Study Browser window by default and displays the list of studies that 

match the information in the search filters. 

Note: Lists can be dragged and dropped to new locations in the Study Browser. 

The Filtered Studies list is on all tabs in the Study Browser. 

The Filtered Studies toolbar lists items, and right-click menus 

vary depending on which tab is being used. 
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DISPLAY 

Users can set the Filtered Studies list to display all studies for 

each of their patients or they can set this list to only show the 

most recent study for their patients.  

If users set the Filtered Studies list to show only the most 

recent study for their patients, all prior studies are located 

only on the Patient History list in the Study Browser. The 

study displayed for the patient in the Filtered Studies list is 

the most recent study that matches the search filter criteria.  

If the Filtered Studies list is set to display all studies for patients, the list shows all studies for patients that match 

the search filter criteria.  

The Filtered Studies list displays information in columns, including (but not limited to) the following: 

• Local—displays whether studies are cached locally. 

• Open—displays each study that is open. 

• Last Name—displays the patient’s last name. 

• First Name—displays the patient’s first name. 

• Birth Date—displays the patient’s date of birth. 

• Modality—displays the modality for the study. 

• Study Description—displays the study description that was ordered or entered at the modality for the study.  

Note: The Study Description column displays the Procedure Name field from Nova RIS, the Study Description from an 

applicable HL7 message, or the Study Description manually entered at the modality. Novarad Support can configure 

the system to automatically update the PACS Study Description field when edits/changes are made in Nova RIS. For 

more information about this configuration, contact Novarad Support. 

• Patient ID—displays the patient’s identification number. 

• Status—indicates if the study is New, Reviewed, Checked Out, Verified, Imported, or Locked for Edit 

• Accession #—displays the accession number (or uniquely identifying number from Nova RIS or a HIS/EHR 

system) for the study. 

• Procedure Status—displays the Nova RIS status of the procedure. 

• Facility—displays the facility where the study was performed. 

• Study Date—displays the date of the study. 

• Report—indicates if a report has been saved if created in Novarad products. 

• Preliminary Impression Status—indicates if the study has an Agree, Disagree, Indeterminate, or New 

preliminary impression status. 

• Report Created By— This column displays who created the report. 
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• Triage—displays triage values so users can quickly identify studies based on their triage values. For example, a 

CVA icon will appear for stroke cases.  

• QA—displays which studies do not have orders that match the study. This will be displayed with a red QA flag. 

• Technologist—displays the Technologist who performed the study.  

• Validated By— displays the Technologist or Admin who validated the study.  

• Procedure Codes— This displays the procedure code for the study. This helps users easily identify similar 

studies. For instance, if users are reviewing an extensive patient history for a specific procedure, they can 

search for the procedure code that corresponds to the exact procedure they are looking for. The Procedure 

Code is available on all study lists. 

• Patient Location— shows where in the hospital the patient is currently located.  

 

Note: Customize the columns that appear in the list by right-

clicking the column heading bar and selecting/deselecting 

the heading labels in the drop-down list. Rearrange the 

order of the columns by clicking and dragging the column 

headings to the preferred locations. Auto-fit the column to 

its contents by double-clicking the right divider of the column 

heading. 
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INCLUDE / EXCLUDE FILTER 

The Include / Exclude control is used with the Study filters as shown below. The control is found above each 

respective filter. 

• If the control is set to Include, the control remains visible while setting the filter. When work in the filter is 

complete, the control is hidden. 

 

• If the control is set to Exclude, the control remains visible while setting the filter, and the filter value(s) displays 

with a strikethrough.  

 

• If the filter is set to (All), the control does not display. If a filter is set to Exclude and the filter value is changed 

to (All), the control reverts to Include. 

•  The filter controls default to Include. 

THE INCLUDE / EXCLUDE STATE OF EACH FILTER IS SAVED WITH THAT FILTER AND PERSISTS WITH THE 

FILTER.ALWAYS SHOW NON-REVIEWED STAT STUDIES 

Novarad Support can configure the 

NovaPACS products to always show non-

reviewed STAT studies regardless of search 

filter settings. This ensures that users see 

STAT studies when they come through to give them the proper prioritization. 

The Always Show Non-Reviewed STAT Studies feature applies to all Novarad products such as the NovaPACS 

Diagnostic Viewer, the NovaPACS Admin Console, and the NovaPACS HTML5 Viewer. 

Users see STAT studies regardless of their 

search filters. This prevents users from 

inadvertently hiding STAT studies while 

searching in NovaPACS.  
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In addition to seeing all non-reviewed STAT 

studies, users may also see STAT studies of 

all statuses if they meet the specified 

search criteria. For example, if users are 

searching for all CT studies, they see all CT 

studies including reviewed STAT studies as 

well as all non-reviewed STAT studies from 

all modalities. Users can sort non-STAT 

studies by clicking the Status column, but 

the STAT studies display at the top 

regardless. 

SEARCH TAB FILTERED STUDIES LIST 

TOOLBAR 

 

• Select All—Selects all the studies in the list 

• Add to Worklist—Adds the selected study to the current user’s Assigned Worklist 

• Open—Opens the selected study in the Image Viewer 

• Open + Old—Opens the selected study and the most recent related study in the Image Viewer 

• Open in Current Workspace—Opens the selected study in the current open workspace in the Image 

Viewer 

• Assign—Allows users to assign studies to their own Assigned Worklist or another user’s Assigned 

Worklist  

• Studies per Data Source—Allows users to select the number of studies displayed from their data 

source(s) 

Note: Selecting a large number of studies could cause the product to perform more slowly. 

ADVANCED WORKLIST FILTERED STUDIES TOOLBAR 

 

See the descriptions above. 

Note: Toolbar buttons may be disabled if a study is not currently selected.  
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SMART WORKLIST 

The Smart Worklist feature allows users to view a study’s due date based on contractual agreements and study 

protocols. The Smart Worklist displays a due date and time in the NovaPACS Study Browser to communicate the 

sense of urgency for applicable studies. Once a new study is routed from the modality, the image processor 

calculates a due date. When a new study routes, the turnaround time populates based on the Apply Contract 

rule(s), as designated in the Admin Console. 

After configuration in the Admin Console, users can view the Due column by right clicking the column heading. 

Once the drop-down list appears, select Study, then click Due to view due dates, as applicable. To sort the studies 

by due date, click the column header. 

Note: The Due column is hidden by default and must be selected to display correctly.  

Users continue to see STAT studies regardless of the search filters and Due column. This prevents users from 

inadvertently hiding STAT studies. The Study Browser now calls attention to studies that are due soon, or are 

overdue, by highlighting the entire row golden yellow, to differentiate between STAT studies, which appear red. If 

the user has selected the STAT Studies on Top site setting, STAT studies appear first, then due/overdue studies 

appear directly under the STAT studies.  

 

Additionally, when users select Open Next 

Worklist Item, NovaPACS automatically 

prioritizes due and overdue studies after STAT 

studies and before other studies.  

 

 

 

2-2—PATIENT HISTORY LIST 

The Patient History list displays all completed studies for the selected patient including all time frames and 

modalities.  

This list appears on the left side of 

the Study Browser window, just below 

the Filtered Studies list, by default. 

The Patient History list is on all tabs 

in the Study Browser (i.e., the Search 

tab, Assigned Worklist tab, and 

Advanced Worklist tabs). 

Note: Lists can be dragged and dropped 

to new locations in the Study Browser. Lists can also be toggled on/off at any time.  

The Patient History list displays information in columns, including (but not limited to) the following: 
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• Local—displays whether studies are cached locally 

• Open—displays each study that is open 

• Last Name—displays the patient’s last name 

• First Name—displays the patient’s first name 

• Birth Date—displays the patient’s date of birth 

• Modality—displays the modality for the study 

• Study Description—displays the study description that 

was ordered or entered at the modality for the study  

Note: The Study Description field displays the Procedure 

Name field from Nova RIS, the Study Description from an 

applicable HL7 message, or the Study Description manually 

entered at the modality. Novarad Support can configure the 

system to automatically update the PACS study description 

field when edits/changes are made in Nova RIS. For more 

information about this configuration, contact Novarad 

Support. 

• Patient ID—displays the patient identification number 

• Status—indicates if the study is New, Reviewed, Checked Out, Verified, Imported, or Locked for Edit 

• Accession #—displays the accession number (or uniquely identifying number from Nova RIS or a HIS/EHR 

system) for the study 

• Procedure Status—displays the Nova RIS status of the procedure 

• Procedure Code—displays any Procedure Codes 

Note: If Procedure Codes and relationships have not been added on the Procedure Codes tab of the 

NovaPACS Admin Console, there may not be any information in the Procedure Codes display column of the 

Patient History List.  

• Facility—displays the facility where the study was performed 

• Study Date—displays the date of the study 

• Report—indicates if a report has been saved—if created in Novarad products 

• Preliminary Impression Status—indicates if the study has an Agree, Disagree, Indeterminate, or New 

preliminary impression status 

Note: Customize the columns that appear in the list by right clicking the column heading bar and 

selecting/deselecting the heading labels in the drop-down list. Rearrange the order of the columns by 

clicking and dragging the column headings to the preferred locations. Auto-fit the column to its contents by 

double-clicking the right divider of the column heading.  

• Select All—Selects all the studies in the list 

• Add to Worklist—Adds the selected study to the current user’s Assigned Worklist 

• Open—Opens the selected study in the Image Viewer 
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• Open + Old—Opens the selected study and the most recent, related study in the Image Viewer 

• Open in Current Workspace—Opens the selected study in the current open workspace in the 

Image Viewer 

2-3—SERIES LIST 

The Series list displays all the series that 

are part of the selected study. The Series 

list appears below the Filtered Studies list 

and to the right of the Patient History list in 

the Study Browser Window, by default. The 

Series list is on all tabs in the Study 

Browser (i.e., the Search tab, Assigned 

Worklist tab, and Advanced Worklist tabs). 

When NovaPACS receives a finalized, 

PDF DICOM report from Nova RIS, it 

displays as a series in the study titled 

Novarad Diagnostic Report.  

Note: The Novarad Image Processor 

creates a new placeholder study if one 

doesn’t exist or if there is a diagnostic report that doesn’t match an existing NovaPACS study. Admins can then go 

back later and fix the studies once they find out why there wasn’t a matching NovaPACS study for the report.  

The series details such as series description and image count display in the Series list. The Series list displays 

information in columns, including (but not limited to) the following: 

• Critical Findings—displays an indicator if a radiologist has 

created a critical finding for the selected study/series 

• Description—displays the series description, generated by 

the modality 

• Image Count—displays the number of images in each 

series for the selected study 

• Modality—displays the modality for the study 

• Series ID—displays the series identification that provides a 

unique identification for each series within the study 

(generated by the modality) 

• Series UID—displays the unique identifier for each series 

for the selected study (generated by the modality) 

• Study UID—displays the unique identifier for the 

selected study (generated by the modality)  

• Select All—Selects all the studies in the list 

• Open—Opens the selected study in the Image Viewer 
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2-4—PRELIMINARY IMPRESSION LISTS 

The NovaPACS Diagnostic Viewer now supports a primary/secondary read workflow where users can review images 

and record preliminary impressions and where radiologists can view and agree/disagree with the findings.  

RECORDING PRELIMINARY IMPRESSIONS 

1. First, users need to enable the Preliminary Impression list. Click View in the Study Browser and select 

Preliminary Impressions Tab.  

Note: By default, this option is disabled in the Study Browser. 

2. Once selected, the Preliminary Impression list appears. 

 

 

3. To add a preliminary impression, select a study in the Study 

Browser, and click the Add icon in the Preliminary Impression list. 

 

 

 

 

4.  A Preliminary Findings text box displays. Click in this text box and 

type the preliminary impression.  

 

 

5. Click Save to record it. Click Cancel to cancel out of creating a preliminary impression. 

 

6. The preliminary impression now displays on the 

Preliminary Impression list under the Preliminary Findings 

heading. This has a time and date stamp for the user that 

created the finding. Users cannot edit a recorded 

preliminary finding. 

Note: Once the preliminary finding is saved and recorded, 

the study has a New Preliminary Impression Status—so 

users can search for studies that have preliminary 

impressions. This is discussed in greater detail in later 

sections. 

 

LOCATING STUDIES WITH PRELIMINARY IMPRESSIONS 

There is a Preliminary Impressions worklist tab that is enabled by clicking View → Preliminary Impressions Tab. 
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There is also a Preliminary Impression Status search 

filter that can be added to the Search tab, Advanced 

Worklist tabs, and the Preliminary Impression tab. 

 

Users can also add a Preliminary Impression Status 

display column in the Study Browser.  

Studies that have a Preliminary Impression waiting for 

approval have a New Preliminary Impression status. 

 

 

 

 

 

REVIEWING PRELIMINARY IMPRESSIONS 

 

1. Enable the Preliminary Impression list by clicking View in 

the Study Browser and selecting Preliminary Impressions 

Tab.  

2. Once selected, the Preliminary Impression list appears. 

3. Search for and select the study with the preliminary 

impression.  

4. Verify that the selected study has a preliminary impression by viewing the impression on the Preliminary 

Impression list, then click the Add icon. 

 

5. A new text box displays. Click in the Review Comments text 

box and type the preliminary impression review comments.  
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6. Select a status from the Status drop-down list (Agree, 

Disagree, or Indeterminate). 

 

 

 

7. The preliminary impression review is now 

displayed on the Preliminary Impression list 

under the Preliminary Findings heading and 

below the initial preliminary impression. This has 

a time and date stamp for the user that created 

the review.  

8. Click Save to record the review or Cancel to cancel out of creating a preliminary impression review.  

Note: Preliminary finding reviews cannot be edited once they have been saved. All preliminary impressions and 

reviews for the selected study display on the Preliminary Impression list. Users can see the preliminary impression 

review information on the Preliminary Impression Activity list in the Study Browser.  

 

9. Once the preliminary impression review is 

saved and recorded, the study has the 

Preliminary Impression Status of what the 

radiologist selected (Agree, Disagree, 

Indeterminate, or New) 

LOCATING REVIEWED PRELIMINARY 

IMPRESSIONS 

Users can locate a reviewed Preliminary Impression, review the comments, and add additional review comments to 

the Preliminary Assessment, if applicable. This enables the user to correct their initial impression based on feedback 

from the radiologist.  

How to locate Reviewed Preliminary Impressions in a study:  

1. First, enable the Preliminary Impression list by clicking View in the Study Browser and selecting Preliminary 

Impressions Tab. 

2. Search for and select the study with the 

preliminary impression and review using the 

Preliminary Impression Status search filter in the 

Study Browser.  

Users can search by Agree, Disagree, or 

Indeterminate Preliminary Impression status to 

find a reviewed Preliminary Impression.  
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Users can also select multiple Preliminary Impression statuses to broaden their 

search.  

 

 

 

 

 

2-5—IMAGES TAB 

The Images tab displays all the series preview thumbnails in the list that are separate from the other lists/tabs.  

The Image list is located as a tab next 

to the Series list in the Study Browser 

by default. 

 

 

 

At any time, the user can double-click a series preview thumbnail in the Images list to open that series in the Image 

Viewer. The study/series display is dependent upon the selected modality’s hanging protocol layouts.  

Users can also left click and drag a series 

preview thumbnail image into the Image 

Viewer at any time.  
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2-6—REPORT TAB 

The Report tab displays the selected study’s report preview in a tab that is separate from the other lists/tabs. The 

Report tab appears below the 

Filtered Studies list and to the 

right of the Patient History list in 

the Study Browser Window by 

default. 

Print—opens a print dialog 

allowing the user to print the 

report. 

 

Clicking Print Report opens a standard print dialog box.  

 

Note: When users sign and save reports in NovaPACS, the 

preliminary report displays in all report locations depending on 

configuration. Once the report is finalized in Nova RIS, a DICOM-

encapsulated PDF report is sent to NovaPACS and added to the 

study. This DICOM PDF report displays in any location where 

users access reports. 

 

 

 

 

 

 

 

 

2-7—STUDY BROWSER TAB FUNCTIONALITY  

Each list or section in the Study Browser has a tab at the top with its name listed. Users can click and drag tabs to 

rearrange them. 

DRAG AND DROP LISTS/TABS 

The drag-and-drop functionality gives users the option to move each list/tab (Filtered Studies, Patient History, 

Series, Images, Report, and Preliminary Impressions lists/tabs) to a new location in the Study Browser. 

1. Click and drag the list/tab. 
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2. As the list is dragged, hover the cursor over the docking station 

icon for any section in the Study Browser. 

Users can drop the list to the top, bottom, left, or right of the 

current docking section using the docking station icon.  

 

Users can also drop the list in the middle of 

the docking station icon, which groups the 

list as a new tab with the current tab(s). 

3. Once the destination is selected, release the 

mouse button and the list appears in its new 

location. 

 

Note: Users may drag and drop their lists to any location 

and/or new window in the Study Browser. However, the 

ability to drag lists into independent windows and 

maintain an optimal display depends upon the number of 

monitors used. Using a single monitor to display the Study 

Browser’s lists each as independent windows may not 

display all relevant details optimally. 

 

 

 

 

 

 

 

 

2-8—HANGING PROTOCOL LAYOUTS 

Hanging Protocol Layouts are 

the saved layouts associated 

with a specific Hanging 

Protocol for displaying study 

images in the Image Viewer.  

 

 

If activated, the Hanging 

Protocol Layouts section is located at the bottom of the Study Browser window and displays thumbnail images of the 

layouts defined for the currently opened study. This section only displays content in the Study Browser if a study is 

open in the Image Viewer. 
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The title of this section also lists the current Hanging Protocol. This appears on all tabs in the Study Browser (i.e., 

the Search tab, Assigned Worklist tab, and Advanced Worklist tabs). 

 

 

To activate the Hanging Protocol Layouts section in the Study Browser 

window, click View in the Study Browser and select Hanging Protocol 

Layouts. Users can also press the default hotkey F4.  

The Hanging Protocol Layouts section collapses by default at the bottom 

of the Study Browser. To view the current study’s hanging protocol 

layouts, hover the cursor over Hanging Protocol Layouts.  

 

 

 

The Hanging Protocols list slides out to display as a panel. 

The Hanging Protocols list displays until users click anywhere 

else in the Study Browser. Interacting with other Study 

Browser features collapses the list.  

 

 

 

At any time, users can change the panel’s slide/collapse 

functionality to a pinned list by clicking the Pin icon in the 

top, right-hand corner of the Hanging Protocols list. It can be 

unpinned and returned to a sliding panel at any time using 

the same pin icon.  

 

 

To use Hanging Protocol Layouts, select a layout to apply it to the current study in the Image Viewer.  

Note: Press the number keys on the keyboard to switch to the corresponding layout in this list.  
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Users can Create, Remove, Duplicate, and Edit 

layouts using the links on the Hanging Protocol 

Layouts list.  

 

 

 

 

2-9—THE SEARCH WORKLIST 

The default worklist on the Study Browser’s home window is the Search worklist. The Search worklist is used with 

the filters on the page to locate specific information. 

Note: To the right of the Search worklist is an Assigned Worklist that can 

be shown/hidden using the View menu. There is also an Advanced 

Worklist that can be used to create advanced worklists with custom 

settings.  

 

 

 

 

CUSTOMIZING THE FILTERS GROUP 

The default settings for the filters vary depending on each 

user’s role. Users can add or remove filter fields by right 

clicking the filter’s bar and selecting the appropriate 

option in the drop-down list. Filters are organized by 

related area, and active filters on the screen have a 

checkmark beside them.  

Note: The Saved Filters and Data Source fields are not optional 

and do not appear in the optional filters list.  

CUSTOMIZING AND SAVING FILTERS 

The Saved Filters drop-down list allows users to create and save custom filters for settings used on a regular basis. 

1. Select the preferred settings by right clicking the filters 

and selecting options from the drop-down lists.  
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2. Select Edit Saved Filters from the Saved Filters drop-down 

list.  

 

3. Enter a name for the new filter in the Save Current Filters As field.  

4. Click OK to save the filter. Click Cancel to cancel out of creating a saved 

filter. 

 

 

 

APPLYING A SAVED FILTER 

1. Click the Saved Filters drop-down list.  

2. Select the saved filter from the list. 

 

 

DELETING A SAVED FILTER 

1. Click the Saved Filters drop-down list.  

2. Select Edit Saved Filters.  

3. In the Select Saved Filters to Delete box, click to check the box next 

to the unwanted filter.  

4. Click OK to delete the filter. Click Cancel to cancel out of deleting 

the filter. 

USING THE SEARCH FILTERS 

The filters are a group of search fields just below the Search/Worklist tabs along the top of the Study Browser 

Window. These filters allow users to select the information to display in the Filtered Studies list. Patient searches 

can be conducted more quickly and efficiently using the filters in this tab. Users can search for studies using any 

combination of search filters. As information is entered into the filters, the Study Browser automatically returns 

search results. Users can disable the automatic search function of the Study Browser and configure the search 

filters to only return results after clicking Search. Disabling automatic search could be especially useful for 

improving search speed and efficiency for facilities with large amounts of customer data. 
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Note: The Auto Load Results checkbox is located in the search filter section under the 

Search button. This option is selected by default. If users deselect Auto Load Results, they 

must click Search to manually search for their studies. Otherwise, users are prompted to do 

so. Users can select/deselect Auto Load Results at any time. 

 

THE DATA SOURCE FILTER 

The Data Source Filter allows users to filter a search 

using the various sources that may contain patient data. 

Click the Data Source drop-down list and select one or 

more of the data source checkboxes. Users can also 

select All to select all available data sources.  

 

Data Sources display at the bottom right of the Study Browser window. The indicator light to the left of the Data 

Source display provides a visual indicator of the status of that server. 

A green icon indicates the data source connection is active and the status is available, and red signifies the data 

source is unavailable or disconnected. Hover the mouse cursor over the Data Source display at the bottom of the 

Study Browser window to see the connection status and click to see the Edit Data Source dialog box.  

Users may have DICOM Pass Through enabled in NovaPACS. This allows users to securely view images and data 

from off-site archives and PACS servers by remotely accessing them through NovaPACS. DICOM Pass Through 

servers are set as a data source that interacts normally with NovaPACS. Users can search for or filter out results 

from a DICOM Pass Through server the same way they would any other data source.  

THE TIME FRAME FILTER 

The Time Frame Filter allows users to select specific time periods to filter a search. Users can search all time 

frames by selecting All in the Time Frame Filter. Users can also select from the time frames listed in the drop-down 

list or create a custom time frame for this filter.  

Note: If users deselect the Time Frame filter from the search filter list, the time frame 

defaults to the last three hours and only displays studies added in that time frame.  

To create a custom time frame: 

a. Click the Time Frame drop-down list.  

b. Select Custom at the bottom of the list.  
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c. Click the arrow for the drop-down calendar to choose a specific 

date for the Start Time and use the arrows next to the time to set 

the exact starting time frame. 

d. Click the arrow for the drop-down calendar to choose a specific 

date for the End Time and use the arrows next to the time to set 

the exact ending time frame.  

e. Click OK to apply the new custom Time Frame Filter. 

 

 

THE MODALITY FILTER 

The Modality Filter allows users to search for data from a specific 

modality. Users can select just one modality to search or select several 

modalities.  

Click the Modality Filter drop-down list and click the checkboxes next to 

the modality options to select or deselect them.  

Note: The server selected as the current data source provides the modalities that are on the Modality Filter drop-

down list. If multiple data sources are selected, the Modality Filter drop-down list contains a combination of all 

modalities from all data sources. 

THE RADIOLOGIST FILTER 

The Radiologist Filter allows users to filter studies that are associated with a Radiologist.  

Enter the Radiologist’s username, last name, or first name. 

All studies that contain those letters or that last name are 

returned in the search list. 

Note: Users cannot search for a radiologist with both a first and last name. Search for either last name or first name.  

THE REFERRING PHYSICIAN FILTER 

The Referring Physician filter allows users to filter studies that are associated with a Referring Physician.  

Enter the Referring Physician’s username, last name, or first 

name. All studies that contain those letters or that last name 

are returned in the search list. 

Note: Users cannot search for a Referring Physician with a first and last name combined. Search for either last name 

or first name.  
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THE STATUS FILTER 

Users can filter results based on the study’s status. Click the Status Filter drop-down 

list and choose from All, Checked Out, Imported, Locked for Edit, New, Reviewed, 

and/or Verified.  

 

 

 

THE CHECKED OUT FILTER 

The Checked Out Filter allows users to filter results based on who has checked 

out the studies.  

Enter a username. All studies that contain that username are returned in the search list. 

THE PATIENT GROUP FILTER 

The Patient Group filter allows users to filter by Patient Group.  

Click the Patient Group drop-down list and click the checkboxes next to the 

patient groups to select or deselect them.  

 

THE STUDY UID FILTER 

The Study UID filter allows users to search for studies by their study unique identification (UID).  

Enter all or part of the Study UID in the search field. All studies that contain those numbers are returned in the 

search list. 

THE PATIENT ID FILTER 

The Patient ID filter allows users to search for studies by the 

patient identification number (PID).  

 

Enter the first few characters or the complete Patient ID of the patient. All studies associated with a Patient ID 

beginning with the characters entered are returned in the search list.  

THE LAST NAME, FIRST NAME, AND ACCESSION # FILTERS 

The Last Name, First Name, and Accession # filters all 

function in the same manner. By entering the first few 



 

Page 27 of 169   

 

NovaPACS User Manual 

characters of the patient’s last name, first name, or accession 

number, the filters return all results that contain those letters 

or numbers in the Filtered Studies list.  

THE ASSIGNED TO FILTER 

The Assigned To filter allows users to filter studies by user for studies that 

have been assigned.  

Click the Assigned To drop-down list and select an option.  

PRELIMINARY IMPRESSION STATUS FILTER  

The Preliminary Impression Status filter allows users to filter studies by Preliminary 

Impressions status. 

Click the Preliminary Impression Status drop-down list and choose from All, Agree, 

Disagree, Indeterminate and/or New.  

 

STUDIES PER DATA SOURCE FILTER 

The Studies per Data Source filter allows users to select the number of studies to view from 

each source. 

Click the arrow next to the drop-down list and select the quantity that best fits the search 

needs (50, 100, 250, 350, 500, 1000, or 2000). 

 

TEACHING FILE SEARCH FILTERS  

If Teaching Files have been enabled, users can add Teaching File search filters 

to the worklist tabs.  

Note: To learn how to enable this feature and to learn more about Teaching Files, see 

Chapter 5, section 5-17—Teaching File.  

Right click the search filter area, hover the cursor over Teaching File, and select 

a Teaching File search filter option from the drop-down list.  

Users must set the Teaching File search filter to Yes before they can search for saved 

Teaching Files.  

Note: When the Teaching File search filter is set to Yes, users can only search for Teaching Files 

and not original studies.  

Users can also select All to search for both teaching files along with real studies. 
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STUDY OF INTEREST SEARCH FILTER 

Users can also add the Study of Interest filter to search for studies that 

have been marked as Studies of Interest—a flag that signifies that users 

want to come back to it later or to create it as a Teaching File study at a 

later time.  

Right click the search filter area, hover the cursor over Study, and select 

Study of Interest from the drop-down list.  

The Study of Interest filter appears in the filters bar, and users must set the filter to Yes to search for studies of 

interest only.  

Users can also select the All option to mix both studies of interest along with other studies. 

AUTO-HIGHLIGHTED TEXT IN SEARCH FILTERS 

When users press Tab to navigate between search filters, any previously entered text is automatically highlighted. 

This enables users to quickly type over or delete text.  

1. Log into the NovaPACS Diagnostic Viewer and access the 

Study Browser.  

2. Click a text input field in the search filters section such as the Patient ID, Last Name, or First Name search 

filter.  

3. Press Tab to navigate to the next search filter.  

Any pre-entered text is automatically highlighted.  

Note: The Auto-Highlight option only works on text input search filters. 

Information is not highlighted on drop-down search filters such as Data 

Sources or Time Frame. 

2-10—THE ASSIGNED WORKLIST 

The Assigned Worklist is located to the right of the Search worklist when activated and is used primarily to display 

studies that have been assigned to the currently logged in user.  

The Assigned Worklist is an effective tool for large 

groups of users that read images at the same time 

from a Filtered Studies list. The Assigned Worklist 

shows studies that have been added by the user to 

their own Assigned Worklist to view later, or that 

have been assigned to the user’s Assigned Worklist 

by someone else. Radiologists can move studies  

into their worklist for review or assign studies to another user’s worklist for specific users or larger groups to review. 
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DISPLAY 

The Assigned Worklist displays information in the same way information is displayed in the Search tab—with a 

Filtered Studies, Patient History, and Series list. Some menu items are not available on the Assigned Worklist, 

including Add to Worklist.  

These options are available on both the Search tab and the Advanced Worklist tabs. 

 

ACTIVATING THE ASSIGNED WORKLIST 

Users can activate the Assigned Worklist tab by selecting View 

in the Study Browser and selecting Worklist. Users can also 

press the default hotkey F2. The Assigned Worklist tab appears 

next to the Search tab in the Study Browser.  

The Assigned Worklist also appears automatically when a study 

is added to the worklist.  

USING THE ASSIGNED WORKLIST SEARCH FILTERS 

The filters are a group of search fields just below the Assigned Worklist tab along the top of the Study Browser 

window. These filters allow users to select the information to display in the Filtered Studies list. Patient searches can 

be conducted more quickly and efficiently using the filters in this tab. Users can search for studies using any 

combination of search filters.  

THE DATA SOURCE FILTER 

The Data Source filter allows users to filter a 

search using the various sources that may contain 

patient data. Click the Data Source drop-down 

list and select one or more of the data source 

checkboxes. Users can also select All to select all 

available data sources.  

THE TIME FRAME FILTER 

The Time Frame filter allows users to select specific time periods to filter a search. Users can search all time frames 

by selecting All in the Time Frame filter. Users can also select from the time frames listed in the drop-down list or 

create a custom time frame for this filter.  

To create a custom time frame: 

1. Click the Time Frame drop-down list.  

2. Select Custom at the bottom of the list.  
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3. Click the arrow for the drop-down calendar to choose a specific date for the Start Time and use the arrows 

next to the time to set the exact starting time frame. 

4. Click the arrow for the drop-down calendar to choose a specific date for the End Time and use the arrows next 

to the time to set the exact ending time frame.  

5. Click OK to apply the new custom Time Frame filter.  

THE STATUS FILTER 

The Status filter allows users to filter results based on the status of the studies being searched. Click the Status 

Filter drop-down list and choose from All, Checked Out, New, Reviewed, and/or Verified.  

THE ASSIGNED TO FILTER 

The Assigned To filter allows users to filter studies by user for studies that have been assigned.  

Click the Assigned To drop-down list and select an option.  

2-11—ADVANCED WORKLISTS 

Users can create sets of filters for specific conditions such as reading 

certain types of exams or reading at certain locations. This 

eliminates the need to change filters on the Search worklist 

constantly. These preferred filters are created using the Advanced 

Worklist option. The Advanced Worklist is located to the right of the 

Study Browser’s Search worklist. The worklist is either labeled 

Advanced Worklist or a blank worklist. 

CREATING ADVANCED WORKLISTS 

1. Select the blank or empty tab to the right of the Search worklist.  

2. Select New and the options window expands. 

3. Create a name for the Worklist by typing it into the 

Worklist Name field.  

4. Select the preferred criteria in each search field using 

the drop-down lists.  

Note: To set a second set of search criteria, click + below the 

search criteria columns. An additional row of search criteria 

appears; set as many rows of search filters as needed. To 

delete a row of search criteria, click – to the left of the row.  

5. Click Save at the bottom of the window. The Advanced 

Worklist tab appears to the right of the Search tab with 

the saved name. A new blank worklist tab appears next 

to the Advanced Worklist tab in the Study Browser 

window.  
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6. To access any Advanced Worklists that are no longer 

displayed, click the Advanced Worklist tab, click the 

Advanced Worklists heading, and select a listed 

Advanced Worklist.  

EDITING ADVANCED WORKLISTS 

1. Click Advanced Worklist.  

2. Click the Advanced Worklists drop-down list. Select the Advanced Worklist to be edited.  

3. Select Edit.  

4. The Advanced Worklist window expands. Edit the search criteria as needed using the drop-down lists.  

5. Click Save at the bottom of the window.  

DELETING ADVANCED WORKLISTS 

1. Click the Advanced Worklist.  

2. Click the Advanced Worklists drop-down list. Select the Advanced Worklist to be deleted.  

3. Select Delete.  

4. A Delete Advanced Worklist confirmation box appears to confirm that the Advanced Worklist is being deleted. 

Click OK to delete the worklist.  

2-12—CUSTOMIZING STUDY BROWSER LISTS 

Users can customize options in the Study Browser lists, including column options, resizing options, and sorting or 

changing column orders. 

RESIZING COLUMN HEADINGS 

Users can resize the width of a column heading in any list to better accommodate the information within.  

1. Hover the cursor over the right divider of the column heading. The cursor changes to a double-ended arrow.  

2. Double-click the right divider of the column heading and the column auto-fits to its contents. Users can also 

click the right divider of the column heading and drag it to the right or left until the column is the desired size. 

RESIZING LIST HEIGHTS 

Users can resize the height of the Study Browser lists to display more or less information.  

1. Hover the cursor over the divider at the edge of the list to be resized. The cursor changes to a double-ended 

arrow.  

2. Click and drag to the preferred height.  
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CHOOSING COLUMN HEADINGS 

1. Right-click the column heading bar to customize. A drop-down list containing the column heading options 

appears.  

2. Click to select or deselect the column headings to appear in the list.  

SORTING DATA IN A COLUMN 

1. Click the column heading to automatically alphabetize the information (or sort numerically if applicable). It 

automatically lists in ascending order.  

2. To reverse the sort order to descending, click the column heading a second time.  

CHANGING THE ORDER OF COLUMNS 

Users can change the order in which the columns appear in the lists. To change the column order, complete the 

following steps: 

1. Click and drag the column heading to the 

preferred location and release.  

Note: As the cursor passes over the other column headings, 

it highlights a dark blue—representing the new location of 

the column heading when released.  

HIDE/SHOW ALL DISPLAY COLUMNS 

1. In the Filtered Studies or Patient History list, right-click any display column.  

A drop-down list of display column options appears.  

The Show All and Hide Hideable options are at the bottom of the display column drop-down list.  

2. To display all possible display columns, select Show All.  

All display columns are added to that list.  

3. To quickly remove all display columns except the Local and Open columns, select Hide 

Hideable.  

 

All display columns except the Local and Open display columns are disabled and removed. 

Note: The Local and Open display columns always display and cannot be removed. 

2-13—USING THE STUDY BROWSER MENUS/CUSTOM TOOLBAR  

The Study Browser’s Menus and Custom Toolbar have many helpful functions. The following sections provide brief 

information on the Study Browser’s Menu and Custom Toolbar.  
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WHERE TO FIND ADDITIONAL STUDY BROWSER MENU INFORMATION 

The Study Browser Menu contains available actions for the Study Browser and Image Viewer.  

USING THE STUDY BROWSER CUSTOM TOOLBAR 

The Study Browser Toolbar is just below the 

menu bar at the top of the Study Browser 

window. The default settings for the Study 

Browser toolbar vary by role. Click any 

button on the toolbar to use its function.  

CUSTOMIZING THE STUDY BROWSER’S CUSTOM TOOLBAR 

Users can customize the Study Browser’s Custom Toolbar to their 

preferences. Users can add or remove toolbar items and change the way 

the toolbar appears in the window.  

1. Click Settings in the Study Browser and select Customize Toolbar. Users 

can also right-click any toolbar in the Study Browser window and select 

Customize from the drop-down list. The Customize Toolbar window 

opens.  

2. To add an item to the toolbar, select the 

item to add from the Available items list 

on the left of the screen. Click Add to 

add it to the Current toolbar items list on 

the right of the screen. Users can also 

select items in the Current toolbar items 

list and click Remove.  

3. Click OK to save and exit.  

2-14—ACTIVATING THE STUDY BROWSER 

Users can hide the Study Browser window when using the Image Viewer to allow a full-image display.  

1. Move the mouse to the right or left edge of the Image Viewer 

window.  

Note: The Study Browser auto-shows and can be displayed if Auto-show Study 

Browser is selected on the Options page.  

2. Click the Study Browser icon on the Image Viewer toolbar.  
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3. Press the default hotkey Spacebar on the keyboard to close all 

workspaces in the Image Viewer and show the Study Browser.  

 

 

 

 

 

 

 

 

 

2-15—CUSTOMIZING THE STUDY BROWSER COLOR AND FONT SIZE 

The settings gear icon is located in the top right-hand corner of the Study 

Browser. Users can click this icon to customize the color theme and font size 

options in the Study Browser.  

 

STUDY BROWSER COLOR THEMES 

Users can quickly access Study Browser display options when needed using the gear 

icon. When not in use, these options only take minimal space.  

Users have access to six color themes including dark gray, dark blue, pink, classic, 

light blue, and green. Hovering the cursor over a color displays a tooltip with the 

theme name.  

The Classic theme enables users to change their display to a look and feel they are 

more accustomed to with earlier software versions.  

Note: Once selected, the chosen color scheme saves to the user’s preferences. 
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FONT SIZE ADJUSTMENT SLIDER 

Users can adjust the font size of the Study Browser window using a font size 

slider. 

 By moving the font size slider to the left, the text displays smaller. 

If the slider is moved to the right, the text displays larger. 

Note: The Classic Theme is merely similar to the previous Study Browser look and is 

not an exact replica of it. The toolbar icons revert to icons used in versions prior to 

8.3. Study Browser themes and displays are dependent upon monitor display and 

resolution settings.  

INTERFACE SCALING 

Click the Gear icon on the top right-hand side of the Study Browser. 

The Viewer Scale has a drop-down box where users can select a scaling percentage.  

The page adjusts to the selected scale.  
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CHAPTER 3—USING THE STUDY BROWSER FILE MENU 

One main function of the Diagnostic Viewer’s Study 

Browser is to help users search for and view studies. 

The File menu in the Study Browser allows users to 

open studies to view or to exit the Diagnostic Viewer. 

The File menu is on the Study Browser’s main toolbar. 

3-1—OPEN FROM DIRECTORY 

Open from Directory allows users to open a group of DICOM image files from a directory that is on a computer or 

CD-ROM.  

1. Click File in the Study Browser and select Open from Directory. The Browse for Folder dialog box opens.  

2. Browse for the folder by expanding the folders in the dialog box. Click OK. 

Note: Opening images from a file or a directory does not import the study into the NovaPACS system. Studies must be 

imported on the Studies tab of the NovaPACS Admin Console. 

3-2—OPEN FROM FILE 

Open from File allows users to open a single DICOM image file from a directory on a computer or a CD-ROM.  

1. Click File in the Study Browser and select Open from File. The Open dialog box opens.  

2. Browse for the image file by expanding the folders in the dialog box. Click Open.  

3-3—EXIT THE DIAGNOSTIC VIEWER 

Exit allows users to exit from the Diagnostic Viewer application completely. If users do not fully exit the NovaPACS 

Diagnostic Viewer correctly, they can potentially lose some of their most recent customizations that would otherwise 

be saved to their user preferences. A full copy of the user’s preferences is written to the server upon correctly 

exiting the application.  

Click File in the Study Browser and select Exit.  

If the option for the Diagnostic Viewer to prompt before closing the application is selected, a warning appears. Click 

Yes to exit, or No to return to the Diagnostic Viewer.  
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CHAPTER 4—USING THE WORKLIST MENU 

The Study Browser’s Worklist menu contains Worklist 

functions that help users organize and manage 

workflow. The Worklist menu is located on the Study 

Browser’s main toolbar. The items on the Worklist 

menu depend on which tab is used. The Search and 

Advanced Worklist tabs contain fewer worklist menu 

items than the Assigned Worklist tab.  

4-1—INTRODUCTION TO THE ASSIGNED WORKLIST 

The Assigned Worklist is a tab located to the right of the Search tab when activated and is used with the filters on 

the page to locate specific information. The Assigned Worklist is an effective tool for large groups of users that read 

images at the same time from a Filtered Studies list. The Assigned Worklist shows studies that have been added by 

the user to view later or that have been assigned to the user by someone else. Radiologists can move studies into 

their worklist for review or assign studies to another user’s worklist for specific users or larger groups to review. 

4-2—ADD TO WORKLIST 

Users can add a study to the Worklist to organize and manage workflow. Users can also assign a study to another 

user’s Worklist for them to review.  

ADD TO WORKLIST 

Users can add studies from the Search tab and the Advanced Worklist tabs to their Assigned Worklist. This allows 

users to see only specific studies along with studies assigned to them by other users for convenience.  

1. Select a study from the Filtered Studies or Patient History list on the Search tab or an Advanced Worklist tab. 

To select multiple studies to add, hold the CTRL key while selecting patients. 

2. Click the Add to Worklist icon on the toolbar.  

The study appears in the Assigned Worklist tab.  

Note: If the study added does not meet the search criteria in the search filters, it may not 

appear in the Filtered Studies list on the Assigned Worklist. Review the search filters if a study is not visible in the worklist.  

Users can also add selected studies to their Assigned Worklist 

• Click Worklist in the Study Browser and select Add to Worklist.  

• Right-click the study and select Add Selected Studies to My Worklist from the drop-down list.  

• Users can customize a hotkey to assign a study to the Worklist.  



 

Page 38 of 169   

 

NovaPACS User Manual 

ASSIGN 

Users can assign studies to another user for review. Studies can be assigned to other users from any tab in the 

Study Browser (Search tab, Assigned Worklist tab, and Advanced Worklist tabs).  

1. Select the study to assign from the Filtered Studies list in the Study Browser. To select multiple studies, hold 

CTRL while clicking.  

2. Click Assign on the Filtered Studies list toolbar. The Assign Studies from ______ dialog box opens.  

 

3. In the Assign Studies from ______ dialog box, select an option from the What role is the assignment for drop-

down list.  

Note: The What role is the assignment for? section populates with users that have that selected role.  

4. Select a user from the Which user to assign to section and click OK. 

Note: If users want the Worklist items to have a status other than New—so 

other users in the Worklist group do not see the patients in the Worklist—users 

can click Checkout for the item before or right after moving it to their Worklist.  

Users can also assign selected studies to other users. 

• Click Worklist in the Study Browser and select Assign.  

• Right-click Assign Selected Studies to Another User from the drop-

down list.  

 

Users can customize a hotkey to assign a study.  

4-3—OPEN WORKLIST ITEM 

Users can open Worklist studies in the Image Viewer. 

1. Select a Worklist study.  

2. Click Open on one of the toolbars in the Study Browser. (The Filtered Studies, Patient History, and Series lists 

all have the Open toolbar button). Click Open + Old on the Filtered Studies or Patient History toolbar to open 

the selected study with prior studies. This opens in the Image Viewer. 

 

Users can also open selected studies: 

• Click Worklist in the Study Browser and select Open Worklist Item.  

• Double-click a study on the Assigned Worklist tab.  

• Right-click a study and select Open Selected Studies from the drop-down list. Select Open Selected Studies 

with Older Related Studies to open the selected study with prior studies.  
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Users can customize a hotkey to open a study.  

4-4—NEXT WORKLIST ITEM 

Next Worklist Item allows users to close all currently opened 

studies and open the next worklist study in the Image Viewer.  

Click Worklist in the Study Browser and select Next Worklist 

Item. Users can also press the default hotkey F1.  

4-5—REMOVE WORKLIST ITEM 

Users can remove an item from their Assigned Worklist by 

selecting the study and clicking Remove Worklist Item from the Worklist menu.  

4-6—CLEAR WORKLIST 

Users can clear their Assigned Worklist using Clear on the Worklist menu.  

Note: Users may want to ensure they don’t accidentally clear their 

worklist by turning on Prompt before clearing worklist on the Options 

page.  
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CHAPTER 5—USING THE STUDY BROWSER STUDY MENU 

The Study menu helps radiologists find additional study 

information sources and tools and manage caseloads. The Study 

menu is located on the Study Browser’s main toolbar.  

5-1—SELECT ALL 

Select All allows users to select all of the items on the active list 

(Filtered Studies, Patient History, or Series List).  

1. Click a list in the Study Browser to make it the active list.  

2. Click Study in the Study Browser and click Select All. 

 

The following are alternate ways to use the Select All option:  

 

1. Click a list to make it the active list, then right-click the list and choose Select All from the drop-down list.  

2. Click a list to make it the active list, then click Select All on the toolbar for that list.  

3. Click to make a list active and press the default hotkey CTRL + A. 

4. Click anywhere on the list to deselect the items after using the Select All function.  

5-2—OPEN 

Open allows users to open a selected study, series, or image in the Image Viewer.  

Click the desired study, series, or image and click Study in the Study Browser. Select Open.  

The following are alternate ways to use the Open option:  

1. Click the desired study, series, or image from any list in the Study Browser, and click Open on the toolbar for 

that list.  

2. Double-click the study, series, or image and the Image Viewer automatically opens it.  

Note: In order to prevent two users from changing a study at the same 

time, a message alerts the second user that the study/series is 

currently checked out. This warning also appears when an 

administrator is editing the study in the Admin Console.  
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5-3—CLOSE WORKSPACE  

Close Workspace closes the current, visible workspace in the Image Viewer while leaving any other workspaces 

open.  

Click Study in the Study Browser and select Close Workspace.  

Note: There are other ways to use Close Workspace. Users can set a hotkey or add a button to the Study Browser’s 

Custom Toolbar.  

5-4—CLOSE ALL WORKSPACES 

Close All Workspaces closes the current, visible workspace and all other open workspaces in the Image Viewer.  

1. Click Study in the Study Browser and select Close All Workspaces.  

2. Press the default hotkey CTRL + Shift + F4.  

5-5—ROUTE 

Route allows users to share images with another site. Images can be routed manually from a NovaPACS data 

source to a specified destination.  

Note: NovaPACS can be set up to automatically route prior studies to workstations based on the RIS schedule for the 

next day. This allows users to view necessary information without workflow interruptions or delays. Contact customer 

support to enable this feature.  

1. Select the desired study or series to route from any list in the Study Browser.  

Note: Use the Select All function on the Filtered Studies list to select all studies to route or hold CTRL and click to 

select multiple studies or series to route.  

2. Click Study  in the Study Browser and select Route. The Add Route Queue Entry dialog box opens. 

3. Choose the desired study, series, and/or image(s) to route by 

expanding the lists and clicking the corresponding checkboxes next to the 

items. If the checkbox next to the study is marked without expanding the 

list, all of the accompanying series and images are automatically routed.  

Note: Route rules can be configured in the Admin Console. If one series in a multi-

modality study matches the route rule, the entire study is routed (e.g., a 

mammography study can include images from multiple modalities like MG and US 

and also non-image files such as Structured Reports).  

4. Choose a destination from the Destination drop-down list.  

Note: An Administrator must add the Destinations that appear in the drop-down list.  

5. Set the routing priority for the image routing by clicking the up or down arrows next to the Priority field. 

Routing priorities range from 1-100, with one as the highest priority. The default routing Priority is three. 

6. Click OK to route to the specified destination.  
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Note: Users can customize a hotkey or add a button to the Study Browser’s Custom Toolbar for the Route option.  

Note: Finalized reports are sent to NovaPACS as a DICOM Encapsulated PDF report—with an image type of DOC. 

These reports are part of the NovaPACS study and therefore can be routed to any location the study can be sent. 

However, the ability for a receiving system to store and view the reports is dependent on their ability to support 

storage and viewing of DOC DICOM images. If users route to a Novarad site using an older version of software, they 

may not see the DICOM PDF report as part of the study.  

5-6—DOCUMENTS  

Documents allows users to see any documents associated with the patient file that were scanned into the RIS. 

1. Select the study from any list in the Study Browser.  

2. Click Study in the Study Browser and select Documents.  

The Document Viewer window opens.  

5-7—EXAM REPORT 

Exam Report allows users to see the report associated with the patient file if one exists. Exam Reports are only 

available if the system is integrated with Nova RIS. 

1. Select the study from any list in the Study Browser.  

2. Click Study in the Study Browser and select Exam Report. 

The report for the study opens in a new window.  

Note: When reports are finalized in Nova RIS, a DICOM PDF report is sent to NovaPACS and is added to the study as 

a new series. If no matching NovaPACS study is found, a placeholder study is created for the report. Admins should 

locate this study in the NovaPACS Admin Console on the Studies tab and move the report series to the correct study 

manually. 

 

The following are alternate ways to use the Exam Report option:  
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1. Select the study from any list in the Study Browser and 

press the default hotkey CTRL + R.  

2. Users can add an Exam Report button to the Study 

Browser’s Custom Toolbar.  

 

Note: When users sign and save reports in NovaPACS, the 

preliminary report displays in all report locations depending on 

configuration. Once the report is finalized in Nova RIS, a DICOM 

encapsulated PDF report is sent to NovaPACS and added to the 

study. This DICOM PDF report displays in any location where users 

access reports.  

 

 

5-8—MANAGE REPORT WORKFLOW 

Manage Report Workflow allows users to quickly view their 

reports and report statuses. Manage Report Workflow is 

particularly useful for Administrators, Transcriptionists, and 

Radiologists. Users can review and/or sign reports using this 

option. 

 

In the Report Workflow window, users see four main boxes for 

Dictated Reports, Unsigned Reports, Signed Reports, and 

Finalized Reports. In the Other window, users can see reports 

that have been marked Requires Correction and can look up 

physicians in the system using the Physician Lookup box.  

 

To access the Report Workflow window, click Study in the Study Browser and select Manage Report Workflow.  

Note: Users can customize a hotkey or add a button to the Study Browser’s Custom Toolbar for the Manage Report 

Workflow option.  

5-9—RIS INFORMATION 

RIS Information allows users to view the RIS Information dialog box for a study. The information included in the RIS 

Information box is submitted by the Admin, Receptionist, or Technologist in Nova RIS. RIS Information dialog boxes 

include patient information, Referring Physician information, order notes, and procedure information about a study.  

1. Select a study from any list in the Study Browser.  

2. Click Study in the Study Browser and select RIS Information.  

The RIS Information dialog box opens and displays any applicable Nova RIS information for the study.  
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Note: Users can customize a hotkey or add a button to the Study Browser’s Custom Toolbar for the RIS Information 

option.  

5-10—MATCH STUDY TO ORDER 

The Match Study to Order feature can be used to match images with RIS orders. This allows Technologists to quickly see the 

information they need about the patient. Below are some of the cases where this feature will be useful: 

• Allows the Technologist to verify the patient’s name is spelled correctly.  

• Allows them to see if the patient is scheduled twice in small bowel series on the same day. This lets them organize 

which procedure needs to happen first.  

• It helps them see if CR images and Fluoro images of the same anatomy are placed in the same order and if they need 

to be merged, viewed, and read on the same report.  

• Matching studies to orders makes it easier to organize images in the event the patient requires follow-up images.  

Users can first enable the Scheduled Orders View to see what orders have been scheduled. To enable this view: 

1. Right-click the toolbar and select Customize. 

2. In the custom toolbars window, click the View dropdown menu. 

3. Click Scheduled Orders,  then click Add . 

 

 

4. Click OK. 

 

Users will then be able to view the scheduled orders.  
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To access the Match Study to Order Window, right-click the study and then click the Match Study to Order option.  

 

To match the study to the order, click on the order that matches the study details. Then click Match.  

If the RIS order does not exist, click Create RIS Order and Match and the system will create the order in RIS from the Study 

information.  

5-11—RETRIEVE IMAGES 

Retrieve Images allows users to download all image files in a selected study from an archive server to their 

computer. Retrieve Images operates in the background, allowing users to perform other tasks while waiting. This 
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option is most useful for situations where there is a slow connection between the archive server and the local 

Diagnostic Viewer installation.  

Click Study in the Study Browser and select Retrieve Images.  

Note: Users can customize a hotkey or add a button to the Study Browser’s Custom Toolbar for the Retrieve Images 

option.  

5-12—PATIENT CD/DVD/USB 

Users with a CD/DVD burner can activate the Patient CD/DVD/USB option to 

burn a patient’s file to a CD, DVD (from the Managed Viewer or Web 

Viewer), or copy to a USB device. Users can continue employing the 

Diagnostic Viewer while a Patient CD/DVD/USB burns in the background. 

Alternatively, images can be shared using Novarad’s CryptoChart Image 

Sharing solution. 

 

 

 

 

 

CREATING PATIENT DISK 

1. Select the desired study or series to burn to disk. 

2. Click Study in the Study Browser and select Patient CD/DVD/USB.  
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The Patient CD/DVD/USB dialog box opens.  

3. Select the desired Studies, Series, and Compression options for the disk. 

Users can choose to burn just the selected study, or all studies for the 

patient.  

 

Users can select to burn all series for each study, or only select series in 

the study/studies.  

 

 

Select series for each study is helpful for sites that have scanned in documents such as screening forms and other 

paperwork that should not be burned to the Patient disk. Before burning the disk, users see a list of each series in 

the study and can select each series to be included or excluded.  

 

By default, diagnostic reports are burned to the Patient 

disk. The Include Diagnostic Reports checkbox is selected 

by default each time users burn a Patient disk.  

 

 

 

 

 

 

 

 

 

If a site is currently merging or fixing patients and studies, they may 

exclude diagnostic reports from the Patient disk by deselecting this 

checkbox. Sites may also choose to exclude reports to not give their 

patients a copy before meeting with their primary physician.  
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Users can select compression options for the Patient disk. Novarad recommends 

not using any compression for patient disks whenever possible because most 

vendors cannot support compressed images. Unless burning multiple or very 

large studies, choose None under the Compression drop-down list.  

4. After selecting the Patient disk options, click OK to save the change(s). Click 

Cancel to cancel out of creating a Patient disk.  

In order to include the exam report on a Patient CD/DVD/USB, the user who 

creates the disk must have a corresponding role with permissions in the NovaPACS Admin Console.  

Note: Users can add a Patient CD/DVD/USB button to the Study Browser’s Custom Toolbar.  

EXPORTING STUDIES TO A USB DEVICE 

1. Select a study from a list in the NovaPACS Study Browser and click Study.  

2. Select Patient CD/DVD/USB.  

The Patient CD/DVD/USB window opens.  

3. Select USB/Drive in the Select Storage Medium section.  

 

After clicking the USB/Drive option, the Drive drop-down list is 

enabled and displays all available drives, including removable drives.  

Note: The Drive drop-down list defaults to the first removable drive 

available.  

4. Click the Drive drop-down list to select a different drive, if 

applicable.  

5. Choose to export Selected studies only or All studies for the 

selected patients.  

6. Then choose to either export All series for each study or Select series for each study. The latter is helpful for 

studies that have additional series such as scanned document series that shouldn’t be exported.  

7. Finally, decide whether to export the diagnostic report. Click OK. 

8. The Select Folder window opens. Users can pinpoint where they would like to save the file.  

9. After making the selection, click Select Folder to save the file. 

10. To quickly open the study that was saved to the USB device, users can click ViewImages.cmd.  

This loads the Novarad Patient CD Viewer application along with the study.  
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There are a total of four additional folders saved to the 

selected USB device: Cache, DICOM, Image Temp, and 

Viewer.  

 

 

5-13—ASSIGN PASSWORD 

Assign Password allows users to assign a temporary Single-Study Access Password for a study, giving a person (i.e. a 

Referring Physician or patient) access to that study through the Web Viewer. The Single-Study Access Password 

gives the user access to the study’s images and RIS reports.  

Note: For more information on the Web Viewer, see Chapter 1, section 1-3—Accessing the Diagnostic Viewer.  

1. Click the study on any list in the Study Browser.  

2. Click Study in the Study Browser and select Assign Password.  

3. The Assign Web Password to Selected Study dialog box 

appears. A randomly generated password is assigned 

automatically. Users can generate their own password by clicking 

the new password link.  

4. Click the Expiration Date drop-down list to set the length of 

time the password is valid and click OK.  

 

 

5-14—SCAN COMPLETE 

Scan Complete allows users to change the patient’s status to reflect a completed scan, which reflects on the Patient 

Workflow page and Scheduling page in Nova RIS.  

1. Select a study from the Filtered Studies list in the Study Browser.  

2. Click Study in the Study Browser and select Scan Complete.  

Note: Users can customize a hotkey for the Scan Complete option.  

5-15—LAUNCH MAMMO VIEWER 

Launch Mammo Viewer allows users to launch a mammography viewing tool used with NovaPACS for 

mammography viewing. 

1. Launch the Diagnostic Viewer and open an appropriate study (i.e. an MG or breast US study).  

2. Return to the Study Browser by clicking the Study Browser icon in the top right corner of the Image 

Viewer window.  
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3. Click Study in the Study Browser and select Launch Mammo Viewer. The configured mammography 

viewer launches in a new window.  

4. When finished using the Mammo Viewer, users can return to the PACS by closing the window.  

Note: A Mammo Viewer software must be installed and configured on the workstation to use the Launch 

Mammo Viewer option. If it is not configured, Launch Mammo Viewer is unavailable on the Study Menu. 

Users can customize a hotkey or add a custom toolbar button to the Image Viewer or Study Browser to 

access this option.  

5-16—VIEW STUDY ON OTHER WORKSTATION 

View Study on Other Workstation allows users to send studies from the Diagnostic Viewer to another computer. 

Contact Novarad Support for the required configuration for this option. Once configured, studies can be viewed and 

processed by another computer. This option is useful if users need to view studies on post-processing stations for 

MIP/MPR or 3D Reconstruction. 

1. Select a study from a list in the Study Browser.  

2. Click Study in the Study Browser and select View Study on Other Workstation.  

5-17—LAUNCH ORTHOPEDIC TOOLS 

Launch Orthopedic Tools allows use of the orthopedic template third party software with Novarad’s Diagnostic 

Viewer. This optional software integration allows users to create a complete array of orthopedic pre- and post-

surgical planning and mapping tools including (but not limited to) Cobb Angles, templates, overlaying, and surgical 

repairs.  

1. Launch the Diagnostic Viewer and open an appropriate study.  

2. Click the Study Browser icon in the top right corner of the Image Viewer window.  

3. Click Study in the Study Browser and select Launch Orthopedic Tools. The configured orthopedic tool 

launches in a new window.  

4. When finished using the orthopedic tools, users can return to the PACS by closing the window.  

Note: The product launched when using the Launch Orthopedic Tools option is dependent upon which software 

option is configured in the PACS Admin Console. If there is not an orthopedic software tool configured, the Launch 

Orthopedic Tools option is unavailable on the Study menu. Users can customize a hotkey or add a custom toolbar 

button to the Image Viewer or Study Browser to access this option.  

5-18—TEACHING FILE  

Teaching File allows users to create anonymized versions of particular studies.  
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This option is only available under the Study menu if 

Teaching Files have been enabled. To enable Teaching 

Files, navigate to the Options page of the Settings menu. At 

the bottom of the General tab, select the box next to 

Enable Teaching Files. 

 

 

CREATING TEACHING FILES 

Once Teaching Files have been enabled, users can click a study in the 

Study Browser and select Teaching File from the Study menu to create 

an anonymized version of the selected study. The Teaching File 

Information dialog box opens, allowing users to record information 

about the study while maintaining the anonymity of the patient once 

the information has been saved. 

Note: For reference, the patient’s name and ID is located at the top of the 

dialog while the users initially fills out the dialog. Once the information has 

been saved, the study no longer contains the patient’s personal identification, 

and the dialog (if reopened) does not reference the original study or patient.  

Note: Users can also create Teaching Files from the Image Viewer. See section 10-31 for more information.  

TEACHING FILE INFORMATION DIALOG 

Users should fill out the Teaching File Information dialog box as prompted, and for convenience, users can easily 

move through fields by pressing the tab key. Follow these guidelines for filling out and managing the Teaching File 

Information dialog:  

THE REQUIRED TAB 

The first few fields under the Required tab allow users to select from a drop-down menu of prepopulated options. 

Users can click and type into any of the other available fields. Any field with a red asterisk next to it is a required 

field that users must fill out in order to save the new information.  

The Study Description field is automatically populated, based on information from the original study. However, 

users can choose to edit this information by clicking in the field and typing. 

Note: Study Description changes save on the user’s machine but are not saved to the server.  

The Findings and Notes fields allow users to add in a large amount of text or copy and paste directly from the 

original report. 
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THE ADVANCED TAB 

The Advanced tab allows users to record additional 

information about a study, though none of the fields under 

this tab are required fields. Each of the open fields under the 

Advanced tab have a limit of 256 characters per field. = 

 

 

 

 

 

 

 

ADDITIONAL OPTIONS AND FIELDS 

On the right side of the dialog box, users can locate who created a Teaching File, as identified by their username as 

well as their first and last name.  

After information in a Teaching File dialog is saved, if it is opened 

and edited later, the dialog displays the identification of the last user 

to modify information. This is displayed beneath the Created By field.  

Also on the right side of the dialog is the Teaching File Patient 

Information box, which contains three fields: 

 

• New Patient ID: This field displays the Teaching File Patient 

ID. A new ID is generated for each new Teaching File, and each ID begins with the letters TF, indicating 

Teaching File. The New Patient ID field is not editable and is not related to the original study. 

• Last Name: By default, all new Teaching File patients are 

assigned “Patient” as their last name. Users can assign a new last 

name by clicking inside the field and typing. Users can then search 

for the saved last name to locate the file later.  

• First Name: By default, all new Teaching File patients are 

assigned “Anonymous” as their first name. Users can assign a new 

first name by clicking inside the field and typing. Users can then search for the saved first name to locate the file 

later. 

If any reports are available for a study, the user can select Get Reports 

from Study beneath the Teaching File Patient Information box.  

If there are no available reports for a study, this button is grayed out, and 

users cannot select it.  

To save information in the Teaching File Information dialog, select OK. To cancel changes made, select Cancel.  
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Users should note the warning on the bottom of the dialog which informs users that they are primarily responsible 

for ensuring that no patient identification is located anywhere on the images or within the available fields in the 

Teaching File Information dialog. 

 

 

 

Note: Scanned images of reports or text within a study are not anonymized when a Teaching File is created. Users 

should plan accordingly.  

ACCESSING SAVED TEACHING FILES 

To access saved Teaching Files, filter for Teaching File studies in the Study Browser. First, enable Teaching File 

filters from the View menu.  

To reopen or edit a Teaching File Information dialog, navigate to the Study Browser, search for the file of interest, 

click the study, and go to Menu → Study → Teaching File. The dialog opens, allowing users to edit information and 

save changes. 

Users can also view Teaching File 

patient information from within the 

Study Browser without pulling up the 

study dialog. Locate the study and 

make sure it has been selected. Next, 

click the Report tab of the Series list in 

the Study Browser. The information 

displayed under this tab is drawn 

directly from the Teaching File 

Information dialog. 

5-19—STUDY OF INTEREST 

Study of Interest allows users to mark studies for future reference. This allows users to easily search for and locate 

interesting studies.  

1. Select a study from a list in the Study Browser.  

2. Click Study in the Study Browser and select Study of Interest.  

3. A message appears notifying users that the study they selected has been marked as a study of interest. Select 

OK or the red X in the upper right corner to exit the box.  

Studies are then marked as studies of interest, and users can search for studies of interest by enabling the Is Study 

of Interest filter in the filter’s bar.  
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5-20—COLLABORATION  

Collaboration allows multiple Radiologists to work simultaneously 

from the same worklist without having duplicate readings. The 

Collaboration option also allows users to participate in peer-to-peer 

reviews of patient studies.  

Studies just entering the NovaPACS system have a status of new or 

imported, depending on the origin of the study. Studies with a new 

status are coming from the modalities into the NovaPACS system. If 

users have an external source for studies, such as an long-term 

archive (LTA) or other DICOM source, studies imported and 

cataloged into the NovaPACS system have a status of imported.  

The Collaboration option enables users to mark various statuses 

such as Verified, Checked Out, and Reviewed to manage studies in 

collaborative environments.  

1. Select a study from a list in the Study Browser.  

2. Click Study in the Study Browser and select Collaboration. A submenu drops down with collaboration options.  

CHECKOUT 

Checkout prevents multiple users from reviewing the same study simultaneously.  

1. Select a study from the Filtered Studies list in the Study Browser.  

2. Click Study in the Study Browser. Select Collaboration and then Checkout.  

The study now displays Checked Out in the Status column of the Filtered Studies list. The Current User column 

reflects the username of the person who checked the study out (if enabled as a display column).  

The Checked-Out status for the study updates on all collaborating users’ lists. Other users may view a Checked-Out 

study but cannot mark it Reviewed or use the Checkout function.  

 Alternate ways to use the Checkout option:  

1. Users can set the Study Browser to automatically checkout a study when opened. Click Settings in the Study 

Browser. Click Options. Click the checkmark next to Auto-checkout studies when they are opened.  

2. Users can customize a hotkey for the Checkout option.  

3. Users can add a Checkout button to the Study Browser’s Custom Toolbar.  

UNDO CHECKOUT 

Undo Checkout allows users to undo the checkout process for a study. This option is helpful when the user checks 

out the wrong study or is unable to complete the review of a study after checkout. The study or series is restored to 

the status it had before checkout (i.e. New or Verified).  
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The Undo Checkout option cannot restore the status of a study if it has already been marked Reviewed. Users can 

only change a study with a Reviewed status using Reset Status to New (see section Reset Status to New).  

1. Select the checked-out study from the Filtered Studies list in the Study Browser.  

2. Click Study in the Study Browser, select Collaboration, and then select Undo Checkout.  

Note: There are other ways to use the Undo Checkout option. Users can set a hotkey or add a button to the Study 

Browser’s Custom Toolbar.  

VERIFIED 

Verified allows users to mark studies as verified, meaning that all attached documents, images, etc., are checked 

and ready for review.  

1. Select the study to be verified from the Filtered Studies list in the Study Browser.  

2. Click Study in the Study Browser, select Collaboration, and then select Verified.  

Note: There are other ways to use the Verified option. Users can set a hotkey or add a button to the Study Browser’s 

Custom Toolbar.  

The study has a Verified status. The Current User column reflects the username of the person who verified the 

study. The Verified status updates on all collaborating users’ lists.  

REVIEWED 

Reviewed allows users to mark a study as reviewed. 

1. Select the study that has been reviewed.  

2. Click Study in the Study Browser, select Collaboration, and then select Reviewed.  

Note: There are other ways to use the Reviewed option. Users can set a hotkey or add a button to the Study 

Browser’s Custom Toolbar.  

The study now has a Reviewed status. The Current User column reflects the username of the person who reviewed 

the study. The Reviewed status for the study updates on all collaborating users’ lists.  

Note: The status of a study resets to its previous New or Verified status if the 

study is closed out without marking it Reviewed, and if the following options 

are marked by navigating to Settings → Options → General tab: 

• Auto-checkout studies when they are opened 

• Auto-review studies when they are closed 

• Prompt before marking a study reviewed 

RESET STATUS TO NEW 

Reset Status to New allows users to restore the status of a reviewed study back to New, so it can be reviewed 

again. 
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1. Select the reviewed study from the Filtered Studies list in the Study Browser.  

2. Click Study in the Study Browser, select Collaboration, and then select Reset Status to New.  

Note: There are other ways to use the Reset Status to New option. Users can set a hotkey or add a button to the 

Study Browser’s Custom Toolbar.  

The study’s status changes from Reviewed to New in the Status column of the Filtered Studies list. The username no 

longer appears in the Current User column.  

Note: The Reset Status to New option must be used within six hours of a study being marked Reviewed. To change 

the status of a study after six hours, contact an administrator. Only administrators can reset studies older than six 

hours.  

PEER REVIEW 

Peer Review allows radiologists to evaluate each other’s reviewed 

studies, give second opinions, and provide quality assurance. Any 

radiologist involved in the review process can view a completed Peer 

Review.  

1. Select a reviewed study from the Filtered Studies list in the Study 

Browser.  

2. Click Study in the Study Browser, select Collaboration, and then 

select Peer Review. The Peer Review dialog box appears.  

3. Select an option under Position.  

4. Enter any comments needed in the Comment field box and click 

OK.  

Note: Peer Review reports are available to NovaPACS Administrators in the Admin 

Console. The Administrator can choose to report an average rate of missed diagnoses over a given time period. 

UTILIZATION REVIEW 

Utilization Review allows radiologists to review studies and provide quality assurance.  

 

1. Select a reviewed study from the Filtered Studies list in the Study 

Browser.  

2. Click Study in the Study Browser. Hover the cursor over Collaboration 

and select Utilization Review.  

The Utilization Information for Reviewed Study dialog box appears.  

3. Select the Position drop-down list and select the position that applies. 

4. Enter any comments needed in the Comment field box and click OK.  
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Note: Administrators can pull a Study Utilization report on the Reports tab of the NovaPACS Admin Console to see all 

Utilization Review and study analysis information.  
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CHAPTER 6—USING THE STUDY BROWSER VIEW MENU 

The View menu contains options for how information is 

displayed in the Study Browser window, as well as 

settings for the Hanging Protocols in the Image Viewer. 

The View menu is located on the main toolbar in the 

Study Browser. 

 

 

 

 

6-1—WORKLIST TAB 

Worklist Tab displays the Assigned Worklist containing studies that have been added by the user to view later or 

that have been assigned to the user by another user. Large radiologist groups use this function to improve workflow. 

1. Click View on the Study Browser’s main toolbar, and select Worklist Tab.  

2. Press the default hotkey F2.  

The Assigned Worklist appears as a tab 

next to the Search worklist on top of the 

Filtered Studies list. The Assigned Worklist 

looks and functions like the Search worklist, 

except there are fewer search filters to use 

on the Assigned Worklist because studies 

are already filtered by assignment. 

6-2—MANAGE HANGING PROTOCOLS  

Manage Hanging Protocols are the saved layouts 

associated with a specific Hanging Protocol for 

displaying study images in the Image Viewer. 

To activate the Manage Hanging Protocols  

section in the Study Browser window, click 

Settings on the Study Browser’s main toolbar and 

select Manage Hanging Protocols. 



 

Page 59 of 169   

 

NovaPACS User Manual 

If activated, the Hanging Protocol Layouts section is located at the bottom of the Study Browser window and 

displays thumbnail images of the layouts defined for the current study. Users can toggle the Hanging Protocol 

Layouts using the default hotkey F4. 

The Hanging Protocol Layouts section only displays content in the Study Browser if a study is open in the Image 

Viewer. 

The title of this section also lists the current Hanging Protocol. This section appears on all tabs in the Study Browser 

(i.e., the Search tab, Assigned Worklist tab, and Advanced Worklist tabs). 

6-3—PATIENT HISTORY  

The Patient History list displays all 

completed studies for the selected patient, 

including all time frames and all modalities. 

The Patient History list is part of the default 

view in the Study Browser. It is below the 

Filtered Studies list and to the left of the 

Series list in the Study Browser window.  

Note: Study Browser lists can be dragged and 

dropped to new locations, as well as toggled 

on/off at any time.  

 

Users can choose to have the Patient History list not available by clicking View in the Study Browser and selecting 

Patient History.  

6-4—SERIES 

The Series list is part of the default view in 

the Study Browser. The Series list displays 

all the series that are part of the selected 

study. It is below the Filtered Studies list and 

to the right of the Patient History list in the 

Study Browser window.  

Users can choose to have the Series list 

unavailable by clicking View on the Study 

Browser’s main toolbar and selecting Series.  

6-5—REFRESH LISTS 

The lists in the Study Browser window can be refreshed to show the most up-to-date information using Refresh 

Lists.  
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1. Click View in the Study Browser and select Refresh Lists.  

2. Press the default hotkey F5.  

Note: To enable the Study Browser lists to automatically update when idle, click Settings in the Study Browser and 

select Options. Mark the check box next to Refresh Study Browser automatically when idle. The lists automatically 

refresh after the user has been idle for one minute.  

6-6—RESET FILTERS 

Users can reset filters when searching the Filtered Studies list using Reset Filters.  

There are multiple ways to use the Reset Filters option: 

1. Click View in the Study Browser and select Reset 

Filters. 

 

 

 

 

 

 

 

 

 

 

2. Click Reset Filters on the Study Browser’s Custom 

Toolbar (if set up). 
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3. Press the default hotkey CTRL + Shift + F5. 

6-7—DOCKING TABS  

Users can toggle on/off the docking tabs in the NovaPACS Study Browser. This may be helpful to conserve space in 

the Study Browser. 

1. Click View in the Study Browser and select Docking Tabs. 

The tab names no longer display in the Study Browser.  

2. Toggle the tab names back on by reselecting Docking Tabs in the View menu.  

3. If tabs are part of a tab group, only the selected or foremost tab displays when Docking Tabs is deselected.  

If a tab needs to be visible all the time, drag it as its own docking section (top, bottom, left, or right of a docking 

section) before deselecting the Docking Tabs option.  

Note: This feature is enabled by default. Once deselected, the Filtered Studies, Patient History, Series, Report, Images, 

Preliminary Impressions, Preliminary Impressions Activity, and Hanging Protocols Layouts tabs are no longer visible. 

6-8—RADIOLOGIST PRODUCTIVITY DISPLAY 

The Radiologist Productivity Display list shows how many studies have 

been Assigned to the current user and how many have been 

Reviewed, by each modality. This helps users keep track of their 

productivity. 
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The Radiologist Productivity Display list automatically refreshes every five minutes. Users can manually refresh their 

list at any time by clicking the Refresh icon in the top, right-hand corner of the list. 

1. To enable the Radiologist Productivity Display, click View in the Study Browser and select Radiologist 

Productivity Display. 

By default, the Radiologist Productivity Display list appears to the right of the Series list. However, this list can be 

dragged and dropped into any location as with all lists in the Study Browser.  

2. To manually refresh the list, click the Refresh icon in the top, right-hand corner of this list.  

Note: The Radiologist Productivity Display list automatically updates every five minutes, regardless of whether users 

manually refresh the list.
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CHAPTER 7—USING THE STUDY BROWSER SETTINGS MENU 

The Settings menu contains 

options to arrange and setup the 

Diagnostic Viewer’s features, 

tools, and monitors. The Settings 

menu is on the Study Browser’s 

main toolbar.  

 

7-1—OPTIONS 

The Options page in the Settings menu allows users to customize options for the Study Browser and the Image 

Viewer.  

Click Settings in the Study 

Browser and select 

Options. The Options page 

opens.  

Note: The Options page can 

also be set as a button on 

the Study Browser’s Custom 

Toolbar.  

GENERAL TAB 

The General Tab on the Options page allows users to select general options for the Study Browser and Image 

Viewer. 

1. Smart image layout 

This helps users to use the space more efficiently in the series window. When selected, this layout causes the 

Image Viewer to place images into any unused space of a series window.  

2. Auto-show study browser  

This hides the Study Browser window from view when the cursor is moved off of the window. The Study 

Browser window reappears when the cursor moves to the far left or right edge of the Image Viewer window.  

Note: If the Auto-show Study Browser option is not selected, the Study Browser window does not automatically 

appear when the cursor is moved to the far left or right edge of the Image Viewer window.  

3. Auto-subtract multiframe angios  

Some modalities create multiframe Angio images. The subtract feature lets users take away a frame from the 

entire multi-frame image and only show the changes between the other frames. Auto-subtract performs the 

subtracting automatically when the multi-frame image is opened.  
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Note: The subtract option is available in the Image Viewer to Cardiologists only.  

4. Auto-checkout studies when they are opened 

This sets the status of a study to Checked Out when it opens in the Image Viewer.  

5. Auto-review studies when they are closed 

This is a sub-option available when the Auto-checkout studies when they are opened option is selected. This 

automatically sets the status of a study to Reviewed when it is closed.  

6. Prompt before marking a study reviewed 

This is a sub-option available when the Auto-checkout studies when they are opened and the Auto-review 

studies when they are closed options are both selected. This prompts users to confirm that the study can be 

marked as Reviewed.  

7. Open a new workspace for each patient 

This allows users to open multiple studies in separate workspaces.  

8. Display older related studies when opening a study 

This opens previous studies along with the selected study in the Image Viewer.  

Note: The Older Related Studies that open are determined by the Anatomical Area field of the image.  

9. Prompt for related studies when needed 

This is a sub-option available when the Display older related studies when opening a study option is selected. 

This prompts users when the Diagnostic Viewer cannot determine whether an older study is related or not, 

based on discrepancies of the Anatomical Area field of the image.  

10. Show patient history when opening a study 

This displays a list of other studies available for a patient when their study is opened in the Image Viewer.  

11. Show patient history when opening with a barcode 

This displays a list of other studies available for the patient when a study is opened with a barcode scanner.  

12. Show study notes when opening a study 

This opens a dialog box when a study is opened in the Image Viewer.  

13. Show other users’ annotations 

This shows all annotations created for a study.  

14. Reset filters when opening the study browser 

This resets the search filters back to default settings every time the Study Browser is opened.  

15. Add study split when opening a second study for a patient 

This automatically splits the Image Viewer window to display multiple studies. If this option is not selected, the 

second study opened appears as a tab at the top of the Image Viewer window.  

16. Auto-sharpen XAs 
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This automatically applies edge enhancement to XA images that may need more detail.  

17. Auto-local contrast enhance CRs 

This applies filters to CR images to enhance details in the image(s). Selecting this option applies the Local 

Contrast Enhancement to all CR images when opened in the Image Viewer. 

18. Use multiple windows to display RIS reports 

This allows users to view more than one exam report at a time. If this option is not selected, the default setting 

causes a second opened report to replace the first one.  

19. Show only the most recent study for each patient in filtered studies 

This shows only the most recent study for each patient in the Filtered Studies list in the Study Browser window. 

This is the default setting for users.  

20. Always sort filtered studies by priority 

This sorts studies by highest priority in the Filtered Studies list in the Study Browser window.  

21. Display separate window when creating a key image series 

This automatically shows the Key Image Series in the Image Viewer window when a Key Image is added. If this 

option is not selected, a Key Image Series is still created, but does not automatically display in the Image 

Viewer window.  

22. Reset cursor when closing a study 

This resets the mouse cursor back to the default settings if a study is closed while annotating. If this option is 

not selected, the mouse cursor retains the same settings that it was using when the previous study was closed.  

23. Auto-sync hanging protocol image layout options 

There are a few options in this section: 

a. Always match layout 

This displays all series windows using the same image layout, regardless of plane, when one series is 

adjusted.  

b. Only match layout if series are coplanar 

This synchronizes image layouts for all coplanar series.  

c. Never match layout 

If this option is selected, any adjustments to the layout need to be made to each series individually. 

24. Mouse control options 

There are a few options in this section: 

a. Mouse scroll sensitivity  

Increased sensitivity makes the cursor faster, while a decreased sensitivity results in a slower cursor.  

b. Minimum mouse drag distance 
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This determines how long of a distance the mouse must be moved to respond. A higher setting 

increases the distance the mouse must move to respond. Users can select a setting from 1-100.  

c. Mouse wheel sensitivity 

This determines how much the mouse wheel needs to be moved before it responds. Increased 

sensitivity makes the mouse wheel respond faster, while a decreased sensitivity results in a slower 

response.  

25. Prompt before marking a study reviewed if it has not been completely viewed  

This prompts users with a dialog box stating that all of the images in the study have not been viewed. Users 

must confirm whether they want the study to be marked Reviewed.  

26. Prompt before saving annotations 

This prompts users to confirm whether they want to save their recent annotations to the study permanently.  

27. Prompt before closing the application 

This prompts users to confirm whether they want to close the entire Diagnostic Viewer when exiting.  

28. Prompt before clearing the worklist 

This prompts users to confirm whether they want to clear the Worklist.  

29. Prompt to allow cross-localization of different frames of reference 

This prompts users to confirm that they want to set up a cross localization between images with different frames 

of reference.  

30. Display spine label cross references 

This displays spine label references at the top of intersecting images.  

31. Refresh study browser when idle 

This automatically refreshes the Study Browser lists after the user has been idle for one minute. 

Note: Contact Novarad Support to change the length of the idle time before auto-refresh begins in the Study Browser.  

32. Show RIS information when opening a study 

This brings up a RIS Information page in the Image Viewer when a study is opened.  

33. Fade Away after This Many Seconds 

This is a sub-option available when the Show RIS information when opening a study option is selected. This lets 

the user select the duration the RIS Information page is visible when the study is opened. Users can select from 

0-100 seconds. The default is 60 seconds.  

34. Magnify glass size 

This allows users to adjust the size of the magnifying glass tool for the Image Viewer. Autosize is the default 

setting. When using Autosize, the magnifying glass automatically adjusts according to the available series 

window and study space. The glass size also grows or shrinks as the magnification increases or decreases.  

35. Enable teaching files 
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This allows users to access and create Teaching Files in the Study Browser and Image Viewer. 

36. Draw arrow annotations head to tail 

This allows users to change the direction that arrows are drawn when annotating images. When selected, an 

arrow annotation is drawn with the pointed end of the arrow positioned where the user first clicks and the tail 

end of the arrow positioned where the user clicks a second time. This feature is turned off by default.  

37. Action when closing primary study 

The options beneath this section allow users to set preferences for how NovaPACS deals with comparison 

studies after the user closes a primary study. 

a. Always leave comparisons open 

This option leaves comparison studies open after primary studies have been closed.  

b. Always close comparisons 

This option automatically closes comparison studies when primary studies are closed.  

c. Prompt for primary from remaining unread comparisons 

When users select this option, the system sorts through comparison studies and prompts users to 

promote a comparison study to a primary study. Users are prompted only if the comparison study has 

not been reviewed.  

d. Auto-promote remaining unread comparisons 

This option auto-promotes an unread open comparison study to a primary study without prompting 

the user.  

 

 

 

 

 

 

38. Radius Menu 

This section allows users to enable or disable the Radius Menu, which is an alternative to the standard 

menu that appears when users right-click in the viewer.  

a. Pallet Mode: This is a consistent set of options that will stay the same for every study and 

modality.  

b. Context Mode: The context mode contains ten options that remain consistent across all studies. 

The outer rings of the Radius Menu in the context menu contain options specific to the study or 

modality the user is working with.  

c. Disabled: Disables the Radius Menu.  
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To enable either of the modes, select the desired mode and then click OK. 

 

 

 

 

 

 

 

 

KEYBOARD SHORTCUTS TAB (HOTKEYS) 

The most commonly used features in the Study Browser and Image Viewer come with default hotkey settings. 

Hotkey settings for menu functions are listed next to function names in the menu drop-down lists. However, these 

default settings can be changed and customized. 

To customize Keyboard Shortcuts, click Settings in the Study Browser, and select Options. 

In the Options dialog box, select the Keyboard Shortcuts tab. The page has windows for both the Study Browser 

menu items and the Image Viewer menu items. 

Assign a Keyboard Shortcut to the desired menu function by expanding the menu options in the Assign shortcuts to 

the Study Browser menu items window.  

Select a Keyboard Shortcut option from the drop-down list. Click Clear to remove the current setting and click OK 

to select the preferred function.  

AssignShortcut to the desired menu function by expanding the menu options in the Assign shortcuts to the Image 

Window menu items window. Type a keystroke or keystroke combination in the Image Window Keystroke field (any 

key combination can be used). Click Clear to remove the current setting and click OK to confirm the assignment. 

Note: The Image Window settings do not allow the same Keyboard Shortcut to be assigned for multiple functions and 

prompts users if a combination is already in use. However, a Keyboard Shortcut assigned to a Study Browser function 

can be used for Image Viewer functions also.  

MOUSE SETTINGS TAB 

Most functions in the Image Viewer can be performed with the mouse instead of the keyboard for 

radiologists’ convenience. The most commonly used features in the Image Viewer come with default mouse 

settings. These default settings can be changed and customized.  

 

1. Viewing Mouse Settings 

Users can change or create mouse 

settings using the Options menu. To 
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view the mouse settings, click Settings 

in the Study Browser, select Options, 

and click the Mouse Settings tab.  

There are three categories of mouse 

settings that users can customize: 

• Assign click events to actions—lists 

the functions available for control 

by mouse click.  

• Assign drag events to actions—lists the functions available for control 

by dragging the mouse.  

• Assign wheel events to actions—lists the functions available for control 

by the mouse wheel. Users can set the mouse wheel to scroll through 

the images slice by slice by assigning the UP or DOWN wheel events to 

the Previous or Next Image actions. 

2. Assigning Functions to Mouse Settings 

To assign or change a Mouse Setting, click one of the three drop-down lists 

(Mouse Click Event, Mouse Drag Event, or Mouse Wheel Event).  

Select the preferred mouse action from the corresponding drop-down list 

and click OK.  

 

MOUSE 3D SETTINGS 

The Mouse MPR/3D Settings allow users to configure what mouse functions do in NovaPACS MPR/3D Viewer. To 

access these settings, click the Mouse MPR/3D 

Settings tab in the Options menu.  

Select the preferred View from the View drop-down 

menu.  

 

Click to highlight the desired action.  
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Select the preferred configurations for buttons, modifiers, and mouse action.  

Once the desired settings have been configured, click OK.  

Note: The Invert option is available. To enable this feature, select Invert below Mouse 

Action. 

IMAGE CONTEXT MENU TAB 

The Image Context Menu allows users to add or remove options in the various modality Image Context menus.  

Click Settings in the Study Browser and select Options. Click the Image Context Menu tab.  

The Image Context Menu tab has two windows—an Available items window and a Current toolbar items window.  

To add Image Context Functions 

to a specific modality’s Image 

Context menu, click the Modality 

selection field at the top of the 

Image Context Menu tab page, 

and select a modality.  

Note: If users choose all modalities, 

the option they modify shows up in 

all Image Context Menus when they 

right-click. However, if users choose 

a specific modality, the option they 

modify shows up in the Image 

Context Menu for that modality 

only.  

 

Select a function to change or add 

from the Available items list. Click Add to add the function to the Current toolbar items list and click OK. The 

function is available in the Image Context Menu in the Image Viewer when the user right-clicks.  

To remove Image Context Functions from a specific modality’s Image Context Menu, click the Modality selection 

field at the top of the Image Context Menu tab page and select a modality.  

Select the unwanted function from the Current toolbar items list. Click Remove to delete the function from the 

Image Context Menu, then click OK.  

RE-ORDERING THE IMAGE CONTEXT FUNCTIONS  

Users can customize the order of the Image Context Menu items. Items can be reset to original settings 

and moved to a different location or hierarchy on the list as well. 
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To do this, select an item on the Current toolbar items window list and click Reset, Move Up, Move In, 

Move Out, or Move Down. Click OK.  

AUTO W/L TAB 

Users can view and manage Auto Window/Level Adjustments 

from the Auto W/L tab of the Options page accessed from the 

Study Browser’s Settings menu. 

The Options page Adjustments box lists all Auto 

Window/Level Adjustments saved for the current user.  

The Filters box lists all filter settings applied across a modality.  

Users can add, edit, and remove Adjustments and Filters from 

this tab to ensure that images always display according to 

their preferences. 

Note: There is only one set of Add, Edit, and Remove buttons. These 

buttons are used to manage both Adjustments and Filters. 

ADDING ADJUSTMENTS 

To add an adjustment, click inside the Adjustments box and select Add at the 

bottom of the page. The Window Level Adjustment dialog box opens. 

The Window Level Adjustment dialog box allows users to manually specify the 

modality and image type the Auto Window/Level Adjustment applies to as well as 

the desired Window/Level values.  

In the Modality field, specify the modality to be associated with the new 

adjustment. In the Low Window, High Window, Low Level, and High-Level fields, 

specify the range of intensity values for the images to which the new adjustment 

applies.  

In the New Window and New Level fields, specify the values to be automatically applied to the specified images. 

Note: When created directly from the Image Viewer, these values are automatically calculated and populated based 

on the currently selected image and applied Window/Level values.  

Click OK when finished. The new Window/Level Adjustment is saved and appears in the Adjustments list. The new 

Window/Level Adjustment automatically applies to the appropriate images the next time they are opened. 

In order to save a new adjustment, all fields must be completed. If fields are not completed appropriately, warning 

dialog boxes prompt the user to correct the error before saving. 
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EDITING ADJUSTMENTS 

Users can edit Window/Level Adjustment by selecting the item they wish to edit from the Adjustments list and 

clicking Edit.  

The Edit Parameters dialog box appears, allowing users to specify the images that the adjustment applies to as well 

as the Window/Level values to be applied. 

Note: Users may not edit the modality of an existing Auto Window/Level Adjustment. 

In the Low Window, High Window, Low Level, and High-Level fields, users may edit the range of intensity values for 

the images to which the new adjustment applies. In the New Window and New Level fields, users may choose the 

values to be automatically applied to the specified images. 

Click OK when finished. Changes to the Window/Level Adjustment are saved and appear in the Adjustments list. 

The new changes automatically apply to the appropriate images the next time they are opened.  

In order to save changes to an auto Window/Level Adjustment, all fields must be completed. If fields are not 

completed appropriately, warning dialog boxes prompt the user to correct the error before saving. 

REMOVING ADJUSTMENTS 

Users can delete Window/Level Adjustment by selecting the item they wish to delete from the Adjustments list and 

clicking Remove. The Window/Level Adjustment is deleted immediately and no longer automatically applies to 

images. 

ADDING FILTERS 

To add a filter, click inside the Filters box and select Add at the bottom of the page.  

The Window Level Filter dialog box opens. 

The Window Level Filter dialog box allows users to manually manage filters that apply across an entire modality. 

Only one filter may be created per modality. 

In the Modality field, specify a modality for the new filter.  

In the Low Window field, enter the minimum low window value for the filter.  

In the High Window field, enter the maximum high window value for the filter.  

In the Low-Level field, enter the minimum low-level value for the filter.  

In the High-Level field, enter the maximum high-level value for the filter.  
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Enter the new window value in the New Window field.  

Enter the new level value in the New Level field.  

Click OK to confirm the changes. Click Cancel to exit without adding the filter.  

In order to save a new filter, all fields must be completed. If fields are not completed appropriately, warning dialog 

boxes prompt the user to correct the error before saving. 

EDITING FILTERS 

Users can edit existing filters by selecting the item they wish to edit from the Filters list and clicking Edit or double-

clicking a listed filter.  

The Edit Parameters dialog box appears, allowing users to edit filter values. 

 

Note: Users may not edit the modality of an existing filter. 

Users can edit the Minimum and Maximum Pixel value fields if needed. 

By default, the NovaPACS Diagnostic Viewer uses the window/level values 

supplied by the modality that are in the DICOM file. Users can decide whether 

to apply the DICOM window/level values or have the Viewer calculate 

optimum window/level values.  

Users can edit this by clicking the Use DICOM Values drop-down list.  

• Always –This always uses the window/level values supplied by the modality 

in the DICOM file for the selected modality type.  

• When Reasonable—The NovaPACS Diagnostic Viewer calculates auto 

window/level values from the selected modality type and compares them to 

the values supplied in the DICOM file. Images display with the most optimal 

window/level values of the two.  

• Never—This never uses the supplied DICOM window/level values for the selected modality type and the 

NovaPACS Diagnostic Viewer calculates optimal auto window/level values.  

In addition, if users want the NovaPACS Diagnostic Viewer to always calculate auto window/level values for the 

selected modality type, they can select the Always Use Calculated Values checkbox—which takes precedence over 

the Use DICOM Values drop-down list settings.  

This ignores the supplied DICOM auto window/level values and the NovaPACS Diagnostic Viewer calculates optimal 

auto window/level values.  

If users decide to have the NovaPACS Diagnostic Viewer calculate auto window/levels instead of using the supplied 

DICOM auto window/level values, they can select Calculate Each Image.  
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This ensures that auto window/level values are calculated using values from each image in a series, instead of an 

average from the entire series. Some modality types have a high variety of values from image to image, and 

choosing this option ensures a more accurate calculation.  

Additional settings on this page are best configured only by Novarad personnel. Contact Novarad Support for 

assistance in setting/adjusting auto window/level filter values.  

Make any necessary changes and click OK. Changes to the filter are saved and appear in the Filters list. The new 

changes automatically apply to the appropriate Modality.  

In order to save changes to a filter, all fields must be completed. If fields are not completed appropriately, warning 

dialog boxes prompt the user to correct the error before saving. 

REMOVING FILTERS 

Users can remove Filters by selecting the item they wish to delete from the Filters list and clicking Remove.  

The Filter is removed immediately and no longer applies to images of the selected modality type.  

LABELS TAB 

Admins can change and customize the DICOM labels that appear on images in the Image Viewer. These labels 

provide useful patient, study, and series information. Font sizes and colors can be customized for the labels as well. 

Labels automatically adjust according to each monitor’s resolution. 

Note: The ability to customize or edit DICOM labels is a role-based permission and can be assigned by Admins. 

VIEWING THE LABELS TAB 

Click Settings in the Study Browser and select Options. Select the Labels tab.  

The Labels page displays the default DICOM label 

settings. These default settings are used if a specific 

modality’s labels are not customized. Select a modality 

from the Modality drop-down list to view its DICOM 

label settings. Users can create and modify their own 

custom labels from the Labels tab.  

Note: The default color of a label is determined by the level of 

that label (i.e. the Patient level has a default color of light 

teal; the Study level has a default color of dark teal; the Series 

level has a default color of purple; and the Image level has a 

default color of gold). 

Editing Label Font Size and Color  
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a. Select a modality from the Modality drop-down list. 

b. Click Size/Color above the DICOM Fields section. The 

Edit Default Label Properties dialog box opens. 

 

c. Select a label from the Select label level to edit drop-

down list. The Size and Color fields become available once a label is 

selected. 

d. Select a size for the font from the Size drop-down list. The default 

size is Normal. 

 

 

e. To change the font color, click the colored square next to the Color field. The 

Color dialog box opens allowing users to select from the Basic Colors options or 

create a custom color using the Define Custom Colors option. 

To create a custom color, click Define Custom Colors. Use the cross-point tool and/or 

enter values in the Hue, Sat, Lum, Red, Green, and Blue custom boxes to define the 

desired color.  

 

 

Click Add to Custom Colors. Select that custom color as the font color and 

click OK to save the changes.  

 

 

 

 

ADDING LABELS 

Admins can add a Label for a specific modality’s image. 

a. Select a modality from the Modality drop-down list. 

b. Select the desired label from the DICOM Fields list.  

c. Drag the label onto the black image box on the page to add it to the labels for the modality’s images.  

Note: Other roles, such as Radiologist, can modify DICOM labels, when Admin enables permission to do so. 
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Note: Users cannot drag a label from one 

quadrant of the black image box to another. To 

move a label from one quadrant to another, users 

must first delete the image label by double-clicking 

it. Then, drag the label onto the appropriate 

quadrant. In addition, users cannot add duplicate 

labels in the same quadrant of the image box. 

 

 

 

REMOVING LABELS 

Double-click the label within the black image box to remove it.  

CREATING LABELS 

If users need a label that is not available in the DICOM Fields list, labels can be created and added to any specific 

modality’s images.  

Note: Users must know the specific group and element numbers located on 

the image to create a label. This is found using the Image Details option in 

the Image Viewer.  

a. Click Create located at the bottom of the DICOM Fields list. The 

Create DICOM Label dialog box appears. 

b. Enter the necessary information into the fields in the Create 

DICOM Label dialog box. 

• Name—Enter a name for the label, for example use “View” for FOV. 

• Modality—Choose a modality to make this DICOM label 

available for a specific modality.  

• Display Label—Enter a short, abbreviated title for the 

label (i.e. ACC# for Accession Number).  

• DICOM Tag Fields—Specify the DICOM group and 

element from which to pull information.  

• Text Display Properties—Use the Size drop-down list to 

select the text size. The default text size is Normal. 

Select the Color box to choose a basic color or create a 

custom color.  

EDITING DICOM FIELDS 

1. Select a field from the DICOM Fields list and click Edit. The Edit DICOM Label dialog box opens.  

2. Make any needed changes to the information fields and click OK to save the changes. Click Cancel to exit 

without saving changes. 



 

Page 77 of 169   

 

NovaPACS User Manual 

LEXICON TAB 

A Lexicon value is one or more words commonly used to 

annotate images in the Image Viewer. Users can add 

phrases that are used frequently and have the option to 

select these from a list in the Image Viewer instead of 

manually typing them. An administrator can create global 

Lexicon values available to all users, and customized values 

can be created by each user available only to them.  

 

VIEWING THE LEXICON TAB 

Click Settings in the Study Browser and select 

Options. Click the Lexicon tab. 

Adding Lexicon Values 

1. On the Lexicon tab page, click Add at the 

bottom. The Add Lexicon Item dialog box 

opens.  

2. Select a modality from the Modality drop-

down list to add a Lexicon value. 

3. Enter the desired text into the Lexicon Text 

box and click OK to save the new Lexicon 

value.  

 

 

EDITING LEXICON VALUES 

1. Select a Lexicon value from the Lexicon list.  

2. Click Edit at the bottom of the page. The Edit Lexicon Item 

dialog box opens.  

3. Make any needed changes to the Lexicon value and click OK 

to save.  

 

 

 

DELETING LEXICON VALUES 

1. Select a Lexicon value from the Lexicon list.  

2. Click Delete at the bottom of the page to delete the value from the list.  
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PLUG-INS TAB 

The NovaPACS Diagnostic Viewer has three Plug-ins options available: 

• Image Rendering Provider—options are DirectX 

• Dictation Provider—options are Basic, File, Dragon, CMDLine, Fluency Direct, and PowerScribe360 

Note: Users can configure the PowerScribe Plugin settings by 

going to Settings → Options →Plugins →Plugin Settings and 

clicking on the PowerScribe tab. 

• CD Burning Provider—options are Primera, Legacy, 

and Basic 

 

Note: The Dictation Provider and CD Burning Provider 

options may require additional software.  

To view and/or change the Plug-ins options, click 

Settings in the Study Browser, and select Options. Select 

the Plug-ins tab.  

Use the drop-down lists next to the Plug-ins to select 

new options. 

Note: In order to edit the Plug-ins options the user’s 

credentials must be verified as the Windows 

Administrator. 

 

 

 

DATA SOURCES TAB 

Data Sources are the connections that allow the 

Diagnostic Viewer to communicate with the 

Database and Image Servers. Data Sources are 

the primary locations from which images are 

downloaded.  

Note: Users cannot add, edit, or delete Data 

Sources for DICOM Pass Through servers. 
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VIEWING DATA SOURCES 

Click Settings in the Study Browser and select Options. Select the Data Sources tab.  

All the currently established Data Sources are listed on the Data Sources tab page. Users can change the Primary 

Archive and Image Cache options using the corresponding drop-down lists.  

ADDING A DATA SOURCE 

1. On the Data Sources page, click Add at the bottom. The Add Data Sources dialog box opens.  

2. Enter the appropriate Friendly Name and Server Address information.  

3. Select the NovaPACS or DICOM source type from the Source Type section.  

4. If NovaPACS is selected as the source type, choose the appropriate Port and Compress Options. Users can 

select checkboxes to Stream Images, Automatically retrieve images queued for this machine (Client Requested 

Transfer), and Automatically login. 

Note: If Automatically Login is selected, users are prompted to enter a username and password and verify a login for 

each data source. 

5. If the DICOM source type is selected, enter the appropriate information for the Port and AE Title fields.  

EDITING DATA SOURCES 

1. Select the Data Source listing from the Data Sources list.  

2. Click Edit at the bottom of the page. The Edit Data Source dialog box opens.  

3. Make any needed changes to the Data Source information and click OK to confirm.  

DELETING DATA SOURCES 

1. Select the Data Source from the Data Sources list.  

2. Click Remove at the bottom of the page. The Data Source is removed from the Diagnostic Viewer’s Data 

Sources options.  

TESTING DATA SOURCES 

1. Select the Data Source from the Data Sources list.  

2. Click Test at the bottom of the page.  

3. The Diagnostic Viewer tests the Data Source. If the Data Source is incorrect, users receive a warning message 

stating that the Data Source failed, however, if it is functioning properly, users do not see any message.  
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7-2—W/L PRESETS 

W/L Presets allows users to specify window/level preset values 

for each modality when using the Image Viewer. The Image 

Viewer sets default W/L values for each modality that 

correspond in number with the F1-F11 keys on the keyboard 

(i.e. F1 corresponds with the W/L setting set to one).  

Note: Up to 12 W/L Presets may be specified; however, only 11 

may be accessed from default hotkeys F1-F11. W/L Preset 12 can 

only be accessed from the menu or toolbar. The F12 keystroke is 

the default hotkey for Auto Window/Level Adjustments.  

CUSTOMIZING THE W/L SETTINGS 

Users can customize the W/L values and save them to user preferences.  

1. Click Settings in the Study Browser and select W/L 

Presets. The Configure Window/Level Presets dialog box 

appears.  

2. Select a modality from the Modality drop-down list.  

3. Select the desired preset value from the W/L Preset 

drop-down list. The Preset Values fields populate with 

the values assigned to that W/L Preset.  

4. Change the Menu/Toolbar Name by entering text in 

the field. The Menu/Toolbar Name appears on the W/L 

Toolbar in the Image Viewer.  

5. The Apply Current Window/Level button allows users to apply the W/L settings used in the Image Viewer to 

the W/L Preset being customized. Adjust the window/level settings in the Image Viewer, then click Apply 

Current Window/Level to apply the settings to the W/L Preset.  

CUSTOMIZING WIDTH AND CENTER FOR WINDOW/LEVEL FIELDS AND PRESETS 

Users can customize the width and center values for the window/level fields and presets.  

To customize the width and center window/level values, click Settings in the Study Browser and select W/L Presets. 

The Configure Window/Level Presets dialog box appears.  

1. Click the up or down arrows next to the Window (Width) and/or Level (Center) fields to choose the values.  

2. Manually enter the values in the Window (Width) and/or Level (Center) fields.  

3. Click Apply Current Window/Level to apply the settings being used in the active study in the Image Viewer.  

4. To set the W/L Preset in the Image Viewer, close the Configure Window/Level Presets dialog box and go to the 

Image Viewer. Make any window/level adjustments needed on the image and press CTRL + F__ (the F key 
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corresponding to the changing preset, i.e. F6 for preset six). This sets the adjustments as the W/L Preset for 

that F key.  

Note: To view the saved settings in the Configure Window/Level Presets dialog box, go back to the Study Browser, 

click Settings, and select W/L Presets. The Configure Window/Level Presets dialog opens. Select the changed modality 

and the changed preset number, and the new values populate in the Window (Width) and Level (Center) fields. 

7-3—MANAGE HANGING PROTOCOLS 

The Hanging Protocol Layouts are the saved layouts associated with a specific modality (and optionally, study 

description) for displaying study images and series in the Image Viewer. 

Users can define multiple Hanging Protocols for each modality and define multiple Layouts for each Hanging 

Protocol. 

 

Within each Layout, users can filter 

individual Image Boxes to display only 

certain types of images. This allows 

users to easily create, manage, and 

navigate between the specific views 

they prefer for individual study types.  

 

Users can manage Hanging Protocols from the Study Browser 

menu by clicking Settings in the Study Browser and selecting 

Manage Hanging Protocols.  

The Manage Hanging Protocols editor dialog box opens. 
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ADD NEW HANGING PROTOCOL 

Click Add New at the bottom 

of the Study Types list. The 

Manage Hanging Protocol 

editor now allows the user to 

select options for the new 

Hanging Protocol. 

Select Modality 

First select a modality from 

the Modality drop-down list. 

This is the modality with 

which the new Hanging 

Protocol is associated. A 

modality must be selected in 

order to save a new Hanging 

Protocol. A Hanging Protocol 

can only be applied to a study 

if they are both associated with the same modality. 

MANAGE STUDY DESCRIPTIONS 

A Hanging Protocol applies automatically to any study that matches all of its Study Descriptions. Adding Study 

Descriptions helps users distinguish what types of studies the Hanging Protocol was set up to display. Users may 

manually apply a Hanging Protocol to a study that does not match its study description, as long as both are 

associated with the same modality. 

To add a Study Description, click Add to the right of the Study Descriptions list.  

 

 

 

 

 

 

 

 

 

 

A small text box appears inside the Study Descriptions list. Type in an anatomical area to associate with the new 

Hanging Protocol. Repeat as many Study Descriptions as needed.  
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Note: If users edit/create a hanging protocol with a study open in the 

Image Viewer by clicking the gear icon, all applicable study and series 

descriptions pre-populate.  

 

 

 

 

 

 

A unique Study Description (or combination of Study 

Descriptions) must be added in order to save a new 

Hanging Protocol for the same modality as an existing 

Hanging Protocol. Radiologists use different Study 

Descriptions to differentiate between study types. 

They use different Hanging Protocols to view those 

studies in a specific order. 

 

To edit an existing Study Description, highlight the 

description and click Edit.  

To delete an existing Study Description, highlight the 

description and click Remove.  

 

 

 

 

 

SELECT A DISPLAY TOOL OPTION 

Select an option from the Display Tool drop-down list to specify how to display the Hanging Protocol. 

SELECT A SPINE LABELING DEFAULT 

Select an option from the Spine Labeling Defaults drop-down list to 

specify the spine labeling configuration for the new Hanging 

Protocol.  

 

Select Edit Options to customize the available spine 

labeling options. This allows users to add, edit, and 
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remove spine labeling options. It also allows users to 

customize font and font color for spine labeling options. 

 

 

 

 

 

 

MANAGE LAYOUTS 

Users can add, edit, remove, and duplicate layouts within a Hanging Protocol using the layouts section of the 

Manage Hanging Protocol editor. 

Add Layout 

Click Create Layout at the top of the 

layouts section. This adds a new, blank 

layout. 

Edit Layout 

Click Edit Layout at the top right of the layouts 

section or double click the thumbnail image of a 

layout. The Edit Layout window opens. 

Editing Series Layout 

There are three primary ways to edit the Series 

Layout. 

1. Click the box with green gridlines, located above the image boxes. 

 

The Choose Series Layout box opens. 

 

 

 

Choose how the series displays by hovering the cursor vertically and horizontally over the squares and clicking when 

the preferred layout is highlighted in light gray.  
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2. Click the appropriate Split Window Tool located 

in the top bar of an image box to edit the image 

layout within that image box or to split the series 

horizontally or vertically.  

3. Click the red X at the top of an image box to 

delete that window from the series layout.  

 

 

 

 

USING THE IMAGE LAYOUT SETTINGS TAB 

Select the Image Box. This enables the Image Layout Settings tab and allows users to choose image layout options 

for the selected portion of the layout.  

On the Image Layout Settings tab, users can edit the 

Layout type, Image Layout, and Clip playback.  

The options for editing the Layout type are as follows: 

 

Tiled 

The images in the series can be set to a Tiled display. This is the default view. 

When the Tiled option is selected, users can do the following: 

1. Use the Choose Image Layout box to select how images display within the series. Select how the images display 

by hovering the mouse vertically and horizontally over the squares and clicking when the preferred layout is 

highlighted in light gray. 

2. Select Zoom To Fit, Zoom To Fill, Custom, or No Zoom.  

3. Adjust the Frame rate, which controls the playback speed.  

4. Select the Auto-start and Use DICOM Frame Rate checkboxes.  

Note: Auto-start begins to play the clip as soon as the image loads. Use DICOM Frame Rate to play the image frame 

rate at the recorded rate. When not checked, the Image Viewer determines the image frame rate by the Desired 

Frame Rate count.  

5. Select Looping, Sweeping, or Stop for the Playback sequencing.  

a. Looping repeats the playback from the first image to the last and then begins again with the first image.  
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b. Sweeping repeats the playback from the first image to the last and then from the last image to the first.  

c. Stop allows users to control image playback by manually advancing or reversing a single image with the 

forward and back buttons. After going to the final image, the series stops and is displayed in default Tiled 

layout. 

Cine 

The images in a series can be set to a Cine display. Cine is typically used for Cardiology images. 

 

When Cine is selected, users can do as follows: 

1. Set the Desired Frame Rate to control the playback speed.  

2. Select the Auto-Start checkbox to begin playing the clip as soon as the image loads.  

3. Select the Use DICOM Frame Rate checkbox  

Note: This plays the image at the rate recorded if selected. If not selected, the Image Viewer determines the image 

frame rate by the Desired Frame Rate count. 

4. Set Playback Sequencing to Looping, Sweeping, or Stop  

 

Processed 

The images in a series can be set to be processed by 

either MPR or Image Fusion. Select the Processed layout 

type, then select an option from the Processed By drop-

down list. 

 

If Processed by MPR is selected, the series automatically displays in a Multi-Planar Reconstruction (MPR) view. This 

view reconstructs multiple 2D images into a multi-planar 3D view. Novarad provides MIP/MPR functionality and 

support with NovaPACS.  

Note: If the system has not been used with the Diagnostic Viewer’s MIP/MPR support, an administrator must contact 

Technical Support to configure each workstation to access MIP/MPR.  

If Image Fusion is selected in Processed By, two series from different modalities (typically CT and PET) fuse for a 

more detailed image.  

When finished editing a layout, click OK to save the changes. Click Cancel to close the Edit Layout window without 

saving changes and return to the Manage Hanging Protocols editor. 

1. Remove Layout 

Select the layout’s thumbnail image from the Manage Hanging Protocols editor and click Remove layout. The 

layout is deleted from the current Hanging Protocol. 

2. Duplicate Layout 

Select the layout’s thumbnail image from the Manage Hanging Protocols editor and click Duplicate layout. The 

layout is duplicated in the current Hanging Protocol. 
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EDIT HANGING PROTOCOL 

Click on an existing Hanging Protocol’s description in the Study Types list. The Manage Hanging Protocols editor 

allows users to make changes to any options described in the previous sections. 

REMOVE HANGING PROTOCOL 

Select an existing Hanging Protocol’s 

description and click Remove below the 

Study Types list to remove it.  

When finished managing Hanging 

Protocols, click Close to exit the Manage 

Hanging Protocols editor and return to the 

Study Browser. 

7-4—CONFIGURE MONITORS 

Configure Monitors allows users to select 

monitors for viewing images. Any monitor 

properly connected to the user’s computer 

appears in the Configure Monitors window as 

numbered rectangles.  

Click Settings in the Study Browser and select 

Configure Monitors. Users can also press the 

default hotkey CTRL + M. The Configure 

Monitors dialog box opens. 

 

Users can select a monitor or combination of monitors by clicking the rectangles. Selected monitors have a red 

border. Deselect monitors by clicking a selected rectangle again. Users can also select which kinds of images will be 

displayed on each monitor. The current options are NovaPACS and NovaMG PRO.  

 

Note: On a three-monitor system, where the third monitor is used only for displaying the Study Browser, make sure 

the third monitor for the Study Browser is not selected for use with images.  

Note: when configuring monitors, users cannot have a monitor between two configured monitors. The configured 

monitors must be contiguous. 
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Users can also determine whether the left monitor displays new studies or old studies by selecting the options at the 

bottom of the Configure Monitors dialog box. Click OK to save the monitor settings.  

7-5—PREFERENCES 

Preferences allows users to select settings for 

viewing and organizing images and 

information in the Diagnostic Viewer. Any 

changes the user makes to the default 

preferences settings are stored and 

automatically recalled each time that user logs 

into the Diagnostic Viewer.  

 

Note: Novarad recommends that users periodically export a copy of their preferences to the desktop, a flash drive, or another 

data storage device.  

Click Settings in the Study Browser and select the Preferences drop-down list.  

RESET PREFERENCES 

Reset Preferences allows users to reset user preferences to the site’s default settings.  

Note: The Diagnostic Viewer permanently overwrites any settings 

that have been changed in the Study Browser and the Image 

Viewer when the Reset Preferences option is selected. Users receive 

a warning before resetting.  

Click Settings in the Study Browser and select the 

Preferences drop-down list. Select Reset Preferences.  

 

The Reset Preferences dialog box opens.  

Click the Select the source profile for preferences drop-down list and 

select the role to use for default preferences.  

Once the role is selected, choose whether to reset the preferences to 

the Basic, Normal, or Advanced level. Administrators can customize 

and save these levels. 

Click OK to confirm the reset.  

IMPORT PREFERENCES  

Import Preferences allows users to import preference settings from a saved location. This is helpful when sharing 

preference settings from one Diagnostic Viewer installation to another.  
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Click Settings in the Study Browser. Hover the cursor over Preferences and select Import Preferences.  

Browse to find the desired preferences file and click Open.  

Note: When exiting the Diagnostic Viewer, if imported preferences 

are not stored in the database, users receive a warning before the 

preferences are overwritten.  

EXPORT PREFERENCES 

Export Preferences allows users to save and export a copy of their user preferences in case they are ever lost or 

reset.  

Click Settings in the Study Browser and hover the cursor over Preferences. Select Export Preferences.  

The Export Preferences to File dialog box opens.  

Select a destination for the file by clicking a listed location or browsing through the computer and file options.  

Name the preferences file in the File Name field.  

Note: Novarad recommends naming the user preferences with the username and the current date, to quickly locate 

them later.  

Click Save to export a copy of the user preferences.  

RESTORE FROM BACKUP 

Restore from Backup allows users to restore their user preferences from preference files that have been backed up 

automatically on the NovaPACS server. This is helpful if users have had connection or server issues and their user 

preferences have been lost. Users can see up to the last ten user preference files that have been saved and can 

quickly restore their user preferences to a selected date’s preferences.  

Note: User preferences are only backed up automatically and available if the user has made any 

changes/customizations while logged in. If the user has not made any changes/customizations, that day’s preferences 

are not available on the Restore from Backup list.  

 

1. Click Settings in the Study Browser and hover the cursor over Preferences. Select Restore from Backup.  

The Restore From Backup dialog box opens.  

2. Click the Most recent preference backups drop-down list 

and select a date. The dates listed are the most recent 

dates when preference backups were saved to the server.  

3. Click Restore to restore the user preferences to the selected date’s backed-up user preference file.  
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EXPORT USER PREFERENCES 

Export User Preferences enables administrators to export all of their users’ preferences from their own user login. 

This allows admins to quickly export all users’ preferences from a single location, and from a remote location if 

necessary.  

 

1. Click Settings in the Study Browser and hover 

the cursor over Preferences. Select Export User 

Preferences. 

 

The Export User Preferences window opens.  

2. Select the user preference(s) to export. Users 

can hold down CTRL or SHIFT to select multiple 

user preferences.  

 

 

3. Select the location for the exported preferences 

by clicking Browse.  

 

The Browse for Folder window opens.  

4. Browse for a location, select it, and click OK.  

5. Click Export in the bottom right-hand corner of the window.  

Users receive a notification when the user preferences are successfully 

exported.  

 

 

 

 

 

Users can navigate to the save location to verify that the users’ preferences have successfully exported.  
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SAVE AS DEFAULT PREFERENCES 

Save as Default Preferences allows administrators to save default user preferences for all users. A new profile for 

CD/DVD/USB preferences can also be set for users burning Patient disks.  

Note: Only an administrator can alter Default User Preferences. It is important to remember that all settings 

including buttons, hotkeys, and the general layout of the window are what the users can use. This includes 

CD/DVD/USB burning preferences.  

1. Make all of the preference changes needed (i.e. hotkeys, toolbars, image context menus, mouse settings, etc.).  

2. Click Settings in the Study Browser, and hover over Preferences. Select Save as Default Preferences.  

The Set Default Preferences for Profile dialog box opens.  

3. Select the user role to save preferences.  

4. Select the level of preferences to save. The options are Basic, Normal, or Advanced.  

5.  Click OK to save the current user preferences for that role.  

SAVING INDIVIDUAL PREFERENCES  

Users can save specific preferences. Click Settings in the Study Browser and hover the cursor over Preferences.  

Select Import, Restore From Backup, or Reset to Default. A separate 

window opens. 

Click Browse to select a preference file. 

To expand the All Preferences checkbox, click the arrow to its left. The 

window extends and reveals a list of individual preferences.  

From the extended window, users can select which preferences to save by 

selecting or deselecting the checkboxes next to the specific preferences. 

 

 

 

7-6— CUSTOMIZE TOOLBAR 

Customize Toolbar allows users to edit the functions on the Study Browser’s Custom Toolbar, add or remove toolbar 

items, and reorder the menus. 

The following sections describe what functions users can do with the Study Browser toolbars: 
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ADDING TOOLBAR ITEMS 

1. Click Settings in the Study Browser and select 

Customize Toolbar. Users can also right-click on any 

toolbar in the Study Browser window and select 

Customize. A Custom Toolbars page opens.  

2. Select the toolbar from the Select Toolbar drop-down 

list.  

3. Select the desired feature from the Available Items 

list on the left side of the page.  

4. Click Add to add the feature to the Current Toolbar 

Items list.  

5. Click Save to save the change(s) and exit.  

REMOVING TOOLBAR ITEMS 

1. Click Settings in the Study Browser and select Customize Toolbar.  

2. Select the toolbar from the Select Toolbar drop-down list.  

3. Select the feature to remove from the Current Toolbar Items list.  

4. Click Remove to remove the feature from the Current Toolbar items list.  

5. Click Save to save the change(s) and exit.  

REORDERING THE MENU 

Users can customize the Study Browser toolbars by resetting the toolbar settings or reordering 

individual features. 

1. Click Settings in the Study Browser and select Customize Toolbar.  

2. Select the toolbar from the Select Toolbar drop-down list.  

3. Select the feature from the Current toolbar items list.  

4. Click Reset, Move Up, Move In, Move Out, or Move Down until the feature is in the desired 

location. 

5. Click Save to save the change(s) and exit.  

CUSTOMIZING TOOLBAR OPTIONS 

1. Click Settings in the Study Browser and select Customize Toolbar.  

2. Click the Toolbar Options tab at the top of the page.  

3. Select an option from the Button Layout drop-down list (Text Only, Image Only, or Image and Text).  

4. To change the toolbar layout, deselect the Auto Toolbar Layout checkbox.  
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5. In the Toolbar Layout field, select an option from the Image Text Relation drop-down list (Overlay, Image 

Above Text, Text Above Image, Text Before Image, or Image Before Text).  

6. To change the image and/or text size, deselect the Use Viewer Scale checkbox.  

7. In the Image/Text Size field, select an option from the Image size drop-down list (Normal or Large) and an 

option from the Text size drop-down list (Normal, Medium, or Large).  

8. Click OK to save and exit.  
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CHAPTER 8—USING THE STUDY BROWSER HELP MENU 

The Study Browser’s Help menu offers users help 

with using the Study Browser and Image Viewer 

functions. The Help menu contains instructions, 

current user information, Novarad Support’s 

contact information, the option to submit 

feedback, the Diagnostic Viewer User Manual, 

What’s New documents detailing new features in 

the Diagnostic Viewer, and an About section.  

The Help menu is located on the Study Browser’s main toolbar.  

8-1—INSTRUCTIONS 

The Instructions window offers users basic information about 

how to open case studies with the Diagnostic Viewer. The 

Instructions window also offers a Shortcuts section with 

information on mouse functionality in the Diagnostic Viewer.  

 

 

 

 

8-2—CURRENT USER INFORMATION 

Current User Information shows users their role in the Diagnostic Viewer and what 

features and tools are available for that role.  

 

 

 

 

 

8-3—CONTACT SUPPORT 

Contact Support allows users to submit general questions to Novarad Support.  
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1. Click Help in the Study Browser and select Contact Support. The Contact 

NovaPACS Technical Support dialog box opens.  

2. Enter the following information in the message window: 

a. Name 

b. Facility Name and Location 

c. Contact Phone Number and/or E-mail Address 

d. Complete description of the issue 

e. Any troubleshooting details, including attempts to correct 

the issue 

3. Click Send to email the message to Novarad Support. 

8-4—SUBMIT FEEDBACK 

Submit Feedback allows users to send product feedback and suggestions to Novarad Corporate. 

1. Click Help in the Study Browser and select Submit Feedback. The Submit 

Product Feedback dialog box appears.  

2. Enter the following information in the message window: 

a. Name 

b. Facility Name and Location 

c. Contact Phone Number and/or E-mail Address 

d. Complete description of the suggestion/feedback 

3. Click Send to email the message to Novarad Support. 

8-5—USER MANUAL 

User Manual allows users to see the Diagnostic Viewer User Manual (in PDF). Users can search for information 

using the Table of Contents, Index, Find (CTRL + F) feature, or the PDF chapter and section bookmarks to the left 

of the PDF viewer window. 

8-6—WHAT’S NEW 

What’s New allows users to see the NovaPACS What’s New document detailing the newest features in that version 

of the NovaPACS software (as a PDF document). 

 

8-7—ABOUT 

About allows users to view Product, Version, and Copyright information 

about the NovaPACS Diagnostic Viewer as well as provides the user with the 

Novarad Support phone number.  
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8-8 FEATURE HIGHLIGHT DIALOG 

Every 30 days, users will see the Feature Highlight Dialog pop-up. This will highlight a Feature 

in PACS or another Novarad product that might be of use to the user. To see the New Feature 

Dialog more than just once a month, users can click the Party Popper icon located next to the 

settings button in the Study Browser.  
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CHAPTER 9—USING THE IMAGE VIEWER 

When users open a study from the Study Browser, the images display in the 

Image Viewer. The Image Viewer screen displays the images along with 

easy access to features on toolbars, menus, and buttons. Users can review 

and annotate images, customize the workspace, and complete reports from 

the Image Viewer. 

 

 

 

 

 

 

9-1—INTRODUCTION TO THE IMAGE VIEWER 

When users open a study from the Study Browser, the images display in the Image Viewer. The images, series, and 

study display in the Image Viewer window according to the default Hanging Protocols for that modality. Depending 

on the monitor configuration, the Image Viewer either displays in front of the Study Browser window or displays on 

a separate monitor, so both windows are visible. 

To access the Image Viewer, double-click a study in the Study Browser window or select a study and click Open on 

that Study Browser list. 

To return to the Study Browser at any time from the Image Viewer, click the Study Browser icon in the top right of 

the Image Viewer window, move the mouse cursor to the far left or right of the screen, or press the Spacebar (the 

default hotkey).  

Note: Users must select the Auto-show Study Browser checkbox in the Study Browser’s Options menu (under the 

Settings Menu) to access the Study Browser window by moving the mouse to the far left or right of the screen.  

Users can access Image Viewer options from menus, toolbars, and hotkey settings. The Image Viewer’s main menu 

is located in the top right corner of the window. Hotkey functions can be assigned to any of these menu functions. 

Users can access many functions from the Image Viewer’s four default toolbars (Main Toolbar, Quick Reference 

Toolbar, Annotation Toolbar, and Window/Level Toolbar), or they can customize new toolbars. 

Note: Users can also access Menu items by assigning a hotkey to that function. Many of these hotkeys are available 

as default hotkeys.  
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• Quick Reference Toolbar—a toolbar that has options such as Choose Series and Series Layout for quick access. 

This toolbar is located to the far left of the Image Viewer window, vertically aligned on the page. However, it 

can be moved to any other toolbar location in the Image Viewer window. 

• Switch Between Workspaces button—drop-down list that displays a list of open studies with a checkmark by 

the currently open study. 

• Patient Name, Study Date, Time of Study, Anatomical Area window—provides study information. 

• Close Current Study button—closes the current study but keeps the Image Viewer open. 

• Main Toolbar—located at the top of the Image Viewer window with drop-down menus (Annotate, Study, Series, 

Image). 

• Default Hanging Protocol drop-down menu—contains options for the Image Viewer’s default Hanging Protocol 

settings. 

• Study Browser icon—users can click this button to restore the Study Browser window. 

• Image Viewer Menu—the main menu list in the Image Viewer that contains the Study, Series, Image, 

Navigation, Customize Toolbars, Tools, and Help menus. 

• Close Application button—closes the entire Diagnostic Viewer application. 

• Annotation Toolbar—contains annotation features. Usually located at the bottom of the Image Viewer window. 

• Window/Level Toolbar—contains Window/Level preset buttons for images. Usually located at the bottom of the 

Image Viewer window. 

Note: Users must activate the four Image Viewer toolbars to view them (Main Toolbar, Quick Reference Toolbar, 

Annotation Toolbar, and Window/Level Toolbar.) Users can add to or edit the Image Viewer toolbars according to 

preferences. New toolbars can also be created.  

 

 

 

 

 

9-2—HANGING PROTOCOL DROP-DOWN MENU 

The Hanging Protocol drop-down menu displays 

the name of the currently applied Hanging Protocol 

and offers five options users can choose from: Add 
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study description to current hanging-protocol (HP), 

Create new hanging-protocol for (Study 

Description), Save current layout, Create new 

layout from current layout, and HP (Available 

Hanging Protocol). 

ADD STUDY DESCRIPTION TO CURRENT HANGING PROTOCOL 

This option adds the Study Description (Anatomical Area) from the current study to the currently applied Hanging 

Protocol. In the future, the current Hanging Protocol is applied as the default Hanging Protocol for all studies with 

the added Study Description. If the user makes changes to the Layout in the Image Viewer prior to adding the Study 

Description, those changes are saved to the current Layout when the Study Description is added to the Hanging 

Protocol. 

CREATE NEW HANGING PROTOCOL FOR THE OPEN STUDY’S STUDY DESCRIPTION 

This option creates a new Hanging Protocol with the Study Description (Anatomical Area) from the current study 

added. In the future, the new Hanging Protocol is applied as the default Hanging Protocol for all studies with the 

added Study Description. The new Hanging Protocol is based on the Hanging Protocol that was applied when the 

option was selected and contains all of the same Layouts as the original Hanging Protocol. 

If the user makes changes to the Layout in the Image Viewer prior to selecting this option, those changes are saved 

to the current Layout in the new Hanging Protocol. The original Hanging Protocol is not modified. 

SAVE CURRENT LAYOUT 

Make any changes to the Layout in the Image Viewer and select Save Current Layout from the drop-down 

menu. All changes are saved to the current Layout in the current Hanging Protocol. If the user makes 

changes using the drag-and-drop images or the resize image box features, those changes are saved to the 

layout. However, filters will remain in their original placement. 

CREATE NEW LAYOUT FROM CURRENT LAYOUT 

This option allows users to add a new Layout to the current Hanging Protocol directly from the Image 

Viewer. The new Layout is based on the Layout that was applied when the option was selected. Select 

Create New Layout from Current Layout. With the new Layout applied, make any changes to the new 

Layout and select Save Current Layout. If users make changes to the original Layout in the Image Viewer 

prior to selecting the Create New Layout from Current Layout option, those changes are saved to the 

original Layout as well as the new Layout. 

APPLY AVAILABLE HANGING PROTOCOLS 

After the previous options, all Hanging Protocols available for the open study are listed on the drop-down menu. 

Selecting a Hanging Protocol from the list applies it to the current study. Although Hanging Protocols associated with 

a study description are generally set up with a particular type of study in mind, users can apply any Hanging 

Protocol to the current study that is associated with the same modality, regardless of study description. 
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9-3—CUSTOMIZING IMAGE VIEWER TOOLBARS 

Users can edit the functions on each of the Image Viewer’s toolbars, add new functions, and create new toolbars. 

1. Right-click any toolbar in the Image Viewer window and select Customize from the drop-down list. The Custom 

Toolbars page opens. 

2. Select a toolbar from the Select Toolbar drop-down list. 

3. Choose an option to the right of the Select Toolbar drop-down list: 

• New Toolbar—allows users to add a new toolbar 

• Edit Name—allows users to edit the toolbar name 

• Remove Toolbar—allows users to delete the toolbar 

ADDING TOOLBAR ITEMS 

1. Select the toolbar from the Select Toolbar drop-down list in the Custom Toolbars page. 

2. Select the desired feature from the Available Items list on the left side of the page. 

3. Click Add to add the feature to the Current Toolbar Items list. 

4. Click Save to save the change(s) and exit. 

REMOVING TOOLBAR ITEMS 

1. Select the toolbar from the Select Toolbar drop-down list in the Custom Toolbars page. 

2. Select the unwanted feature from the Current Toolbar Items list. 

3. Click Remove to remove the feature from the Current Toolbar items list. 

4. Click Save to save the change(s) and exit. 

REORDERING THE MENU 

Users can customize the Image Viewer toolbars by resetting the toolbar settings or reordering features. 

1. Select the toolbar from the Select Toolbar drop-down list in the Customize Toolbars page. 

2. Select the feature from the Current toolbar items list. 

3. Click Reset, Move Up, Move In, Move Out, or Move Down until the feature is in the desired location. 

4. Click Save to save the change(s) and exit. 

CUSTOMIZING TOOLBAR OPTIONS 

1. Click the Toolbar Options tab on the Custom Toolbars page. 

2. Select an option from the Button Layout drop-down list (Text Only, Image Only, and Image and Text). 

3. To change the toolbar layout, deselect the Auto Toolbar Layout checkbox. 
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4. In the Toolbar Layout field, select an option from the Image text relation drop-down list.  

5. To change the image and/or text size, deselect the Auto Size checkbox. 

6. In the Image/Text Size field, select an option from the Image size drop-down list (Normal or Large) and an 

option from the Text size drop-down list (Normal, Medium, or Large). 

7. Click OK to save and exit when finished. 

9-4—MOVING TOOLBARS 

Users can move each of the four default toolbars or any created toolbar to the top, bottom, or sides of the Image 

Viewer window.  

1. Right-click any toolbar in the Image Viewer window, and make sure the Lock Toolbars option is not checked in 

the drop-down list.  

2. Drag the toolbar by clicking the gray dots to the left of the buttons.  

3. Drop the toolbar in the new location.  

Toolbars can also be hidden from the Image Viewer window by right clicking any toolbar and deselecting the toolbar 

name in the drop-down list.  

9-5—LOCKING TOOLBARS 

Users can select Lock Toolbars to lock the toolbars so they cannot be dragged and dropped to a new location. The 

toolbars remain in their locations unless the user deselects the Lock Toolbars option.  

Right-click any toolbar in the Image Viewer window and select Lock Toolbars from the drop-down list.  

9-6—ACCESSING MENU OPTIONS 

The Menu list in the Image Viewer contains the Study, Series, Image, 

Navigation, Customize Toolbars, Tools, and Help menus. Chapters 10 

through 13 offer more details on the Image Viewer’s menu functions.  

 

 

 

9-7—IMAGE VIEWER ICON BUTTONS 

In the Image Viewer window, each image in a series or 

study displays with icons in the corner that users can access 

for different functions.  

 

A. Return to Study Browser 
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B. Display Image in 3D icon—displays applicable images (CT, MR, PT, XA) in 3D, using Nova3D+ 

C. Scroll to the previous image with an annotation.  

D. Annotation icon – launches the Annotation menu, where users select which type of annotation to use. 

E. Scroll to the next image with an annotation.  

F. Choose Image Layout icon—opens the Choose Image Layout dialog box to allow users to choose how images are 

laid out in a series. 

G. Split Window Horizontally icon—splits the layout window horizontally into separate windows. 

H. Split Window Vertically icon—splits the layout window vertically into separate windows. 

I. Edit HP icon—opens the Edit Layout dialog box. 

J. Close Series icon—closes only the study or series currently open.  

Note: If there is only one series displayed, the Close Series icon is disabled. 

K. Maximize/Minimize Window Layout icon—maximizes or minimizes only the study or series currently open.  

L. Close Window Layout icon—closes the window layout from view in the Image Viewer window.  

9-8—DRAGGING AND DROPPING IMAGES 

In the Image Viewer window, users can drag and drop images into any series space on any monitor. This feature 

helps to facilitate comparison between images in different studies. Users can also drag the side of an Image Box to 

resize it. 

DRAGGING FROM IMAGE BOX 

 

 

 

 

 

1. Click and hold the top bar of the image display box of the image to be moved (where the Series ID number and 

Split Window Tools are). 

2. Drag it to any series space on any monitor. 

3. The image then displays in the selected image box. 

DRAGGING FROM CHOOSE SERIES THUMBNAIL 

1. Access the Choose Series thumbnail box by clicking Menu → Study → Choose Series or by launching it from 

the quick access toolbar. 

2. Hover the cursor over the thumbnail of the 

image to be moved. 
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3. Click and drag it to any series space on any 

monitor. 

4. The image then displays in the selected 

image box. 

DRAGGING IMAGES WITHIN A STUDY 

Images that are dragged and dropped to an empty series space within the same study moves to the new display 

location without any additional labeling or conditions. Only the visible image moves, not the entire series. 

Note: If an image is dragged and dropped to an image box that already contains a series, the entire series swaps 

display boxes with the other. 

PATIENT HISTORY SERIES CHOOSER 

The Patient History Series Chooser can be used to drag and drop series thumbnails into the image box without 

having to use the Study Browser. The Patient History Series Chooser contains all of the series thumbnails for both 

the primary and prior studies and is located at the bottom of the Image Viewer.  The Series Thumbnails are 

grouped by Study with the Study groupings displayed in order based on the study date.  

 

 

 

 

 

 

 

 

 

 

 

Users can toggle the Patient History Series Chooser On and Off by clicking the gear icon 

in the left-hand corner of the image viewer and selecting Patient History Mode.  

 

Study groups can be collapsed or expanded by clicking the [+] or [-] button in the top 

left corner of each group.  

 

There is a settings menu in the Patient History Series Chooser that 

users can access by clicking the blue gear icon on the right-hand 

side. 

Then users will have the option to filter the thumbnails they see 

using the Filters drop down.  

The Max Studies drop down lets users select the max number of studies they see and select the minimum visible 

thumbnails.  
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The Minimum Visible Thumbnails drop-down lets users configure how many thumbnails are visible when the study 

group is collapsed. 

DRAGGING IMAGES BETWEEN STUDIES 

To drag images to a display box in another study, both studies must be from the same patient. Images that are 

dragged and dropped to a display box in a different study continues to display in their original study. Only the 

visible image displays in the new study, not the entire series. Images moved from a comparison study to display in a 

new study retain all comparison labeling. The moved image continues to display in the new image box even if its 

original study is closed. Images moved to display in a new study are not saved in the new study or deleted from 

their original study. 

 

 

 

 

 

RESIZING IMAGES 

To resize an Image Box, hover the cursor over any side of the Image Box that is adjacent to another Image Box. A 

white, double-pointed arrow appears. Click and drag the side of the Image Box to the desired position. Both of the 

adjacent Image Boxes are resized. 

SAVING CHANGES 

Users can save changes made in the Image Viewer to the Layout with the Hanging Protocol drop-down list option 

Save Current Layout. All changes that alter image box size or shape are saved. Although content moves with an 

image box as it is dragged and dropped during viewing, those changes to content placement cannot be permanently 

saved as part of the permanent Layout. Content placement resets when the layout is reapplied. Content Filters 

cannot be dragged and dropped and remain in their original placement. To manage content placement in a 

permanent Layout, use the Filters options in the Manage Layout window. 

9-9—COPY TO CLIPBOARD 

Users can copy an image as it appears in the Image Viewer to the Window Clipboard to paste it onto an email, 

another document, etc. 

FROM THE RADIUS MENU 

Select a study that has the image to copy from the study browser.  

Click the image to copy. The selected image has a red border.  

Right-click to populate the Radius Menu. 

Search for Copy To Clipboard on the search menu.  
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Open the desired program and Paste the image by pressing CTRL + V. by 

right-clicking and selecting the Paste icon. 

The image is pasted without any PHI.  

FROM THE IMAGE MENU 

Select the study containing the desired image from the study browser.  

Click the image to be copied. The highlighted image has a red border.  

Select Menu. 

Hover the cursor over Image.  

Select Copy to clipboard. 

The image is copied to the clipboard and can be pasted into another 

document, application, etc. without any PHI.  
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CHAPTER 10—USING THE IMAGE VIEWER STUDY MENU 

The Image Viewer’s Study menu contains many functions to help users as they work with images. The Study menu is 

located on the Image Viewer’s Menu list.  

Note: The Image Viewer’s toolbars can be customized to 

contain frequently used functions from any menu to 

increase efficiency. Users can also add any options or 

functions to Image Context Menus for quick access in the 

Image Viewer.  

 

10-1—PATIENT HISTORY 

Patient History in the Image Viewer allows users to see all of the studies administered to that patient from all time 

periods and modalities. 

In addition, the Patient History 

window displays the Series, Images, 

and Report lists as independent lists, 

and users can drag/drop their lists to 

any location as they would in the 

Study Browser. 

Users must either manually open the 

Patient History window in the Image 

Viewer or choose to have the Patient 

History window automatically open 

when opening studies on the Options 

page.  

Manually 

1. Open a study in the Image Viewer.  

2. Click Menu, hover over Study, and select Patient History.  

The Patient History window opens.  

Automatically 

1. Click Settings in the Study Browser and select Options.  

2. Click the checkbox next to Show patient history when opening a study and click OK.  

3. Open any study and the Patient History window displays.  
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Editing the layout of the Patient History window.  

1. Once the Patient History window is open in the Image Viewer, users can make it any size by clicking and 

dragging a corner of the window.  

The NovaPACS Diagnostic Viewer automatically remembers the size and location of the user’s windows in the 

Image Viewer.  

2. As with the Study Browser, if the user clicks a list’s tab, the list can be dragged and dropped into any docking 

panel section.  

Lists can be dragged to the top, bottom, left, and right of any section.  

Lists can also be dropped into the center of a docking panel section, which adds the list as a tab to the right of an 

existing list.  

Optionally, users can drag lists into their own, 

independent lists.  

 

 

 

 

Note: If the user has configured their list display on 

one machine by dragging and dropping and then 

logs into another machine, they may need to 

separately configure that machine’s lists as well. 

Users should only need to do this once for each 

machine from which they access Novarad products. 

 

 

10-2—SELECT ALL IMAGES IN A 

STUDY 

Select All Series allows users to select 

all of the series in an active study. 

This is helpful when wanting to apply 

changes to multiple series at the 

same time.  

Click the Menu in the Image Viewer 

and select Study. Select Select All 

Images in a Study. 

Each series is now highlighted in red, 

showing they are active.  
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10-3—CLOSE STUDY 

Close Study allows users to close the active study while leaving the Image Viewer open. Click Menu in the Image 

Viewer and select Study. Select Close Study.  

Note: Users can also press the red X button next to the study 

and patient information in the Image Viewer to close the active 

study while leaving the Image Viewer open. 

 

10-4—CLOSE STUDY AND SHOW STUDY BROWSER 

Close Study and Show Study Browser allows users to close the active study and view the Study Browser window in 

front of the Image Viewer window. Click Menu in the Image Viewer and select Study. Select Close Study and Show 

Study Browser. 

Note: If other studies are open in other workspaces, they remain open. The Study Browser window still shows in front 

of the Image Viewer window.  

10-5—CLOSE WORKSPACE 

Close Workspace allows users to close the active workspace. Click Menu in the Image Viewer and select Study. 

Select Close Workspace. 

 Note: If other workspaces are open in the Image Viewer, they remain open.  

 

10-6—CLOSE ALL WORKSPACES 

Close All Workspaces allows users to close all of the workspaces open in the Image Viewer. Click Menu in the 

Image Viewer and select Study. Select Close All Workspaces. 

Users can also press the default hotkey CTRL + Shift + F4.  

10-7—CLOSE ALL WORKSPACES AND SHOW STUDY BROWSER 

Close All Workspaces and Show Study Browser allows users to close all open workspaces in the Image Viewer and 

view the Study Browser window. Click Menu in the Image Viewer and select Study. Select Close All Workspaces and 

Show Study Browser. 

Users can also press the default hotkey the Spacebar.  

10-8—MARK REVIEWED, CLOSE WORKSPACE, AND SHOW STUDY BROWSER 

Mark Reviewed, Close Workspace, and Show Study Browser allows users to mark a study Reviewed when closing it 

and view the Study Browser window.  
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Note: If the Prompt before marking a study reviewed option or Prompt before marking a study reviewed if it has not 

been completely reviewed option is selected, a dialog box appears asking the user to confirm they want to mark the 

study Reviewed. If other studies are open in other workspaces, they remain open. The Study Browser window appears 

in front of the Image Viewer window.  

Click Menu in the Image Viewer and select a Study. Select Mark Reviewed, Close Workspace, and Show Study 

Browser. 

10-9—MANAGE HANGING PROTOCOLS 

Navigate to Menu → Study → Presentation → Manage Hanging Protocols. The Manage Hanging Protocols editor 

dialog box opens. 

ADD NEW HANGING PROTOCOL 

Click Add New at the bottom of the Study Types list. The Manage Hanging Protocol editor now allows users to 

select options for the new Hanging Protocol. 

1. Select Modality 

First, select a modality from the Modality drop-down list. This is the modality with which the new Hanging Protocol 

is associated. A modality must be selected in order to save a new Hanging Protocol.  

2. Manage Study Descriptions 

Next, manage any Study Descriptions to be associated with the new Hanging Protocol. A Hanging Protocol is 

applied automatically to any study that matches all of its Study Descriptions. Adding Study Descriptions also helps 

users distinguish what types of studies the Hanging Protocol was set up to display. 

To add a Study Description click Add to the right of the Study Descriptions list. A small text box appears inside the 

Study Descriptions list. Type in an anatomical area to be associated with the new Hanging Protocol. Repeat as 

many Study Descriptions as needed. A unique Study Description (or combination of Study Descriptions) must be 

added in order to save a new Hanging Protocol associated with the same modality as an existing Hanging Protocol.  

To edit an existing Study Description, highlight the description and click Edit to the right of the Study Descriptions 

list.  

To delete an existing Study Description, highlight the description and click Remove to the right of the Study 

Descriptions list. 

3. Select a Display Tool Option 

Select an option from the Display Tool 

drop-down list to specify how to display 

the Hanging Protocol. 

4. Select a Spine Labeling Default 

Select an option from the Spine Labeling Defaults drop-down list to specify how to configure spine labeling for the 

new Hanging Protocol.  
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Select Edit Options to the right of the Spine Labeling Defaults 

drop-down list to customize the available spine labeling options. 

The Spine Labeling Options editor allows users to add, edit, and 

remove spine labeling options. Users can also customize font and 

font color for spine labeling options. 

 

 

 

 

MANAGE LAYOUTS 

Users can add, edit, remove, and duplicate layouts within a Hanging Protocol using the Presentation Groups 

(layouts) section of the Manage Hanging Protocol editor. 

To add a new Layout to a Hanging Protocol, click Add New at the bottom of the Study Types list. The Manage 

Hanging Protocol editor allows users to select options for the new Hanging Protocol Layout.  

1. Add Layout 

Click Create layout to the top right of the layouts section. The system adds a new, blank Layout. 

2. Edit Layout 

Click Edit Layout to the top right of the layouts section or double click the thumbnail image of a layout. The Edit 

Layout window opens. 

 

Editing Series Layout 

There are three primary ways to edit the Series Layout. 

1. Click the box with green grid lines located above the image boxes. 

 

 

 

The Choose Series Layout box opens. 

Select how to display the series by hovering the cursor vertically and 

horizontally over the squares and clicking when the preferred layout is 

highlighted light gray.  
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2. Or click Split Window Tools located in the top bar of an image box to 

edit the image layout within that image box or to split the series 

horizontally or vertically.  

3. Or click the red X at the top of an image box to remove that window 

from the series layout. 

 

 

 

Using the Imagebox (Series) Tab 

First, select the Image Box to be edited. This enables the Imagebox 

(Series) tab and allows users to choose image layout options for the 

selected portion of the layout.  

 

On the Imagebox (Series) tab, users 

can edit the View, Image Layout, 

and Clip Playback.  

 

 

Tiled 

The images in the series can be set to be in a 

Tiled display. This is the default view. 

 

When the Tiled option is selected, users can do the following: 

1. Use the Choose Image Layout box to select how images display within the series. Hover the cursor vertically 

and horizontally over the squares and click when the preferred layout is highlighted light gray. 

2. Zoom To Fit, To Fill, Custom, or No Zoom.  

3. Adjust the Frame rate, which controls the playback speed.  

4. Select the Auto-start and Use DICOM Frame Rate checkboxes.  

5. Select Looping, Sweeping, or Stop for Playback Sequencing. 

Cine 

The images in a series can be set to a Cine display. Cine is typically used for Cardiology images.  

When the Cine option is selected, users can do the following: 

1. Set the Desired Frame Rate, which controls the playback speed.  

2. Select the Auto-Start checkbox, which begins to play the clip as soon as the image loads.  

3. Select the Use DICOM Frame Rate checkbox.  
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4. Set the Playback Sequencing to Looping, Sweeping, or Stop 

 

Processed By 

The images in a series can be set to be 

processed by either MPR or by Image Fusion. 

Select Processed by from the drop-down list after 

selecting the Processed View. 

 

If users select the Processed by MPR option, the series automatically displays in a Multi-Planar Reconstruction 

(MPR) view. This view reconstructs multiple 2D images into a multi-planar 3D view. Novarad provides MIP/MPR 

functionality and support with NovaPACS.  

Note: If the system has not been used with the Diagnostic Viewer’s MIP/MPR support, an administrator must contact 

Novarad Support to configure each workstation to access MIP/MPR.  

If Processed by Image Fusion is selected, two series from 

different modalities (typically CT and PET) fuse for a more 

detailed image.  

Using the Filters Tab  

Select the Image Box to edit. This enables the Filters tab and 

allows users to choose Content Filter options for the selected 

portion of the layout.  

Users can edit options for the Filters tab in the Edit Layout 

window. The Filters tab allows users to Add, Edit, and Remove 

Content Filters that manage which files display in individual 

Image Boxes. 

 

Adding Content Filters 

Click Add to the right of the Content Filters list. This enables the Edit Filter box. 

Editing Content Filters 

Add a new filter or select an existing filter from the Content Filters list and click Edit. The Edit Filter options allow 

users to Filter by Attribute Presence or Filter by Image Plane. 



 

Page 113 of 169   

 

NovaPACS User Manual 

1. To Filter by Attribute Presence, select the checkbox 

next to the option’s title. This enables the rest of the 

options associated with this filter. Select whether to 

include content if the attribute is present or absent. Select 

the Attribute to filter by from the drop-down list. The VR 

value is entered automatically. Click Apply. New filters 

now appear in the Content Filters list. 

Note: The Image Details window displays all available 

attributes and their values for a selected image. Users can refer to this window if they have difficulty setting up 

filters.  

 

2. To Filter by Attribute Value select the Attribute to filter by from the drop-down list. This enables the rest of the 

options associated with this filter. The VR value is entered automatically. 

Note: Do not select the Filter by Attribute Presence checkbox when filtering by Attribute Value. 

Select the desired Operation from the drop-down list. The operation specifies the relationship between the Attribute 

and the Value. Select the desired Value from the drop-down list (or type it). Click Apply. The new filter now appears 

in the Content Filters list. 

3. To Filter by Image Plane, select the checkbox next to the option’s title. This enables the rest of the options 

associated with this filter. Select whether to include content that is a Member of or Not a Member of an image 

plane from the Operation drop-down list. Select the Image Plane to filter by from the Value drop-down list. 

Click Apply. New filters now appear in the Content Filters list. 

Note: Not all images are associated with an Image Plane. If an image plane is associated with an image the data is 

stored in the image’s Series Description. Users can view an image’s Series Description from the Series List on the 

Study Browser. 

Users can also view an image’s Series 

Description from the Image Details window. 

 

 

4. Users may also select whether they would like the 

rest of a series or other content that is associated 

with a filtered image but does not meet filter 

requirements to be displayed in the same Image 

Box. 
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Deleting Content Filters 

Select an existing Content Filter from the Content Filters list and click Remove. 

Display Multiframes as Series 

To view multiframe images as their own series for a specific modality, open Manage Hanging Protocols inside the 

Image Viewer. Either select a pre-existing hanging protocol or create a new hanging protocol. Check the checkbox 

marked Display Multiframes as Series.  

 

When finished editing a layout, click OK or Cancel to close the Edit Layout window and return to the Manage 

Hanging Protocols editor.  

3. Remove Layout 

Select the layout’s thumbnail image from the Manage Hanging Protocols editor and click Remove layout. The 

selected layout is deleted from the current Hanging Protocol. 

4. Duplicate Layout 

Select the layout’s thumbnail image from the Manage Hanging Protocols editor and click Duplicate layout. The 

selected layout is duplicated in the current Hanging Protocol. 

EDIT HANGING PROTOCOL 

Click an existing Hanging Protocol’s description in the Study Types list. The Manage Hanging Protocols editor allows 

users to make changes to any options described in the previous sections. 

REMOVE HANGING PROTOCOL 

Select an existing Hanging Protocol’s description and click Remove below the Study Types list.  

When finished managing Hanging Protocols, click Close to exit the Manage Hanging Protocols editor and return to 

the Image Viewer. 

10-10—ADD SPLIT 

Add Split allows users to split the Image Viewer’s viewing area in half. The new viewing space opens to the right of 

the current study. If the user has more than one study open from a patient (open in tabs at the top of the Image 

Viewer window), the new viewing space automatically populates the second study. Users can also click and drag an 

open image into the new window.  

Click Menu in the Image Viewer and select Study. Select Add Split. 

10-11—CHOOSE SERIES 

Choose Series allows users to see all the series in the current study in a thumbnail view list. Users can select other 

series to view from this list.  
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Click Menu in the Image Viewer and select Study. Select Choose Series. 

The Choose Series list disappears from view after interacting with the Image Viewer unless the Stay Visible 

checkbox is selected at the top of the list. The Choose Series list can be moved anywhere in the viewing area by 

clicking and dragging it to a new location. Users can resize the Choose Series list box by hovering the cursor in the 

corner of the box until the cursor becomes a double-ended arrow and then clicking and dragging to the desired 

size.  

1. Drag the thumbnail image from the Choose Series list into the series window. 

2. Select an image window in the viewing area. It highlights red. Double-click the thumbnail image from the 

Choose Series list and it opens in that selected image window.  

10-12—CHOOSE SERIES BOX DOCKING 

The Choose Series box in the Image Viewer enables users to quickly open a study’s individual series—by clicking the 

preview thumbnails or dragging and dropping. Users can dock their Choose Series box so it is in the most 

convenient location while viewing a study’s images. Users can dock the Choose Series box to the top, bottom, left, or 

right of the Image Viewer window.  

1. Click Menu → Study → Choose Series in the Image Viewer.  

Note: If users dock the Choose Series box or select the Stay Visible option, they do not need to select the Choose 

Series box option again. It opens and displays automatically for all studies.  

2. Click the gear icon in the top, right-hand corner of the Choose Series 

box. Select the option to Dock Left, Dock Right, Dock Top, or Dock 

Bottom to dock the Choose Series box.  

 

 

 

 

Once docked, users can choose to Undock or select a new docking option at any 

time. 

All studies, series, images and toolbars display in the Image Viewer along with 

the docked Choose Series box.  
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3. If users open a current and comparison study 

together, each study’s Choose Series box displays 

with its respective study. Each Choose Series box 

can be independently docked/undocked.  

 

Note: If users undock the Choose Series box, the option to 

Stay Visible is available when they click the gear icon. If the 

Choose Series box is docked, the Undock option is available 

when users click the gear icon. 

 

 

 

 

10-13—AUTO SYNC 

Auto Sync allows users to set images to 

synchronize as they are scrolled (in 

coplanar series). If the Auto Sync option is 

selected, it remains on for all subsequent 

studies until deselected. 

Click Menu in the Image Viewer and select 

Study. Select Auto Sync. Users can also 

press the default hotkey S.  

Scroll through synchronized images by 

either: 

1. Left-clicking an image and dragging the cursor up or down. 

2. Pressing the left or right arrow keys on the keyboard. 

The synchronized images in the other windows scroll in sync with the image. 

 

10-14—CROSS LOCALIZE 

Cross Localize allows users to view a line of intersection between two orthogonal images. A linear reference marker 

appears in all open series windows that correlate to the selected image. Images will still be cross-localized as the 

user scrolls through them. 

1. Select an image to Cross Localize. More than one series needs to be viewable in the Image Viewer window. 

2. Click Menu in the Image Viewer and select Study. Select Cross Localize. Users can also press the default hotkey 

X. 
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The linear reference marker appears in all visible series that correlate to the selected image.  

Users can adjust the angle of obliqueness when using Cross Localize lines in MPR or Fusion view. After enabling 

Cross Localize lines, there are rotational red dots on the ends of the lines. Click these dots and drag the line in any 

direction. This changes the oblique angle of the corresponding selected image. A small dot near the middle of the 

cross-localize line indicates the center of rotation in the oblique view.  

Note: When Radiologists activate the Cross Localize feature for a specific modality, the system remembers and saves 

whether the feature is turned on or off for that specific modality as a user preference. The state of Cross Localize is 

independently saved as a user preference for each modality. 

10-15—CROSS LOCALIZE 

Point Cross Localize allows users to select a point on an image, and the Image Viewer finds the intersecting images 

in all orthogonal series. The Auto Sync option must be activated to use Point Cross Localize.  

1. Select an image with which to use Point Cross Localize.  

2. Click Menu in the Image Viewer and select Study. Select Point Cross Localize.  

3. Right-click the specific point in the selected image. A bullseye symbol appears on that point; the same point is 

located in the other images in the Image Viewer window.  

10-16—SET SYNC 

Set Sync allows users to link series from different studies to a frame reference of choice. If the user wants to 

compare two separate studies side-by-side, they can choose the specific image in a series to start synchronization 

using Set Sync.  

The Set Sync option enables Auto Sync. After Set Sync is set, the Image Viewer synchronizes the image slices as the 

user scrolls.  

Note: The Set Sync option affects how the two series synchronize with each other; the Auto Sync within each series 

remains the same.  

1. Open the comparative studies so the Image Viewer displays both.  

2. Scroll through the images in each series until the images you want to synchronize are both visible and selected 

(highlighted red).  

3. Click Menu in the Image Viewer and select Study. Select Set Sync. 

10-17—AGGREGATE 

Aggregate allows users to select images from various studies or series and display them in a single series window. 

The Aggregate series created is temporary and does not exist after the window closes.  

1. Open images from one or more series in the Image Viewer window.  

2. Click Menu in the Image Viewer and select Study. Select Aggregate. An empty Aggregate window opens.  
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3. Click the top bar of the series (where the Series ID number and Split Window Tools are). Hold CTRL while 

dragging and dropping the series into the Aggregate window. Users can select any number of series to drop into 

the Aggregate window.  

10-18—PRINT 

Print allows users to print images. Users can choose to print to a default printer or select another printer. This 

allows users to print to paper or film.  

SELECTING A PRINTER  

1. Click Menu in the Image Viewer and select Study. Select Print. The Print Wizard dialog box opens.  

Note: If the user is printing specific images, select the images before selecting the Print option (images highlight in red 

when selected). Otherwise, all images in the active study or series will print. 

2. Click Print using a DICOM printer I will select.  

3. Select an option under the Which images will be printed? section. Users can choose between printing all open 

images in the active series or study or printing selected images in the active series or study.  

4. Select an option for printing clips. Users can choose to print only the active frame or all frames.  

5. To print each series on a new page, select the Start each series on a new page checkbox.  

6. Click Next when finished. The Printer Options dialog box appears.  

7. Select a printer from the Printer drop-down list.  

Note: If the needed printer is not on the Printer drop-down list, contact an Administrator. Printers and their printing 

formats are configured by the Administrator, Novarad Support, and the printer’s vendor. 

8. Click the black Image Format window to select the 

format.  

9. Select format options from the drop-down lists and 

checkboxes.  

Note: The printer’s abilities and the vendor settings 

determine the printing formats.  

10. The options to print image and overlays are selected by 

default. Deselect the checkboxes if needed.  

11. Click Next. A final page opens. Users can click Back to 

make any changes or click Finish to print.  

 

PRINTING TO THE DEFAULT PRINTER 

1. Click Menu in the Image Viewer and select Study. Select Print. The Print Wizard dialog box opens.  

2. Select Print using my computer’s default printer.  
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3. Select an option under the Which images will be printed? section. Users can choose between printing all open 

images in the active series or study or printing selected images in the active series or study.  

4. Select an option for printing clips. Users can choose to print only the active frame or all frames.  

5. To print each series on a new page, select the Start each series on a new page checkbox.  

6. Click Next when finished. The Printer Options dialog box 

appears.  

7. Click the black Page Layout window to select the layout.  

8. Complete the Company Information section to have it printed 

at the top of each page.  

9. The options to print image labels and overlays are selected by 

default. Deselect the checkboxes if needed.  

10. Select a Zoom option (Fit or Fill).  

11.  Click Next. A final page opens. Users can click Back to make 

any changes or click Finish to print.  

 

10-19—ROUTE 

Route allows users to share images with other sites or 

locations. Images can be routed manually from a 

NovaPACS data source to a specified destination.  

 

1. To route a study series, click Menu in the Image 

Viewer and select Study. Select Route. The Add Route 

Queue for ____ dialog box opens. 

2. Choose the study, series, and/or image(s) to route by 

expanding the lists and clicking the corresponding 

checkboxes next to the items. If the checkbox next to the study is marked without expanding the list, all of the 

accompanying series and images route automatically.  

Note: Route rules can be configured in the Admin Console. If one series in a multi-modality study matches the route 

rule, the entire study routes (e.g., a mammography study can include images from multiple modalities like MG and 

US, and also non-image files such as Structured Reports).  

3. Choose a destination from the Destination drop-down list.  

Note: An Administrator must add the Destinations that appear in the drop-down list. If the needed 

destination isn’t on the list, talk to an Administrator.  

4. Set the routing priority for the image routing by clicking the up or down arrows next to the Priority field. 

Routing priorities range from 1-100, with 1 as the highest priority. The default routing Priority is 3.  

5. Click OK to route to the specified destination. 
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10-20—DOCUMENTS 

Documents allows users to see any documents associated with the patient file that were scanned into the RIS.  

Click Menu in the Image Viewer and select Study. Select Documents. 

10-21—EXAM REPORT 

Exam Report allows users to see the report associated with the patient file if one exists. Exam Reports are only 

available if the system is integrated with Nova RIS. 

Note: When reports are finalized in Nova RIS, a DICOM PDF report is sent to NovaPACS and is added to the study as 

a new series. If no matching NovaPACS study is found, a placeholder study is created for the report. Admins must 

locate this study in the NovaPACS Admin Console on the Studies tab and move the report series to the correct study 

manually. 

Click Menu in the Image Viewer and select Study. Select Exam Report.  

 

Note: PDF reports can be viewed but not edited. If authorized to do so, users can edit HTML reports.  

Note: When users sign and save reports in NovaPACS, the preliminary report displays in all report locations 

depending on configuration. Once the report is finalized in Nova RIS, a DICOM-encapsulated PDF report is sent to 

NovaPACS and added to the study. This DICOM PDF report displays in any location where users access reports. 

10-22—MANAGE REPORTS WORKFLOW 

Manage Reports Workflow allows users to see a list of reports and their statuses. This option is particularly useful 

for Radiologists, Residents, Administrators, and Transcriptionists.  

In the Report Workflow window, users see four main boxes for Dictated Reports, Unsigned Reports, Signed Reports, 

and Finalized Reports. In the Other section, users can see reports that have been marked Requires Correction and 

can look up physicians in the system using the Physician Lookup box.  

Click Menu in the Image Viewer and select Study. Select Manage Reports Workflow. 
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10-23—RIS INFORMATION 

RIS Information allows users to view the RIS Information dialog 

box for a study. The information included in the RIS 

Information box is submitted by the Admin, Receptionist, or 

Technologist in Nova RIS. RIS Information dialog boxes include 

patient information, referring physician information, order 

notes, and procedure information about a study.  

Open a study and click Menu → Study → RIS Information.  

The RIS Information dialog box opens.  

Note: Information contained on the RIS Information dialog box only 

displays if it has been added to a Nova RIS order form when 

scheduling. Referring physician contact information must be added to the referring physician record in Nova RIS 

before it displays on the RIS Information dialog box. 

10-24—DICTATE 

Dictate allows users to dictate a report for the selected study. The following sections describe dictation options for 

the NovaPACS Diagnostic Viewer.  

DICTATION TYPE 

The Dictate settings are set by Novarad in user preferences. The options available are: Basic, File, Dragon, and 

CMDLine (found on the Plug-Ins tab of the Options page, under the Study Browser’s Settings Menu). 

LAUNCH DICTATION  

Click Menu in the Image Viewer and 

select Study. Select Dictate.  

Users can also press the default hotkey 

D.  

 

Note: If a prior study is made active and dictation is launched, users receive a warning dialog box asking if they are 

sure they want to dictate the study.  

DICTATING AN ADDENDUM (REPORT EXISTS) 

A dialog box alerts users if there are existing dictations for the study. If the user dictates for a study that already 

has a report, it is added as a report addendum.  
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DICTATION MICROPHONE SETTINGS CHECK 

The Diagnostic Viewer checks the default microphone settings 

before starting dictation and notifies the user if the microphone is 

muted or the recording volume is too low. Users should make any 

needed adjustments before beginning dictation.  

Note: The Diagnostic Viewer only checks the microphone settings once per 

application session, not each time dictation launches.  

 

DICTATIONS WAITING TO BE UPLOADED 

The dictation dialog box also lists the number of dictations waiting to be uploaded, in the bottom right-hand corner 

of the dictation window.  

This helps notify radiologists that dictation files have been saved and are being automatically uploaded to Nova RIS 

through the Dictation Launcher service in the event that they are experiencing network or connection issues.  

FLUENCY DIRECT DICTATION INTEGRATION 

Fluency Direct allows users to insert patient and exam data into the diagnostic report using voice commands. These 

commands can be used in the Instant Dictation window or within a Standard Report. 

The commands insert the specified data at the current cursor position. 

Voice Command Syntax Details 

Fluency Direct recognizes specific voice commands enclosed in caret symbols (̂ ^). These commands allow radiologists 

to automatically insert patient and study data into the report. 

Syntax Rules 

• All commands must start with ^ and end with ̂. 

• Format: ̂Novarad[DataType]̂ 

• Say the full command clearly (e.g., “Novarad patient name”). 

• The system replaces the command with the actual data when recognized. 

Available Commands 

Voice Command Replaced With Example Output 

^NovaradModalitŷ Study Modality CT 
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Voice Command Replaced With Example Output 

^NovaradStudyDescription̂ Study Description CT Chest with Contrast 

^NovaradPatientAgê Patient Age 54 

^NovaradPatientNamê Patient Name John Smith 

^NovaradPatientGender̂ Patient Gender Male 

^NovaradPhysicianReason̂ Physician Reason Shortness of breath 

  

Usage Notes 

• Commands can be inserted anywhere in the dictation at the cursor location. 

• If the data does not exist for the current study, the command is typically left unchanged. 

• Pause briefly before and after saying a command for best recognition. 

• Commands work in both the Instant Dictation window and Standard Reports. 

INSERTING NOVA RIS STANDARD REPORTS  

When using Dragon dictation, the user can insert a RIS Standard Report at any point in the current dictation.  

TRANSCRIPTION BUTTONS  

The M*Modal Fluency Direct Function is mapped to actions in the Instant Transcription Window. The functions are 

as follows: 

  

• Launch Dictation “D” from Novarad Diagnostic Viewer 

• Record (hold microphone button or click the MIC/VU meter control in the Instant Transcription window) 

• Play  

• Pause 

• Skip Forward 

• Skip Backward 

• Save 

• Sign & Save 

 

The Instant Transcription Window’s size and position can be saved as a user preference. When dictating, move or 

resize the form, and when users close and reopen the form, the size and location will be saved. 
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CHANGING DICTATION FONT DISPLAY SIZE 

There is a font display slider bar in the Instant Transcription 

window when using Dragon or M*Modal dictation in the 

NovaPACS Diagnostic Viewer.  

1. Log into the PACS as a Radiologist, Resident, or 

Cardiologist, open a new study, and launch Dictation 

using the default hotkey D, or using a configured Speech 

mic/Nuance mic button. The Instant Transcription 

window opens.  

2. The font display slider bar appears just above the text 

display section.  

3. By moving the slider to the right, the font display size in 

the Instant Transcription text window increases; moving 

the slider to the left decreases the font display text size. 

Note: Altering the font display size in the Instant Transcription window does not affect the text display on any 

diagnostic report for the patient—diagnostic report text display is dependent upon the formatting used in the 

reporting system. 

10-25—LAUNCH MAMMO VIEWER 

Launch Mammo Viewer allows users to launch a mammo viewing tool used with NovaPACS for mammography 

viewing.  

1. Launch the Diagnostic Viewer and open an appropriate study (i.e., an MG or breast US study).  

2. Click Menu in the Image Viewer, select Study, then select Launch Mammo Viewer. The configured 

mammo viewer launches in a new window.  

3. When finished using the mammo viewer, users can return to the PACS by closing the window.  

Note: A mammo viewer software must be installed and configured on the workstation to use the Launch 

Mammo Viewer option. If it is not configured, the Launch Mammo Viewer option is not available on the 

Study Menu. Users can customize a hotkey or add a custom toolbar button to the Image Viewer or Study 

Browser to access this option.  

10-26—VIEW STUDY ON OTHER WORKSTATION 

View Study on Other Workstation allows users to send studies from the Diagnostic Viewer to another computer. 

Contact Technical Support for the required configuration for this option. Once this is configured, studies can be 

viewed and processed by another computer. This option is useful if users need to view studies on post-processing 

stations for MIP/MPR or 3D Reconstruction. 

Click Menu in the Image Viewer and select Study. Select View Study on Other Workstation.  



 

Page 125 of 169   

 

NovaPACS User Manual 

10-27—LAUNCH ORTHOPEDIC TOOLS 

Launch Orthopedic Tools allows use of the orthopedic template third-party software with Novarad’s Diagnostic 

Viewer. This optional software integration allows users to create a complete array of orthopedic pre- and post-

surgical planning and mapping tools including (but not limited to) Cobb Angles, templates, overlaying, and surgical 

repairs.  

1. Launch the Diagnostic Viewer and open an appropriate study.  

2. Click Menu in the Image Viewer, select Study, then select Launch Orthopedic Tools. The configured 

orthopedic tool launches in a new window.  

3. When finished using the orthopedic tools, users can return to the PACS by closing the window.  

Note: The product launched when using the Launch Orthopedic Tools option is dependent upon which software 

option is configured in the PACS Admin Console. If an orthopedic software tool is not configured, the Launch 

Orthopedic Tools option is unavailable on the Study Menu. Users can customize a hotkey or add a custom toolbar 

button to the Image Viewer or Study Browser to access this option.  

10-28—ASSIGN PASSWORD 

Assign Password allows users to assign a temporary Single-Study Access Password for a study, allowing a person (i.e. 

a Referring Physician or patient) to access that study through the Internet.  

1. Click the Study to be assigned Single-Study Access.  

2. Click Menu in the Image Viewer and select Study. Select Assign Password.  

3. The Assign Web Password to Selected Study dialog box appears. A randomly generated password is assigned 

automatically. Users can generate their own password by clicking the New Password link.  

4. Click the drop-down list next to Expiration Date to set the length of time the password is valid and click OK. 

10-29—NOTES 

Notes allows users to view notes that have been made for the selected study. The Notes option allows various 

Diagnostic Viewer users (technologists, radiologists, etc.) to communicate with each other about the study. The 

Notes option is not part of the patient’s medical record, does not print, and does not transfer to a patient disk.  

Click Menu in the Image Viewer and select Study. Select Notes. Users can also press the default hotkey N.  

 

10-30—COLLABORATION 

Collaboration allows multiple radiologists to work simultaneously from the same worklist without having duplicate 

readings. The Collaboration option also allows users to participate in peer-to-peer reviews of patient studies.  

Studies just coming into the NovaPACS system have a status of New or Imported, depending on the origin of the 

study. Studies with a New status are coming from modalities into the NovaPACS system. If users have an external 
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source for their studies, such as a long-term archive (LTA) or other DICOM source, studies imported and cataloged 

into the NovaPACS system have a status of Imported.  

The Collaboration options enable users to mark various statuses such as Verified, Checked Out, and Reviewed to 

manage studies in collaborative environments.  

CHECKOUT 

Checkout prevents multiple users from reviewing the same study simultaneously.  

Click Menu in the Image Viewer and select Study. Select Collaboration and select Checkout. 

The study displays Checked Out in the Status column of the Filtered Studies list in the Study Browser. The Current 

User column reflects the username of the person who checked the study out. The Checked-Out status for the study 

updates on all collaborating users’ lists. Other users may view a Checked-Out study but cannot mark it reviewed or 

use the Checkout function on it.  

UNDO CHECKOUT 

Undo Checkout allows users to undo the checkout process for a study. This function is helpful when the user checks 

out the wrong study or the user is unable to complete the review of a study after checkout. The Undo Checkout 

function cannot restore the status of a study if it has already been marked Reviewed. Users can only change a 

study with a Reviewed status using the Reset Status to New function (see section Reset Status to New below).  

Click Menu in the Image Viewer and select Study. Select Collaboration and click Undo.  

The study or series is restored to the status it had before checkout (i.e. New or Verified).  

VERIFIED 

Verified allows users to mark studies as verified, which means that all attached documents, images, etc., are 

checked and ready for review.  

Click Menu in the Image Viewer and select Study. Select Collaboration and click Verified. 

The study now has Verified in the Status column of the Filtered Studies list. The Current User column reflects the 

username of the person who verified the study. The Verified status for the study updates on all collaborating users’ 

lists.  

REVIEWED 

Reviewed allows users to mark a study as reviewed.  

Click Menu in the Image Viewer and select Study. Select Collaboration and click Reviewed. 

The study now displays Reviewed in the Status column of the Filtered Studies list in the Study Browser. The Current 

User column reflects the user name of the person who reviewed the study. The Reviewed status for the study 

updates on all collaborating users’ lists.  
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Note: The status of a study resets to its previous New or Verified status if the study is closed out without marking it 

Reviewed and the following options are marked in the Study Browser’s Settings menu under the General tab: 

• Auto-checkout studies when they are opened 

• Auto-review studies when they are closed 

• Prompt before marking a study reviewed 

RESET STATUS TO NEW 

Reset Status to New allows users to restore the status of a reviewed study back to New, so it can be reviewed 

again. 

Click Menu in the Image Viewer and select Study. Select Collaboration and click Reset Status to New. 

The study’s status changes from Reviewed to New in the Status column of the Filtered Studies list in the Study 

Browser. The username no longer appears in the Current User column.  

Note: The Reset Status to New function must be used within four hours of a study being marked Reviewed. To 

change the status of a study after four hours, contact Novarad Support.  

PEER REVIEW 

Peer Review allows Radiologists to evaluate each other’s reviewed studies, give second opinions, and provide quality 

assurance. Any Radiologist involved in the review process can view a completed Peer Review.  

1. Click Menu in the Image Viewer and select Study. Select Collaboration and click Peer Review. The Peer Review 

dialog box appears. 

2. Click an option for the Position field.  

3. Enter any comments needed in the Comment field box and click OK.  

Note: Peer Review reports are available to NovaPACS Administrators in the Admin Console. The Administrator can 

choose to report an average rate of missed diagnoses over a given time period.  

 

UTILIZATION REVIEW 

Utilization Review allows Radiologists to review film to provide quality assurance.  

1. Click Menu in the Image Viewer and select Study. Select Collaboration and click Utilization Review. The 

Utilization Information for Reviewed Study dialog box appears. 

2. Select the applicable position from the Utilization Heading Position field drop-down list. 

3. Enter any comments needed in the Comment field box and click OK.  

10-31 TEACHING FILE 

Teaching File allows users to create anonymized Teaching Files based on existing studies in NovaPACS. These 

anonymized files do not contain personal identifiers but maintain the layout and structure of the original studies, 
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and all previously made annotations are preserved when the new file is created. Once a Teaching File has been 

created, the new file is completely independent of the original study, and unique patient IDs are generated to 

prevent Teaching Files from being associated with original studies.  

Note: Users can only create Teaching Files by enabling Teaching Files in the Options tab.  

 

For this option to function correctly, users must first select individual images to 

add to the new Teaching File. Select the Teaching File icon to add individual 

images from a study to a new Teaching File.  

When users select this icon, images are added to a Teaching File series window where users can review the images 

added to the file.  

Note: Individual images in comparison studies cannot be added to Teaching Files. To create Teaching Files of images 

in a comparison study, close the study and reopen it as the primary study.  

After reviewing the images in the viewing window, users can decide to remove images from the Teaching File. To do 

this, navigate back to the Image Viewer and select the Teaching File icon. Images are then removed from the 

Teaching File Images window.  

After selecting images, navigate to the Study drop-down menu and select Teaching File. The Teaching File 

Information dialog box appears, allowing users to enter study and patient information.  

Users can also access the Teaching File Information dialog directly after selecting individual images by hitting their 

spacebar and exiting the study. The dialog appears automatically.  

 

 

 

 

When users create Teaching Files by selecting images 

individually, the dialog box allows them to click Include 

Selection From Study or Include Entire Study. Include 

Selection From Study will create the file from only the files 

that were selected. Include Entire Study creates the file 

from all of the images in the study. 

Mark as in Progress allows users to select some images 

without creating the teaching file. They can come back to 

that study at any time, finish selecting images, and then 

create the teaching file.  

Note: Teaching Files originally created from an entire study do not provide users with the option to only include 

selected images in a Teaching File.  
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10-32—RESEARCH 

Research allows users to look in the GlobalRad database for cases that have similar anatomical/pathological 

findings. This can help with more accurate diagnoses and more efficient research.  

Once activated, the Research option launches GlobalRad—a database of studies from around the world that have 

been made anonymously, complete with clinical findings, diagnoses, etc. Novarad users can sign up for a GlobalRad 

account and submit studies using the Upload to GlobalRad option. GlobalRad preserves anonymity of patient 

information as it is submitted. For any assistance in this process, please contact Novarad Support. 

Click Menu in the Image Viewer and select Study. Select Research.  

10-33—UPLOAD TO GLOBALRAD 

Upload to GlobalRad allows users to upload all selected images in the active study to GlobalRad—a database of 

studies that have been made anonymous for research purposes.  

Click Menu in the Image Viewer and select Study. Select Upload to GlobalRad.  

10-34—SAVE VIEW SETTINGS 

Save View Settings allows users to save the view-related changes (W/L, Zoom, Pan, etc.) that were made while 

viewing the active study/series. If the user does not select Save View Settings, the Diagnostic Viewer does not save 

any view-related changes.  

Click Menu in the Image Viewer and select Study. Select Save View Settings.  

10-35—SHOW ALL SERIES 

Show All Series allows users to view all of the series for the current patient in the Image Viewer window.  

Click Menu in the Image Viewer and select Study. Select Show All Series.  

10-36—SERIES LAYOUT 

Series Layout allows users to alter the series layout for the active series using a Choose Series Layout window.  

1. Click Study in the Image Viewer. Select Series Layout.  

2. Choose how to display the series by hovering the cursor vertically and horizontally over the squares and clicking 

when the preferred layout is highlighted in light gray. 

10-37—HANGING PROTOCOL LAYOUTS 

Hanging Protocol Layouts can be applied to a study from the Image Viewer in a number of ways.  

• Apply Next Layout allows users to iterate to the next available Layout for the current Hanging Protocol. 

Navigate to Menu → Study → Apply Next Layout. Users may also set up a hotkey for this option. Using Apply 

Next Layout allows users to navigate sequentially through Layouts until they reach the last available Layout for 

the current Hanging Protocol. This option does not allow users to cycle back to the beginning. 
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• Apply Previous Layout allows users to navigate to the previous Layout for the current Hanging Protocol. 

Navigate to Menu → Study → Apply Previous Layout. Users may also set up a hotkey for this option. Using 

Apply Previous Layout allows users to navigate backwards through Layouts until they reach the first available 

Layout for the current Hanging Protocol. This option does not allow users to cycle back to the end. 

• Hanging Protocol Layouts allows users to apply a preset Hanging Protocol Layouts layout to the active 

study/series. It also allows users to open the Hanging Protocol Layouts window to preview the set Hanging 

Protocol Layouts for that modality before choosing to apply one.  

a) Click Study in the Image Viewer. Select Hanging Protocol Layouts. A drop-down list opens.  

b) Select View Hanging Protocol Layouts to preview the existing Hanging Protocol Layouts for the 

modality and select the thumbnail image to apply to the active study.  

OR 

a) Select a Hanging Protocol Layout from the drop-down list to apply it to the active study. These 

numbered Hanging Protocols correspond with the available Layouts in the current Hanging Protocol as 

well as the number keys on the keyboard (i.e. Hanging Protocol 1 corresponds with the first available 

Layout in the current Hanging Protocol as well as the number one on the keyboard). Press a number 

key on the keyboard to quickly apply its associated layout. 

Note: These numbers are configurable in the Study Browser’s Options, under the Keyboard Shortcuts tab.  

10-39—MINIMIZE 

Minimize allows users to minimize the Image Viewer window.  

Click Study in the Image Viewer. Select Minimize.  

10-40—EXIT 

Exit allows users to exit and close the entire Diagnostic Viewer. If users have selected the Prompt before closing the 

application option from the Study Browser’s Options list, a prompt appears when selecting Exit.  

Note: Closing the Diagnostic Viewer using the Exit option closes studies properly and saves all changes to patient 

images. Use this exit option or the Study Browser’s exit application to ensure proper study closing and saving.  

Click Study in the Image Viewer. Select Exit.  
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CHAPTER 11—USING THE IMAGE VIEWER SERIES MENU 

The Image Viewer’s Series Menu contains many functions to help users as they examine and mark findings in a 

series. The Series menu is located on the Image Viewer’s Menu.  

Note: The Image Viewer toolbars can be customized to contain frequently used functions from any menu to increase 

efficiency. Users can also add any options or functions to Image Context Menus for quick access in the Image Viewer.  

11-1—SELECT ALL IMAGES 

Select All Images allows users to select all images in the active series. This option is helpful if users want to make 

changes to all the images in a series at the same time.  

Click Menu in the Image Viewer and select Series. Click Select All Images. Users can also press the default hotkey 

CTRL + A.  

11-2—CLOSE 

Close allows users to close the active series. All other open series remain open.  

Click Menu in the Image Viewer and select Series. Select Close.  

11-3—VIEWS 

Views allows users to change views on the active study. 

TILED 

The Tiled view is the default view that presents the series with the images and clips in a tiled format. The clips in 

the Tiled view each have their own controllers and play independently of each other.   

Note: Users can pause and/or scroll through the frames of a Cine clip in a Tiled Layout.  

Click Menu in the Image Viewer and select Series. Select the Views drop-down list and select Tiled.  

CINE 

The cine view displays all of the images in a series in a played format, including the first frame of each image.  

Note: If clips are opened using a cine view, users see a message stating that the cine view is used to cine a series of 

images and that the Tiled view can play clips. Users are encouraged to switch to a Tiled view.  
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Click Menu in the Image Viewer and select Series. Select the Views drop-

down list and select Cine. 

To adjust the Cine or Clip Frame Rate: 

1. Click the frame rate number found on the cine or clip controller bar. 

A slider bar appears.  

2. Use the slider bar to adjust the frame rate. Moving the slider down 

decreases the frame rate. Moving the slider up increases the frame 

rate. 

MPR VIEW 

The MPR (Multi-Planar Reconstruction) view reconstructs an axial plane into sagittal and coronal planes to provide 

more comprehensive views of images.  

Note: Novarad provides MIP/MPR integration and support. If the system is not configured to use the Diagnostic 

Viewer with MIP/MPR, an administrator should contact Novarad Support for assistance configuring the workstation to 

access MIP/MPR. MIP is Maximum Intensity Projection.  

Click Menu in the Image Viewer and select Series. Select the Views drop-down list and click MPR.  

There are four MPR views. Three of the views display a specific orientation (axial, coronal, or sagittal). The fourth 

view has several buttons that, when used, modify the view or the functionality of the left mouse button. 

Users can quickly change/reset the fourth MPR view by clicking an orientation button (axial, sagittal, or coronal).  

The following list contains a few of the MIP/MPR options:  

• Rapid scroll through the series by left clicking and dragging the mouse.  

• Change the slice (slab) thickness by scrolling the mouse wheel.  

• Change Window/Level by right-clicking and dragging the mouse.  

• Zoom by pressing and holding both the left-mouse and right-mouse buttons and dragging.  

• Right-click to bring up an MPR Image Context Menu.  

• Capture Series allows users to set the parameters for the capture. The capture starts at the green line and 

ends at the red. Drag those lines around the image for a more precise capture. Users can also change the 

desired slice spacing.  

Users also have the ability to create an Angle Measurement in the MPR View. To create this annotation, follow the 

steps below: 

1. Click Menu. 

2. Under the Annotations option, click Measure Angle. 

3. Draw the lines start to end by clicking the right-mouse button and dragging. 

4. Users can drag the end points to adjust the angles.  
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The system will compute by matching the two start points and measuring the angle between the endpoints.  

IMAGE FUSION 

The Image Fusion view displays CT and PET images together, along with a row of images with fused (overlaid) CT 

and PET images.  

Note: Image Fusion requires a separate download that an administrator should run before launching the Diagnostic 

Viewer. This is a one-time download per computer.  

1. Open a study with more than one series 

2. Click Menu in the Image Viewer and select Series. Select the Views drop-down list and select Image Fusion. The 

Select Series for Fusion dialog box appears.  

3. Select the two series to fuse. Both series selected need to have the same number of images.  

In the Image Viewer, the fused PET/CT series 

shows in three rows. The first two rows display 

the PET and CT series, and the third row displays 

the fused series.  

Right-click and the Image Context menu appears 

with options including Colorize, Measure Line, 

and Capture Image.  

Note: Users can individually customize the W/L values 

of the images in each row. If users modify the W/L 

values of the fused images, the Diagnostic Viewer 

revises both the CT version in the first row and the PET 

version in the middle row. If users alter W/L values of just the second row of the PET version of the images, the fused 

images on the bottom row only adjusts the PET portion. 

To configure the mouse controls to navigate through the PET study more efficiently, see section 7-1 Options for more 

information.  

SUV MEASUREMENTS WITH IMAGE FUSION 

Users can now make SUV (standardized uptake value) measurements with Image Fusion in NovaPACS. 

1. Launch the Diagnostic Viewer and open a study to measure in the Image Viewer.  

2. Click Menu in the Image Viewer, select Series, and select Views.  

3. Select Image Fusion from the drop-down list. The Select Series for Fusion dialog box appears. 

4. Select two series to fuse.  

5. Once the Image Fusion series is opened, right-click an image to measure.  

6. Select Sphere VOI (volume-of-interest) from the drop-down list.  
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7. Right-click the image and complete the 

measurement. When the mouse is released, the 

SUV measurements display on the image.  

8. To save the measurements, right-click the image 

and select Capture Image from the drop-down list. 

This creates a Fusion Captures series.  

Note: The Viewer will display SUV values when users 

Window/Level a PET image. The lower image bound 

will not go below zero when window/leveling PET 

images to avoid washing out the image. 

 

 

11-4—SPLIT HORIZONTAL 

Split Horizontal allows users to split the active window in the Image Viewer horizontally. The next series in 

succession appears in the new window when it is split.  

Click Menu in the Image Viewer and select Series. Select Split Horizontal. Users can also click the Split Horizontal 

icon in the upper right corner of each active window.  

11-5—SPLIT VERTICAL 

Split Vertical allows users to split the active window in the Image Viewer vertically. The next series in succession 

appears in the new window when it is split.  

Click Menu in the Image Viewer and select Series. Select Split Vertical. Users can also click the Split Vertical icon in 

the upper right corner of each active window.  

11-6—CHOOSE IMAGE LAYOUT  

Choose Image Layout allows users to choose how the images in a series are arranged. 

Click Menu in the Image Viewer and select Series. Select Choose Image Layout. Users can also click the Choose 

Image Layout icon in the upper right corner of each active window. 

The Choose Image Layout dialog box opens. Select how to display images by moving the cursor vertically and 

horizontally over the squares and clicking when the preferred layout is highlighted light gray. 

11-7—CALCIUM SCORING 

Calcium Scoring allows users to examine CT studies for calcium buildup in the coronary arteries. Normally, the 

coronary arteries do not contain calcium. Calcium in the coronary arteries is a sign of Coronary Artery Disease 

(CAD). Cardiac Calcium Scoring, or coronary artery calcium scoring, uses CT studies to check for the buildup of 

calcium in the coronary arteries to detect early stages and severity of heart disease.  
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1. Open a CT study in the Image Viewer.  

2. Click Menu in the Image Viewer and 

select Series. Select Calcium Scoring. 

The Calcium Scoring dialog box 

appears.  

3. Select an Artery Button in the 

Calcium Scoring dialog box: 

LM: Left Main 

LCX: Left Circumflex 

LAD: Left Anterior Descending 

DIAG: Diagonal 

RCA: Right Coronary 

PDA: Posterior Descending 

Other: Other  

4. Complete the Calcium Scoring annotation on the image for each artery to measure.  

5. When the Calcium Scoring annotation is complete, click Create Report to create a web page report.  

Note: This web page report does not save in the Diagnostic Viewer or Nova RIS. 

11-8—SORT IMAGES  

Sort Images allows users to change the sort order of the images in a series. The default sort order is sort By Image 

Number Ascending.  

Click Menu in the Image Viewer and select Series. Select the Sort Images drop-down list, and choose a sort option:  

• By Image Number Ascending—sorts the images numerically starting from the first image.  

• By Image Number Descending—sorts the images numerically starting from the last image.  

• By Slice Location Ascending—sorts the images by slice location starting from the last slice taken.  

• By Slice Location Descending—sorts the images by slice location starting from the first slice taken.  

11-9—COLORIZE 

Colorize allows users to identify areas of interest in radiology images using colorization. This helps radiologists to 

spot or validate areas of interest in images by converting grey scale intensity to colors.  

1. Open a study in the Image Viewer. Colorization works best on studies with a lot of detail.  

2. Click Menu in the Image Viewer and select Series. Select the Colorize drop-down list and choose a color.  
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11-10—CREATE NEW VIEW 

Create New View allows users to open a second view of the active series in a new series window. This option is 

useful when comparing different images within a series or comparing the same image with different window/level 

values. 

Click Menu in the Image Viewer and select Series. Select Create New View. 

To see the new view, scroll to the next image or use the Split Window tools to split the series window horizontally or 

vertically to see the image and the new view together. 

11-11—SUBTRACT 

Subtract allows users to subtract the pixels of the selected image from all other images in the series. When 

subtracting is complete, the series shows the pixels from all other images in the series.  

Cardiologists can subtract an angio study (XA) and see the contrast through the veins once the image with bones 

and soft tissue is subtracted from the series.  

Note: The Subtract option is available to Cardiologists only.  

Click Menu in the Image Viewer and select Series. Select Subtract.  
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11-12—ADVANCED ANALYSIS 

Using the Advanced Analysis option, users can generate the 

maximum and minimum slope for each image slice over 

time. This is an important feature for Radiologists because it 

allows them to see the areas with the steepest rate of 

change (maximum) or the slowest rate of change (minimum). 

Being able to quickly see the rate of change is helpful in a lot 

of cases, including but not limited to: 

 

 

 

 

 

 

 

Maximum Slope:  

• Differentiating between malignant and 

benign tumors. 

• Mapping brain functions during cognitive or 

motor tasks. 

• Detecting areas of impaired blood flow in 

the heart. 

• Identifying areas of acute ischemia 

 

Minimum Slope: 

• Identifying stable, non-reactive tissue such 

as scar tissue or chronic lesions. 

• Indicates regions with poor blood flow or low 

perfusion, which is common in areas 

suffering from chronic ischemia or vascular 

disease.  

• Diagnosing neurodegenerative diseases. 

• Assessing stable vascular abnormalities such 

as an aneurysm or arterial stenosis. 

To calculate the Maximum or Minimum slope: 

1. Open the desired study.  

2. Click Menu in the Image Viewer. 

3. Navigate to Series. 

4. Click Advanced Analysis from the side menu that appears.  

The Advanced Analysis window will appear.  

5. Select the desired operation.  

6. Click OK.  
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Users can also subtract Images from the series with this feature.  

Subtract Options: 

In the Advanced Analysis window, users can also subtract images from the image series. Subtracting an image will 

create a transparent image overlay. This is helpful because it allows users to isolate and highlight the differences 

between two images, making it easier to detect subtle changes or abnormalities over time. This process can help 

identify tumors, inflammation, or vascular changes by removing static elements and emphasizing areas of contrast 

enhancement or other dynamic tissue alterations.  

A. Subtract selected image from the others in the series: 

Choosing this option will subtract the currently selected image from the series and create a 

transparent overlay that can be used to compare images.  

B. Subtract images of the selected time from the others in the series by slice location: 

This option will allow users to select a group of images by their time distinction and subject from the 

series, which will create a transparent image overlay that can be used for comparison. 

 

Results: Users can decide how they want the subtraction results displayed. They can choose to display them as a 

new series with a new name or in the existing series.  

 

Original Series: This displays the number of images, the number of slice locations, and the number of images 

ignored in the original series.  

 

Result Series: Displays the number of images in the Result Series.  

 

11-13—REMOVE IMAGES  

Remove Images allows users to remove selected images from a Key Image series or Aggregate series. This option 

does not remove images from a regular study.  

Click Menu in the Image Viewer and select Series. Select Remove Images.  

11-14—EJECTION FRACTION 

Ejection Fraction allows users to measure the capacity at which the heart is pumping. Ejection Fraction is the 

percentage of blood that pumps out of a filled ventricle with each heartbeat. The Ejection Fraction option is usually 

measured in the left ventricle (LV)—the heart’s main pumping chamber. A normal Ejection Fraction percentage is 

55 to 70 percent.  
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Note: This feature is only for Cardiologists.  

1. Open an image in the Image Viewer (typically MR) that shows the ventricles of the heart.  

2. Navigate through the images in the active series to find an image of the left ventricle in the Systolic Phase.  

3. Click Menu in the Image Viewer and select Series. Select Ejection Fraction. The Calculate Ejection Fraction 

dialog box appears.  

4. Use the Next Frame and/or Previous Frame buttons to find an image of the left ventricle in the Systolic Phase.  

5. To measure the ventricle at its smallest size, right-click and drag the mouse on the image. Outline or draw a 

circle around the left ventricle in the Systolic Phase.  

6. Click Next when done. Use the Next Frame and/or Previous Frame buttons to find an image of the left 

ventricle in the Diastolic Phase.  

7. To measure the ventricle at its largest size, right-click and drag the mouse on the image. Outline or draw a 

circle around the left ventricle in the Diastolic Phase. 

8. Click Next to see an Ejection Fraction Report.  

9. Click Save to save the Ejection Fraction Report.  

11-15—PERCENT STENOSIS 

Percent Stenosis allows users to check for the presence of a stenosis (abnormal narrowing) in a blood vessel. 

Calculating the Percent Stenosis tells a Radiologist how narrow the blood vessel is compared to a normal section of 

the blood vessel.  

 

Note: This feature is only for Cardiologists.  

 

1. Open an Angio study (XA). 

Note: An image without any pixel spacing must be calibrated 

before an accurate Percent Stenosis can be calculated. 

2. Navigate through the images in the active series to 

find an image showing the normal width of the blood 

vessel. 
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3. Click Menu in the Image Viewer and select Series. Select Percent Stenosis. The Calculate Percent Stenosis dialog 

box appears. 

4. To measure the vessel at its widest point, right-click and drag the mouse on the image. The cursor begins in 

the Measure Length mode. 

5. Draw a line extending from one border to the next, from lumen wall to lumen wall, on the fully patent or open 

lumen. Click Next when finished. 

6. To measure the vessel at its most narrow point, right-click and drag the mouse on the image. This marks the 

distance of the obstruction. 

7. To measure the lesion length, right-click and drag the mouse on the lesion in the image. 

8. Click Next to see the Percent Stenosis report. 

9. Click Save to save the Percent Stenosis report. 
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CHAPTER 12—USING THE IMAGE VIEWER IMAGE MENU 

The Image Viewer’s Image menu contains many functions to help users as they view images. Users can select from 

many annotation options and identify critical findings. The Image menu is located on the Image Viewer’s Menu. 

When configured, the Image menu can also be located on the Image Viewer’s Main Toolbar.  

Note: The Image Viewer toolbars can be customized to contain frequently used functions from any menu to increase 

efficiency. Users can also add any options or functions to Image Context Menus for quick access in the Image Viewer.  

12-1—ZOOM  

Zoom allows users to change the zoom or magnification of an image.  

Click Menu in the Image Viewer and select Image. Select the Zoom drop-down list. 

Users have the choice of four different Zoom options: 

• 1:1 - Displays the image in its original size from the modality. Each pixel of the image is represented by one 

pixel on the monitor. The size and resolution of the monitor affects how large the image appears.  

• To Fit - The image scales until the entire image is visible and touching either the horizontal or vertical edges 

of the view box. This is the default zoom setting. 

• To Fill - The image scales until the image touches both horizontal and vertical edges of the view box. This 

results in parts of the image being cut off. Monitor orientation, image orientation, and hanging protocol settings 

affect how much of the image is visible.  

• Manual Zoom - Users can hold the right and left mouse buttons simultaneously while dragging the mouse up to 

zoom in and down to zoom out. The default hotkey is Z.  

Note: Undo the Zoom changes by manually zooming out with the mouse. The entire image then shows.  

12-2—ZOOM MAP 

When users zoom into an image in the NovaPACS Diagnostic Viewer, they see an image thumbnail displayed in the 

bottom right-hand corner of the image called a Zoom Map. The Zoom Map shows users the area they are viewing 

in respect to the entire image. The Zoom Map is clearly marked with a yellow box pinpointing the area where users 

have zoomed in. 

1. Log into the NovaPACS Diagnostic Viewer and open an image.  

2. With an image open in the Image Viewer, press and hold the left and right mouse buttons simultaneously and 

drag the mouse up to zoom in. 

The Zoom Map automatically displays in the bottom, right-hand corner of the image.  
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Note: To zoom out, click both mouse buttons and drag 

down.  

3. The Zoom Map feature is enabled by default for 

all users. To disable the Zoom Map, click Menu in 

the Image Viewer. 

4. Hover the cursor over Image → Zoom and 

deselect Zoom Map.  

 

 

Note: The Zoom Map feature is enabled by default. If the user disables/enables this feature, it saves to their user’s 

preferences. 

 

12-3—RELOAD 

Reload allows users to reload the image file, removing any changes in orientation, magnification, filtering, or pixel 

inversion.  

Click Menu in the Image Viewer and select Image. Select Reload from the list. Users can also press the default 

hotkey, the Backspace key.  

12-4—INVERT 

Invert allows users to invert the grey scale shades in an image to the colors of a negative image where the black 

and white colors switch. The Invert option aids in visualization of angiography and other vessel/lumen exams and 

runoffs.  

Click Menu in the Image Viewer and select Image. Select Invert. Users can also press the default hotkey I.  

12-5—SUBTRACT CLIP FRAMES 

Subtract Clip Frames allows users to subtract the active frame of a clip from the other frames in the clip. The 

Diagnostic Viewer creates a new clip containing the subtracted frames and adds it to the series.  

Click Menu in the Image Viewer and select Image. Select Subtract Clip Frames. 

12-6—CALIBRATE MEASUREMENT  

Calibrate Measurement allows users to calibrate and measure studies that do not come with pixel spacing as part 

of their DICOM value.  

1. Click Menu in the Image Viewer and select Image. Select Calibrate Measurement.  

 



 

Page 143 of 169   

 

NovaPACS User Manual 

2. A dialog box appears, warning users of the possible inaccuracies 

of calibrating measurements by hand. This warning dialog box 

appears each time users open the Calibrate Measurement 

option unless the Don’t show this again checkbox is marked. 

Click OK.  

 

 

3. The cursor changes to an annotation measurement cursor. Right-click on 

the image and drag the mouse to draw a line of measurement.  

 

 

 

 

 

 

4. In the Measurement Calibration dialog box, choose the desired 

measurement value—users can choose from Use Millimeters or Use French 

(1/3 mm) value. Select or enter the measurement value.  

5. To apply the image calibration to the entire series, click the Apply to 

Series checkbox. This calibrates all of the images in the currently selected 

series.  

6. Click OK to save the calibration setting.  

Note: This calibration is only valid for the current image unless the Apply to 

Series checkbox has been selected.  

12-7—DETAILS 

Details allow users to view the list of DICOM fields that the 

modality transmitted when sending the study to NovaPACS.  

Click Menu in the Image Viewer and select Image. Select 

Details. The DICOM Viewer dialog box opens.  
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12-8—FLIP/ROTATE  

Flip/Rotate allows users to change flip or rotate an image or images.  

Click Menu in the Image Viewer and select Image. Select the Flip/Rotate drop-down list. Users have the choice of 

four different Flip/Rotate options: 

• Flip Horizontal  

• Flip Vertical  

• Rotate Right  

• Rotate Left 

Note: Users can flip/rotate an entire series by choosing Select All Images from the Image Viewer’s Series menu before 

using the Flip/Rotate option.  

Note: The Reload, Hide, Invert, and Rotate toolbar buttons are available in the web viewer as image specific features 

that only affect the feature to which they were applied.  

12-9—ANNOTATE  

Annotate allows users to perform functions like annotating, marking, highlighting, and marking regions of interest 

on images. There are many annotation options in the Annotate list. 

Note: Admin users that do not also have a Radiologist, Resident, or Cardiologist role can annotate, but the 

annotations are not saved.  

ACCESSING THE ANNOTATE OPTIONS 

1. Click Menu in the Image Viewer and select Image. Select Annotate to open the drop-down list.  

2. If the Image Viewer’s Main Toolbar is activated, click Image, and select Annotate to open the drop-down list.  

3. Right-click an image in the Image Viewer. The Image Context Menu appears containing many annotation 

options by default.  

4. Activate the Default Annotation Toolbar by right-clicking any toolbar in the Image Viewer and selecting Default 

Annotation Toolbar.  

USING ANNOTATIONS 

1. Select an annotation tool from the Annotate drop-down list or toolbar.  

2. The mouse cursor changes to reflect the selected annotation. Activate the annotation by right-clicking the 

image and moving the mouse.  

3. Perform the action specific to the annotation option.  

4. Reset the cursor when finished by selecting Reset Cursor from the Annotate drop-down list or toolbar. Users 

can also reset the cursor by pressing the default hotkey Esc.  
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ANNOTATION OPTIONS 

Users have many annotation options to choose from when working with images. Annotations can be added to any 

image, even in Cine view.  

COLOR 

Color allows users to select a color for annotation marks from a color palette.  

FONT 

Font allows users to select the font, size, and style for any text annotations.  

RESET CURSOR 

Reset Cursor allows users to turn off any selected annotation mode and restores the mouse cursor to the default 

setting. Double-Right-Clicking with the mouse or using the default hotkey Esc also resets the cursor.  

ROI 

ROI (Region of Interest) measures Hounsfield values (or the density of a particular area on the image) of the 

average and deviation values to aid in diagnosis. The ROI annotation is helpful in tumor diagnosis and identifying 

abnormalities in the anatomy.  

Select the Annotate drop-down list, select the ROI drop-down list, and choose an option: 

• ROI Polygon 

• ROI Rectangle 

• ROI Circle (default hotkey is R) 

• ROI Ellipse 

• ROI Point 

Users can also add 2D ROI annotations to PET/Fusion Images by right-clicking on a PET/Fusion Image and selecting 

Annotation. To add a 2D circle, select ‘Circle.’ 

PEN 

Pen allows users to make annotations using a freehand drawing tool. The default hotkey is W.  

POLYGON 

Polygon allows users to create a freehand polygon shape. Any side left undrawn is auto completed. This allows users 

to highlight an area on an image.  

RECTANGLE 

Rectangle allows users to draw a rectangle shape to highlight an area on an image.  
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CIRCLE 

Circle allows users to draw a circle shape to highlight an area on an image.  

On an MPR image, the circle annotation will only cover the circular area on that specific slice; unlike the sphere 

annotation, it will not cover the area on any other slice. This will also display the minimum, maximum, medium, 

and average values for the area.  

ELLIPSE 

Ellipse allows users to draw an oval shape to highlight an area on an image.  

POINT 

Point allows users to draw small dot shapes to highlight areas on an image.  

ARROW 

Arrow allows users to create arrows for pointing out specific features on images. The default hotkey is A. With the 

arrow annotation selected, right-click and drag to draw the arrow. By default, arrows are drawn tail to head, 

meaning that the tail end of the arrow is positioned where the user first clicks and the pointed end of the arrow is 

dragged to the desired position before releasing the mouse. Users can reverse the way arrow annotations are drawn 

in the Study Browser’s Option menu.  

COORDINATES 

Coordinates allows users to determine and annotate the coordinates of a specific point on an image. This tool is 

useful when counting and comparing vertebrae from one plane to another.  

Click the Annotate drop-down list and select Coordinates. Right-click the precise point to establish coordinates. To 

verify that the coordinates or anatomy are of equal position on comparable images, repeat these steps on those 

images. 

TEXT  

Text allows users to add text annotations to images.  

1. Select the Annotate drop-down list and select Text. Users can also press the default hotkey T.  

2. Right-click the image to mark the starting point. The Insert Text dialog box opens.  

3. Enter new text for the annotation or select pre-existing text from the lexicon.  

4. To add the new text to the lexicon, select the checkbox for Add this annotation to the lexicon.  

5. Users can edit the existing lexicon text and/or add new lexicon items by clicking Edit Lexicon.  

6. Click OK to add the text annotation to the image.  
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SPINE LABELING 

Spine Labeling allows users to annotate vertebral body and disc mapping.  

1. Select the Annotate drop-down list and select Spine Labeling. The Spine Labeling dialog box appears.  

2. Select the Vertebral Body or Disc tab to identify the type of label.  

3. Select the starting point for the annotation (i.e. C3).  

4. Select the Up or Down option for the direction of labeling. This marks the spine labels from either superior to 

inferior or inferior to superior.  

5. Right-click the image to mark the starting point or right-click and drag to draw a line on the border of the 

area. If the user draws a line on the border, then draws a second line, the Diagnostic Viewer automatically 

connects the ends of the lines to form a four-sided polygon; the label text is automatically centered in the 

polygon.  

6. Continue marking the vertebrae in the image. Do not close the menu until the labeling is complete.  

To use the Spine Label Cross Reference: 

1. Click Settings in the Study Browser and select Options.  

2. On the General tab, select Display spine label cross references.  

Spine label cross-references show at the top of intersecting images. An intersecting image is any orthogonal in the 

study (with the same frame of reference) that intersects a spine label in another image.  

If it is a simple label, it intersects the label text. If it is a polygon label, it intersects any part of the polygon (i.e. if a 

sagittal image of the spine is labeled, any axial images that intersect a spine label displays the label at the top of 

the axial image for reference).  

MEASURE LENGTH  

Measure Length allows users to measure lengths on images.  

1. Select the Annotate drop-down list and select Measure Length. Users can also press the default hotkey M.  

2. Right-click the image to mark the starting point.  

3. Drag the cursor the length of the area to measure, and release. A line appears with the measurement in 

millimeters.  

Note: The Image Viewer can only calculate measurements for images with pixel spacing information. If no pixel 

information exists, users must Calibrate Measurements before measuring.  

MEASURE PATH 

Measure Path allows users to measure a freehand line. This tool gives a more accurate measurement of non-linear 

objects or anatomy.  

Click the Annotate drop-down list and select Measure Path. On the image, right-click and drag the cursor along the 

path to measure. The measurement displays in millimeters when the path is complete.  
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MEASURE AREA 

Measure Area allows users to trace around anatomical areas on an image to calculate the area and circumference. 

The area and circumference values display on the image in millimeters. 

MEASURE ANGLE 

Measure Angle allows users to measure the angles of structures and other elements in an image. This is a useful 

tool for scoliosis and fracture angles.  

1. Select the Annotate drop-down list and select Measure Angle. Users can also press the default hotkey CTRL + 

M.  

2. Right-click and drag to draw the first line.  

3. Move the mouse cursor to the fulcrum or hinge point of the angle and right-click and drag to draw another 

line. An arc fills in between the two lines established and the degree of the angle is displayed at the fulcrum 

point.  

Users can also complete the following Measure Angle options: 

• Cross two lines in the middle 

• Draw two lines that do not touch but would intersect if they were to extend farther 

• Draw two parallel lines 

Note: Angle measurements can be undone one line at a time using the Undo annotation tool.  

COBB ANGLE 

Cobb Angle allows users to perform complex angle measurements for spinal curvature and scoliosis studies along 

with other angle measurements for Orthopedics diagnosis and reading.  

1. Select the Annotate drop-down list and select Cobb Angle.  

2. Right-click the image and drag the mouse to begin using the Cobb Angle annotation tool.  

3. Right-click and drag the mouse to draw as many lines as needed. The angles between the lines are measured 

and displayed in degrees.  

VOICE ANNOTATIONS 

The Voice Annotation Dialog is a powerful feature that allows users to record or dictate a voice annotation in 

conjunction with other annotation marking tools. The Image Viewer records mouse movements over the image along 

with the voice recording, allowing users to point out and mark relevant pathology on the screen while describing it.  

1. Select the Annotate drop-down list and select Record. The Voice Annotation Player dialog box appears, and the 

recording begins immediately. Users need a microphone for this tool.  

2. Dictate the information for the image. The mouse movements on the screen are also recorded.  

3. Click Save to end the recording session and save the recording. The recorded annotation is saved to the image. 

A Voice label appears in the corner of the image once recorded.  
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The dialog will present Patient and Study information. It will also display a position indicator (to inform users how 

long the recording is). There are also Pause, Play, Record, Save and Cancel. 

PLAY 

Play allows users to play back information that was recorded with the Record annotation tool. The recording plays 

back in the Image Viewer when opened.  

SHOW SCALE 

Show Scale allows users to display a sale on images to help judge sizes. The scale displays to the bottom right of the 

image. The scale is in cm units and changes to mm units if the image is zoomed in a certain amount.  

Note: The Show Scale option does not save to the image, but when displayed, it prints with the image.  

HIDE ALL 

Hide All allows users to hide all computer-generated and user-generated annotations and labels on the selected 

image. This option remains on or off unless selected.  

ERASE 

Erase allows users to erase the user-created annotations from the selected image.  

Note: This option only erases annotations created by the current user during the current viewing session in the Image 

Viewer. To erase saved annotations, see History below.  

ERASE ALL 

Erase All allows users to delete all the user-created annotations from the selected image.  

Note: This option only erases annotations created by the current user during the current viewing session in the Image 

Viewer. To erase saved annotations, see History below. 

UNDO 

Undo allows users to remove the last annotation made to the selected image.  

REDO 

Redo allows users to reinstate the last annotation removed.  

HISTORY 

History allows users to open a history of all annotations created for the selected image. The Annotation History 

dialog box opens. The four columns in the dialog box are as follows: Annotation Type, Creation Time, Created By, 

and Can Delete. If the Can Delete column says Yes for an annotation, users can select the annotation and click 

Delete to remove it.  
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EDITING ANNOTATIONS 

Users may quickly and easily edit annotations for images without having to delete or undo the original annotation. 

Annotations may be edited only during the current viewing session. Once an annotation has been saved, it cannot 

be edited. A small padlock symbol appears next to the cursor if an annotation cannot be edited. Users may edit 

annotations by clicking and dragging or using the Edit Annotations drop-down list. 

CLICK AND DRAG 

Users can click and drag annotations in the Image Viewer to move an existing annotation, move text independently 

from an existing annotation, or to resize or reshape an existing annotation. 

MOVING ANNOTATIONS 

To move an existing annotation, hover the cursor over the annotation until a hand-shaped cursor appears. Click 

and hold the left mouse button. Drag the annotation to the desired location and release the mouse. If an annotation 

makes calculations based on location, the calculations automatically update once the annotation is moved.  

MOVING TEXT 

If an annotation includes associated text, the text box can be moved independently from the main annotation. 

Hover the cursor over the text until a hand-shaped cursor appears. Click and hold the left mouse button. Drag the 

text to the desired location and release the mouse. The main annotation remains in place while the associated text 

is moved. If the main annotation is moved, the associated text moves with it. Users cannot edit text in an existing 

annotation; however, text based on calculations update to reflect changes to the annotation. 

RESIZING OR RESHAPING ANNOTATIONS 

Some annotations can be resized or reshaped. Typically, if an annotation has multiple lines or figures, each item 

can be resized/reshaped individually. To resize or reshape an annotation, hover the cursor over an existing 

annotation until a hand-shaped cursor appears. Follow the line of the annotation with the mouse until a small, 

white circle appears next to the cursor (usually at the ends or corners of an annotation). Click and hold the left 

mouse button. Drag the cursor to resize or reshape the annotation. Release the mouse. The edited annotation 

remains at the selected size or shape. Any calculations based on the size, shape, or positioning of the annotation 

update to reflect changes. 

Note: Annotations that are drawn freehand or that only represent one point cannot be resized or reshaped.  

DROP-DOWN MENU 

Users can right click an existing annotation to access a drop-down list that allows them to delete the annotation, 

change the color of the annotation, or change the font of text used in an annotation. 

CHANGING COLOR 

To change the color of an annotation, hover the cursor over the annotation until a hand-shaped cursor 

appears. Right-click the annotation. A drop-down menu appears. Select Color. The Color dialog box 
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appears. Select the desired color and click OK. The color of the annotation automatically updates in the 

Viewer. 

CHANGING FONT 

To change the font of a text annotation, hover the cursor over the text until a hand-shaped cursor appears. Right-

click the annotation. A drop-down menu appears. Select Font. The Font dialog box appears. Select the desired font 

and click OK. The annotation font automatically updates in the Viewer. 

DELETE ANNOTATIONS 

Users can delete annotations by right-clicking the annotation and selecting Delete Annotation from the drop-down 

menu. The selected annotation deletes from the image in the Viewer. Only annotations from the current viewing 

session can be deleted using this option. 

12-10—NAVIGATE THROUGH ANNOTATED IMAGES 

Users can quickly navigate through annotated images in the Image Viewer in the NovaPACS Diagnostic Viewer. 

In the header bar for the series window in the Image Viewer, there are annotation navigation icons. Users can click 

the left arrow icon to navigate to the previous annotated image or click the right arrow icon to navigate to the next 

annotated image. 

Each series box displayed in the Image Viewer window has these arrow icons. 

 

The Image Viewer navigates to the next or 

previous image in the user’s current series 

first. If there are no more available 

annotated images in the current series, the 

next available series containing annotated 

images appears. 

 

 

 

 

12-11—MOVE IMAGES 

Move Images allows users to transfer images in and out of Aggregate and/or Key Image Series.  

Click Menu in the Image Viewer and select Image. Select Move Images. Right-click and drag to move selected 

images in or out of Aggregate and Key Image series.  
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12-12—EXPORT TO FILE 

Export to File allows users to save an image to a file for export or other uses (i.e. exporting images to PowerPoint or 

sending fetal ultrasound images with a patient). The Export to File option supports DICOM, BMP, GIF, TIFF, and 

JPEG file formats.  

1. Select an image from an open study to export.  

2. Click Menu in the Image Viewer and select Image. Select Export to File. The Save As dialog box opens. 

3. Browse for the export location by expanding the folders in the Save in drop-down list.  

4. When the correct location is selected, click Save to export the image.  

Note: The Diagnostic Viewer only exports image files. 

12-13—MAGNIFICATION 

Magnification allows users to activate the Magnify Glass feature. Click Menu in the Image Viewer and select the 

Magnification drop-down list. Users have the choice of four different Magnification options: 

• Magnify Glass—turns the magnifying glass on or off. The default hotkey is G.  

• Magnify Glass Size—increases or decreases the size of the magnifying glass window. The default hotkey is Shift 

+ G.  

• Magnify Up—increases the size of the magnifying glass window.  

• Magnify Down—decreases the size of the magnifying glass window.  

12-14—UNDO ALL SELECTIONS 

Undo All Selections allows users to deselect any selected images in the Image Viewer.  

Click the Image Viewer’s Menu and select Image. Select Undo All Selections. 

12-15—KEY IMAGE SERIES 

A Key Image Series is a series that contains certain key images that the user wants to group together. When a Key 

Image Series is created, the Diagnostic Viewer saves this series for future viewing.  

• Key Images—shows or hides the Key Image Series in the Image Viewer window. 

• Add to Key Images—adds the selected image to the Key Image Series.  

• Remove from Key Images—removes the selected Key Image from the Key Image Series.  

To view the Key Image Series, click Menu in the Image Viewer and select Image. Select the Key Image Series drop-

down list and select Key Images. Users can also press the default hotkey K.  

To add to the Key Image Series, click Menu in the Image Viewer and select Image. Select the Key Image Series 

drop-down list and select Add to Key Images. Users can also click the key icon at the top of each image in the 

Image Viewer.  



 

Page 153 of 169   

 

NovaPACS User Manual 

Note: Users cannot add files to an existing Key Image Series if the Key Image Series isn’t already open.  

To remove an image from a Key Image Series, select the key image in the series. Click Menu in the Image Viewer 

and select Image. Select the Key Image Series drop-down list and select Remove from Key Images.  

12-16—CRITICAL FINDINGS 

Critical Findings allows radiologists to mark images, series, and/or studies that contain a critical. Critical findings 

can contain up to ten diagnoses. 

ADD CRITICAL FINDINGS 

1. Select an image to mark. 

2. Click Menu in the Image Viewer and select Image. Select the Critical Findings drop-down list and select Add 

Critical Findings. Users can also click the critical findings triangle icon at the top of each image in the Image 

Viewer. The Add Critical Findings dialog box opens.  

3. Select from the list of available Critical Findings.  

4. Click Save and yellow text labeling the Critical Finding appears in the top-right corner of the image in the 

Image Viewer.  

Note: If the user is both a radiologist and an admin, an Add a New Critical Finding Value link appears. After selecting 

this option, the Add New Critical Finding dialog box appears. Enter text for the Critical Finding and click OK. The 

new value appears in the available critical findings list and can now be selected. Click Save to add the finding to the 

image. 

In the Add Critical Findings dialog box, users can also choose to do the following: 

1. Add image to the Key Image Series—adds the selected image to a Key Image Series.  

2. Record Findings—opens the Findings Record Editor dialog box where users can record the critical findings and 

mark any physician notification attempts.  

RECORD FINDINGS 

1. Click Menu in the Image Viewer and select Image. Select the Critical Findings drop-down list and select Record 

Findings. The Findings Record Editor dialog box opens.  

2. Click Add to add a finding. The Physician Notification Editor dialog box opens.  

3. Mark any notification attempts and click Add.  

4. Click Save to save the recorded finding.  

The following are alternate ways to use the Record Findings option: 

1. Click Image in the Image Viewer and select Critical Findings. Click Record Findings at the bottom of the Add 

Critical Findings dialog box.  

2. Click the triangle Critical Findings symbol on an image in the Image Viewer. Click Record Findings at the 

bottom of the Add Critical Findings dialog box.  
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EDIT PHYSICIAN INFO 

When using the Record Findings option, if the Physician field is blank or the needed Physician is not on the list, 

users can search for and edit Physician info. 

1. Click Menu in the Image Viewer and select Image. Select the Critical Findings drop-down list and select Record 

Findings. The Findings Record Editor dialog box opens.  

2. Click Add to add a finding. The Physician Notification Editor dialog box opens.  

3. In the Physician Notification Editor dialog box, click the magnifying glass icon next to the Physician drop-down 

list. The Physician Search dialog box opens.  

4. Enter the Physician’s information in the search fields and click Search.  

5. When the specific Physician appears in the Physicians list, select it and click OK. The Physician’s information 

populates in the Physician Notification Editor dialog box.  

To revise physician notification information: 

1. Click Menu in the Image Viewer and select Image. Select the Critical Findings drop-down list and select Record 

Findings. The Findings Record Editor dialog box opens.  

2. Click Add to add a finding. The Physician Notification Editor dialog box opens.  

3.  In the Findings Record Editor dialog box, select the name of the physician in the Physicians Notifications field 

by highlighting it with the mouse, and then select Edit. The Physicians Notification Editor dialog box opens.  

4. Make any needed changes and click Add.  

5. Select Store. A dialog box appears warning that the critical findings and physician notification will become a 

permanent record. Click Yes to save.  

To delete the physician notification information:  

1. Click Menu in the Image Viewer and select Image. Select the Critical Findings drop-down list and select Record 

Findings. The Findings Record Editor dialog box opens.  

2. Click Add to add a finding. The Physician Notification Editor dialog box opens.  

3.  In the Findings Record Editor dialog box, select the name of the physician in the Physicians Notifications field 

by highlighting it with the mouse. Click Remove. The name of the Physician is deleted.  

4. Select Store. A dialog box appears warning that the critical findings and physician notification will become a 

permanent record. Click Yes to save. 

12-17—EQUALIZE HISTOGRAM 

Equalize Histogram allows users to enhance the contrast of an image by equalizing the image’s histogram. This 

option is helpful when viewing images of the lungs. Use the Equalize Histogram option on a PA. The lung apices and 

angles are easily visible, the lung markings are clear, and the mediastinum is not over- or underexposed.  

Note: It is important to note when a bucky takes an image. A bucky has a grid that improves the image quality. 

Portable chest x-ray studies only have one view; therefore, a PA and those images do not have a grid. 
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Click Menu in the Image Viewer and select Image. Select Equalize Histogram. 

12-18—SET WIN/LEVEL 

Set Win/Level allows users to manually enter a window/level value for a selected image.  

Click Menu in the Image Viewer and select Image. Select Set Win/Level. The Set Window/Level dialog box opens. 

Manually enter the level numbers in the fields for the window/level settings. 

12-19—SMOOTH 

Smooth Error! Bookmark not defined. allows users to soften the edge enhancement applied to the selected 

image(s). The Smooth option can be applied multiple times until the desired effect is created.  

Click Menu in the Image Viewer and select Image. Select Smooth. 

Note: The Smooth and Sharpen options work in direct opposition to each other. Users can apply these two options to 

correct each other.  

12-20—SHARPEN 

Sharpen allows users to sharpen the detail or edge enhancement applied to the selected image(s). The Sharpen 

option can be applied multiple times until the desired effect is created.  

Click Menu in the Image Viewer and select Image. Select Sharpen. 

Note: The Smooth and Sharpen options work in direct opposition to each other. Users can apply these two options to 

correct each other.  

12-21—LOCAL CONTRAST ENHANCEMENT 

Local Contrast Enhancement allows users to enhance details in CR images, specifically the bone in the images.  

Click Menu in the Image Viewer and select Image. Select Local Contrast Enhancement. Users can also press the 

default hotkey Shift + E.  

Note: Users can also set the option to apply the Local Contrast Enhancement automatically when CR images are 

opened.  

CHAPTER 13—MISCELLANEOUS INFORMATION  

The Image Viewer’s Navigation, Customize Toolbars, and Help menus contain many functions to help users as they 

view images. Users can navigate through images, series, and studies, customize the various Image Viewer toolbars, 

and explore help topics. The Navigation, Customize Toolbars, and Help menus are located on the Image Viewer’s 

Menu list. If set up, these menus can also be found on the Image Viewer’s Main Toolbar.  

Note: The Image Viewer’s toolbars can be customized to contain frequently used functions from any menu to increase 

efficiency. Users can also add any options or functions to Image Context Menus for quick access in the Image Viewer. 
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13-1—NAVIGATION 

The Navigation Menu contains a convenient list of options to help users navigate to the Study Browser and among 

images in the Image Viewer. The Navigation menu is located on the Image Viewer’s Menu. If set up, this menu can 

also be found on the Image Viewer’s Main Toolbar.  

Click Menu in the Image Viewer and select Navigation. Navigate between worklist items, workspaces, studies, 

series, and images using the Navigation menu options.  

Note: Any of the Navigation Menu options can be assigned a hotkey.  

A. Study Browser—launches the Study Browser window. 

B. Next Worklist Item—closes the current workspace and opens the next worklist study. The name of the worklist 

being used appears in parentheses next to this menu item.  

C. Mark Reviewed, Close, and Open Next Worklist Item—marks the current study as Reviewed and closes it. It 

then opens the next worklist item from the worklist being used. The name of the worklist being used appears in 

parentheses next to this menu item.  

D. Previous Workspace—changes the view to the study located on the previous workspace.  

E. Next Workspace—changes the view to the study located on the next workspace.  

F. Previous Study—switches to the previous study within the same viewer. When multiple comparisons are open 

together, users see each study as a tab in the comparison viewer.  

G. Next Study—switches to the next study 

Note: If the first or last study tab is selected, and the user tries to navigate forward or backward past that first 

or last study, the navigation does not cycle around the study tabs.  

H. Previous Series—changes the view to the previous series in the study. The default hotkey is the up arrow.  

I. Next Series—changes the view to the next series in the study. The default hotkey is the down arrow.  

J. Previous Page—changes the view to the previous page of images in the current series. The default hotkey is 

Page Up.  

K. Next Page—changes the view to the next page of images in the current series. The default hotkey is Page 

Down.  

L. Previous Image—changes the view to the previous image in the current series. The default hotkey is the left 

arrow.  

M. Next Image—changes the view to the next image in the current series. The default hotkey is the right arrow.  

N. First Image—changes the view to the first image in the current series. The default hotkey is Home.  

O. Last Image—changes the view to the last image in the current series. The default hotkey is End.  

13-2— THE RADIUS MENU 

The Radius Menu is an alternative to the standard right-click menu. Instead of the options appearing in the side 

menu, they will appear in concentric circles around the user’s mouse. Users may find this helpful because many of 

the features will appear closer to the mouse than they do with the standard right-click menu.  
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To enable the Radius Menu: 

1. Click Settings.  

2. Click Options. 

3. Make sure the General Tab is selected. 

4. Select either Palette Mode or Context mode underneath the Radius Menu section of the General Tab.  

WHEN PALETTE MODE IS SELECTED, A SET OF OPTIONS WILL APPEAR. THE SELECTION OF OPTIONS WILL 

REMAIN CONSISTENT ACROSS ALL MODALITIES AND STUDIES. 

Note:  When using the Radius Menu in the 3D Viewer, only Palette mode will be available. 

When Context mode is selected, a smaller set of consistent options will appear, and the rest will vary depending on 

the specific images being viewed.  

5. Click OK when the desired mode has been selected.  
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Users can customize the Radius by selecting the gray arrow directly below the menu. 

 

 

 

 

 

 

 

 

 

A selection menu will appear. Here, Users can search for the feature they want to add to the Radius Menu by 

dragging the feature to an empty spot on the menu. 

Note: If there is no empty spot to drag a feature to in the Radius Menu, users will have to right-click the 

feature and select the category they want to add it to from the menu that appears.  

 

 

 

Users can also right-click any of the features and a menu containing all of the menu categories will 

appear. To add the feature to the menu, click on the category to house the desired feature.  

To remove a feature from the menu, right-click the feature and deselect the category in the menu that 

appears.  



 

Page 159 of 169   

 

NovaPACS User Manual 

RADIUS MENU IN THE 3D VIEWER 

When users enable the Radius Menu it will automatically enable for the 3D Viewer as well. It is important 

to note that only Palette Mode will work in the 3D Viewer, not the Context Mode.  

13-3—ADDITIONAL SOFTWARE PRODUCTS 

There are additional software products that can be used in conjunction with the NovaPACS Diagnostic Viewer. 

Users can contact Novarad Support for more information. 

NOVAORTHO® ORTHOPEDIC PACS 

Web-based Orthopedic PACS for image and information management that includes the following key features:  

• Orthopedic trauma tools, templates, and pre-op planning tools 

• Fast and accurate desktop CR with cart workstation and three-year warranty and maintenance  

• On-site archive and redundant archive for image storage 

• Images and pre-op plans archived in NovaPACS for fast and easy retrieval 

• Admin Console 

• Installation and on-site training 

• 24/7 technical support service 

NOVASCAN® DIGITIZE TO DICOM 

This software tool allows users to create a DICOM file from images produced by non-DICOM equipment. NovaScan 

software accepts image data from intermediary imaging equipment like film digitizers and video capture cards. 

NovaScan generates files that contain image pixel data and patient/study information that users send to a DICOM 

server for review by DICOM viewers. 

Users can run NovaScan from the NovaPACS Study Browser. This feature was implemented to allow users to scan 

documents directly from NovaPACS without having to open any separate applications.  

A Scan Documents link has been added within NovaPACS to launch NovaScan. The Scan Documents link appears 

in the Study menu, the right-click menu, in the toolbar items under the Documents section, and in the keyboard 

shortcuts section.  

Selecting any of the Scan Documents options launches NovaScan in the same manner as NovaPACS is running.  

- If NovaPACS is a managed client, the system attempts to run an installed NovaScan. 

- If NovaPACS is click-once, run the deploy for NovaScan. If accessing NovaScan through the web viewer, 

the NovaScan click-once version runs. 

If NovaScan is already running when a new session is launched, the current one closes and the new session 

launches. This prevents multiple sessions from opening simultaneously. 
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NOVAPRO® PACS FOR OFFSITE RADIOLOGIST OR RAD GROUP 

NovaPro provides any Radiologist or Radiology group the ability to receive DICOM images from unlimited, 

unaffiliated imaging producing practices with no fear of intermingling of images and/or information. Distributes the 

resulting reports automatically via email and/or fax or through direct HL7 messaging into the customer’s own HIS, 

RIS, and or EMR/EHR. The system automatically scrubs images from the archive when reaching the pre-

determined image storage limit. NovaPro provides this functionality without needing to store or maintain the image 

files. The provider can configure the system to be a complete PACS solution allowing them to store and maintain 

images and reports. 

NOVAPRO® SINGLE USER 

This product comes fully functional to tie into a group’s workflow with no added expense. 

TRAUMACAD® ORTHO PRE-OP PLANNING PLUG-IN 

TraumaCad allows doctors to use digital images on-screen. Physicians can perform measurements, fix prostheses, 

simulate osteotomies, and visualize fracture reductions. Procedure-specific measurement tools and semi-automatic 

wizards guide the measurement process step-by-step. TraumaCad allows doctors to replicate every action currently 

performed by tracing on x-ray films, only more conveniently and much faster. TraumaCad has the largest digital 

template library with over 90,000 template images available. There are ten planning modules including Auto-Hip, 

Knee, and Upper Limb. Integrated orthopedic hardware lists facilitate pre-op planning. 

NOVA RIS (RADIOLOGY INFORMATION SYSTEM) 

Streamlines workflow, provides timestamps, tracks, and reports for every aspect of the process. Completely web-

based and runs on existing workstation hardware. Provides the radiology department with the following features: 

• Drag-and-drop, web-based scheduling, workflow tracking, order entry, interfaces, reports, 

dictation, and voice recognition  

• Referring physician exam requests and orders entered from their offices go directly into Nova RIS 

• Alert pop-ups for billing and insurance preauthorization requirements, contraindications by 

patient, prep instructions, and exam orders 

• Transcription module includes foot pedal control, playback, dictation, and editing within Nova RIS 

• Patient reminder letters, e-sign, auto-refresh of technology screen for easy patient tracking, and 

many other user-friendly features 

• ONC-ATCH ambulatory certification and integration with certified EMR/HER modules to provide 

complete Meaningful Use compliance. 

• Integration with the new Nova RIS Billing module. 

NOVAVAULT™ DATA PROTECTION  

Archive, backup, and storage solution service designed to provide on-site and off-site storage and off-line disaster 

recovery of data. There are three versions of NovaVault. These products help sites with long-term access to critical 
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clinical information, managed 

services, and disaster recovery 

services. This product may also be 

installed at sites not currently 

utilizing NovaPACS. 

NOVACARDIO® IMAGING 

PLATFORM  

NovaCardio is accessible anywhere and 

offers an efficient workflow and powerful 

features. NovaCardio contains four modules: 

 

1) The ECG Viewer, which launches when 

users select a study with the ECG 

modality that produces EKG strips 

2) Motion Cardiac Imaging Viewer to view 

ultrasound studies containing stress 

echo images 

 

3) NovaPACS with a NovaCardio license to 

view cardiac catheterization, vascular 

ultrasounds, and nuclear medicine 

imaging 

 

4) EncaptureMD Structured Reports. 

 

Additional features of the NovaCardio Imaging Platform include: 
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• EncaptureMD SR—With full support for 

both invasive and non-invasive cardiology 

procedures, the NovaCardio with EncaptureMD 

Echocardiography Structured Reporting Application is 

the fastest way to create all types of accredited 

cardiography-related reports. EncaptureMD 

simplifies the documentation process and eliminates 

the need for transcription and dictation services.  

• ECG Management System—The new 

NovaCardio ECG Viewer has been added to 

NovaPACS and allows users to read ECG studies and 

create reports. Cardiologists launch the ECG Viewer 

from within the NovaPACS Study Browser, which allows users to view waveforms and data, compare prior 

studies, and save, create, edit, and distribute reports. 

• Syntermed’s Emory Cardiac Toolbox™—NovaPACS integrates with Syntermed™ nuclear studies viewer and 

Emory Cardiac Toolbox. This allows Cardiologists to streamline their workflow by launching nuclear medicine 

studies directly from the NovaPACS Study Browser. 

NOVADOSE® IONIZING RADIATION DOSE INFORMATION SYSTEM 

Novarad provides integrated Radiation Dose Monitoring that runs on existing infrastructure and is modality vendor 

neutral. NovaDose calculates a patient’s ionizing dose history for CT, XA, MG, and DR modalities and provides 

alerts based on a customer-defined dose threshold when a test is ordered. When used with both NovaPACS and 

Nova RIS, NovaDose automatically adds a complete study dose summary for all series to the RIS Report. In addition 

to patient monitoring, department directors, CIO’s, and physicists use NovaDose to quickly identify dosing 

performance issues by tech, procedure, and modality. Simple queries produce comparison charts instantly to provide 

data to assist with decision making. For example, 

• Tech A consistently doses higher than other techs when performing Head CT. 

• CT Machine #4 is set higher than other CT machines. 

NOVA RIS BILLING MODULE 

Novarad’s Billing Client product fully integrates with Nova RIS and offers radiology practices a comprehensive billing 

service that emphasizes verify, code, process, and collect workflows. With features like automatic coding, complete 

transparent/anytime access to billing status in detail, and verification of patient benefits at check-in, Nova RIS 

Billing improves efficiency and cashflow. The billing module allows for the following: 

• Manage patient accounts 

• View unbilled procedures 

• Seamlessly bill insurance and patients 

• Add, edit, or delete claims 

• Explanation of Benefits (EOBs) 

• Batch processing 
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• Electronic Data Interchange (EDI) 

NOVA RIS EHR MODULE 

Novarad’s ambulatory EHR solution allows Nova RIS users to maintain an efficient and effective workflow within 

the RIS while providing full compliance for Meaningful Use stages. This product allows users to record, modify, and 

retrieve patient medical, billing, insurance, and demographic data. A compliance dashboard allows physicians to 

quickly review their compliance progress visually.  

NOVAMG® PRO MAMMOGRAPHY 

NovaMG PRO is a multi-modality workstation with an integrated mammography viewer that allows users to read a 

wide variety of mammography studies, as well as other studies, all in one place. 

CRYPTOCHART 

CryptoChart is a mobile app that provides the following features: 

• Securely share medical images without passwords or logins 

• Full DICOM viewing system 

• Mobile compatible with PACS integration 

CRYPTOSHARE 

CryptoShare is a mobile app that provides the following features: 

• No username or password needed 

• Integrated with MobileRAD and WhatsApp: Fully mobile environment 

• Fast, trackable image sharing that is compatible with PACS 

MOBILERAD 

MobileRAD is a mobile app that provides the following features: 

• Efficient and secure  

• Easy access to schedules and patient information 

• Secure communication and documentation 

ALERTVIEW 

AlertView is a mobile app that provides the following features: 

• Automatically send reports/images 

• Easily connect with referring physicians 

• Customizable settings 



 

Page 164 of 169   

 

NovaPACS User Manual 

SNAPVIEW 

SnapView is a mobile app that provides the following features: 

• Securely capture photos/videos/documents 

• Organized by department 

• Rapid and secure documentation 

• No Personal Health Information (PHI) left behind 
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